Federal Emergency Management Information System (FEMIS)

Installation Guide for FEMIS v1.4.6

JA Arp
RA Burnett
RJ Carter
TR Downing
JR Dunkle
PM Fangman
PP Gackle
BJ Homer

DM Johnson
RL Johnson
SM Johnson
RM Loveall
AJ Stephan
WD Millard
BM Wood

June 25, 1999

Prepared for the U.S. Department of Energy under Contract DE-AC06-76RLO 1830

Pacific Northwest National Laboratory
Richland, Washington 99352
DISCLAIMER

This report was prepared as an account of work sponsored by an agency of the United States Government. Neither the United States Government nor any agency thereof, nor any of their employees, make any warranty, express or implied, or assumes any legal liability or responsibility for the accuracy, completeness, or usefulness of any information, apparatus, product, or process disclosed, or represents that its use would not infringe privately owned rights. Reference herein to any specific commercial product, process, or service by trade name, trademark, manufacturer, or otherwise does not necessarily constitute or imply its endorsement, recommendation, or favoring by the United States Government or any agency thereof. The views and opinions of authors expressed herein do not necessarily state or reflect those of the United States Government or any agency thereof.
DISCLAIMER

Portions of this document may be illegible in electronic image products. Images are produced from the best available original document.
Preface

The Federal Emergency Management System (FEMIS) is an emergency management planning and response tool. The following documents were developed to support system users. The audience for each is identified.

The FEMIS Installation Guide provides instructions for installing and configuring the FEMIS software package.

This FEMIS Data Management Guide provides the information needed to manage the data used to support the administrative, user-environment, database management, and operational capabilities of FEMIS.

The FEMIS System Administration Guide provides information on FEMIS system administrator activities as well as the utilities that are included with FEMIS.

The FEMIS Release Notes provide a description of what is new in the release, a list of known problems and workaround suggestions, and any information specific to this release that was not available when other documents were published.

The FEMIS Bill of Materials defines FEMIS hardware, software, and communication requirements.

The FEMIS Online Help System explains how to use the FEMIS program, which is designed to help civilian emergency management personnel to plan and respond to a Chemical Accident or Incident (CAI) Event at a military chemical stockpile.
Contents

1.0 Overview ................................................................. 1-1
1.1 Point of Contact ..................................................... 1-1
1.2 Document Organization ........................................... 1-1
1.3 Software Products ................................................... 1-2
1.4 Installation ............................................................ 1-3
  1.4.1 Environment ...................................................... 1-3
  1.4.2 Storage Requirements ......................................... 1-3
    1.4.2.1 FEMIS Server ................................................. 1-3
    1.4.2.2 FEMIS PC ..................................................... 1-4
1.5 FEMIS Directory Structures ....................................... 1-4

2.0 FEMIS UNIX Installation .............................................. 2-1
2.1 Installing the UNIX COTS ......................................... 2-2
  2.1.1 Installing the Operating System .......................... 2-2
    2.1.1.1 Automounting and FEMIS ............................... 2-3
    2.1.1.2 Creating Users and Groups ......................... 2-5
  2.1.2 Installing the NFS Authentication Services Daemon ... 2-8
    2.1.2.1 Determining Version of NFS Daemon ............... 2-8
    2.1.2.2 Removing Previous NFS Daemon .................... 2-9
    2.1.2.3 Installing Hummingbird NFS Daemon ............... 2-9
    2.1.2.4 Installing Sun PC NFS Daemon ..................... 2-10
  2.1.3 Installing an E-mail Package .............................. 2-11
2.2 Installing the FEMIS UNIX Software .......................... 2-11
  2.2.1 Creating UNIX Accounts on the Server ................ 2-11
  2.2.2 Upgrading the FEMIS Application ....................... 2-13
  2.2.3 Installing the FEMIS Package ............................. 2-15
  2.2.4 Installing Network Time Protocol (NTP) ............... 2-17
2.3 Installing the FEMIS GIS and Database ....................... 2-18
  2.3.1 Installing the GIS and Oracle Database ............... 2-19
  2.3.2 Database Cleanup Tasks .................................... 2-20
    2.3.2.1 Dropping Database Objects and Exporting Data Owners ... 2-20
    2.3.2.2 Removing Current Oracle Installation ............ 2-21
  2.3.3 Installing Oracle Software or Relinking Oracle ....... 2-22
    2.3.3.1 Creating the UNIX Environment for Oracle ....... 2-22
    2.3.3.2 Installing the Oracle Software .................... 2-27
    2.3.3.3 Installing and Using Oracle Documentation ....... 2-33
    2.3.3.4 Relinking the Oracle Software .................... 2-34
    2.3.3.5 Configuring Existing Oracle for Latest Version of FEMIS ... 2-35
    2.3.3.6 Modifying the Initialization Parameter .......... 2-36
  2.3.4 Defining the Database Topology ......................... 2-36
    2.3.4.1 Running the Build Topology Program ............. 2-37

2.3.4.2 Setting Up the EOC DBA Directory (as femis) .................................. 2-38
2.3.5 Creating or Updating the FEMIS Database ........................................ 2-39
  2.3.5.1 Creating the Database Schemas ...................................................... 2-39
  2.3.5.2 Loading Data (as femis) ................................................................. 2-40
  2.3.5.3 Upgrading Database from Previous Versions of FEMIS ................. 2-41
  2.3.5.4 Creating Objects that Share Data (as femis) .................................. 2-42
  2.3.5.5 Upgrading Shared Data from Previous Versions of FEMIS ............. 2-42
  2.3.5.6 Fixing the EOC Table (as femis) .................................................... 2-43
  2.3.5.7 Setting Up the Oracle Crontab ....................................................... 2-43
  2.3.5.8 Starting Replication (as femis) ...................................................... 2-43

2.3.6 Configuring the FEMIS Files (as root) ............................................... 2-44
2.3.7 Configuring the FEMIS PC Files (as femis) ......................................... 2-45
  2.3.7.1 Editing the /home/femis/config/fsetup.ini File ................................ 2-45
  2.3.7.2 Updating Windows NT User Accounts .......................................... 2-47
  2.3.7.3 Correcting Group Ownership ......................................................... 2-47
  2.3.8 Verifying the Configuration Files (as femis) ...................................... 2-47
  2.3.9 Setting Up the Command Server Configuration File .......................... 2-49
  2.3.10 Setting Up femis_event ................................................................. 2-50

2.4 Checking the FEMIS Startup ................................................................. 2-51
  2.4.1 Rebooting the Server (as root) .......................................................... 2-51
  2.4.2 Verifying the FEMIS Programs (as femis) ........................................ 2-52

2.5 Utility to Add FEMIS Login Programs to the Database .......................... 2-52

2.6 FEMIS AutoRecovery System Description and Installation ...................... 2-53
  2.6.1 Messaging Service ............................................................................. 2-54
  2.6.2 Logging .............................................................................................. 2-54
  2.6.3 Sending E-mail ................................................................................... 2-55
  2.6.4 Running Processes ............................................................................ 2-55
  2.6.5 Monitoring Swap and Disk Space ...................................................... 2-56
  2.6.6 Installing AutoRecovery ................................................................. 2-56
  2.6.7 Configuring AutoRecovery ............................................................... 2-57

2.7 AutoRecovery Web Reporting Application ............................................ 2-58
  2.7.1 Software Requirements ..................................................................... 2-59
  2.7.2 Installing AutoRecovery Web Reporting .......................................... 2-59
  2.7.3 Configuring AutoRecovery Web Reporting ....................................... 2-60
  2.7.4 Customizing AutoRecovery Web Reporting ....................................... 2-61
    2.7.4.1 Setting the retainFlag Variable .................................................... 2-61
    2.7.4.2 Changing the Refresh Rate ........................................................... 2-62
    2.7.4.3 Accurate System Time ................................................................. 2-62
    2.7.4.4 Customizing the Apache Web Server .......................................... 2-62

3.0 FEMIS GIS Migration and Configuration .............................................. 3-1
  3.1 IEM GIS Upgrade .................................................................................. 3-1
  3.2 Preparing to Install FEMIS on One PC ................................................ 3-1
  3.3 Editing the FEMIS.INI File for the GIS Upgrade .................................... 3-2
  3.4 Populating the GIS-Related Tables ....................................................... 3-3
3.5 Migrating the FEMIS GIS from v1.4.5 to v1.4.6 ........................................................... 3-5
  3.5.1 Change Permissions on the Lookup Table .......................................................... 3-5
  3.5.2 Copy the GIS Files from the Server /home/femis/gis to a PC ................................ 3-5
  3.5.3 Updating the Mettower Theme ........................................................................ 3-5
  3.5.4 Populating the defaults.txt File .......................................................................... 3-6
  3.5.5 Save the DEFAULTS.TXT File ......................................................................... 3-9
  3.5.6 Upgrading the femisgis.ini and obj_type.lut Files to v1.4.6 ............................... 3-9
  3.5.7 Troubleshooting the Migration .......................................................................... 3-10
    3.5.7.1 Checking the v1.4.5 FEMISGIS.INI File ................................................... 3-11
    3.5.7.2 Checking the v1.4.5 obj_type.lut File ......................................................... 3-11
3.6 Copying the v1.4.6 GIS Files to the Other Servers ..................................................... 3-11
3.7 Completing the Installation on This PC .................................................................... 3-12

4.0 FEMIS PC Installation .......................................................................................................... 4-1
4.1 Installing the PC COTS .................................................................................................. 4-1
  4.1.1 Installing Windows NT v4.0 ............................................................................... 4-1
    4.1.1.1 Before Installing Windows NT ................................................................... 4-1
    4.1.1.2 Running the Installation Program .......................................................... 4-3
    4.1.1.3 Installing Windows NT Service Pack 4 .................................................... 4-7
  4.1.2 Installing an NFS System ..................................................................................... 4-8
    4.1.2.1 Uninstalling NFS Maestro v6.0.1 (or earlier) .......................................... 4-8
    4.1.2.2 Installing NFS Maestro v6.1 .................................................................... 4-9
    4.1.2.3 Installing Solstice NFS Client v3.2 ........................................................... 4-10
    4.1.2.4 Configuring Solstice NFS Client v3.2 ......................................................... 4-11
  4.1.3 Installing or Upgrading Oracle SQL*Net v2.3.4 and ODBC v2.5.3 ...................... 4-11
  4.1.4 Installing ArcView GIS v3.0 and v3.0a Patch ......................................................... 4-12
    4.1.4.1 Installing ArcView GIS v3.0 .................................................................... 4-13
    4.1.4.2 Installing ArcView GIS v3.0a Patch ......................................................... 4-13
    4.1.4.3 Creating the ArcView GIS Icon for All Users ........................................... 4-14
  4.1.5 Installing Microsoft Project 98 Service Release 1 ................................................. 4-14
  4.1.6 Installing Other COTS .......................................................................................... 4-15
4.2 Configuring the FEMIS Setup Program ........................................................................ 4-16
  4.2.1 Connecting the Network Install Drive ................................................................. 4-16
  4.2.2 Validating I:\CONFIG\FSETUP.INI File ............................................................ 4-17
  4.2.3 Validating I:\CONFIG\HOSTS File ................................................................... 4-17
  4.2.4 Validating I:\CONFIG\TNSNAMES.ORA File ............................................... 4-17
  4.2.5 Validating I:\CONFIG\ADDODBC.BAT File .................................................. 4-18
  4.2.6 Validating the AUTOEXNT.BAT File .............................................................. 4-18
  4.2.7 Validating I:\PC\NTP\NTP.CONF File .............................................................. 4-18
  4.2.8 Validating I:\USER Directory ......................................................................... 4-19
  4.2.9 Configuring the I:\PC\FEMTOOOLS\FEMIS.DBA File ................................. 4-19
4.3 Installing FEMIS Client Software ............................................................................... 4-20
  4.3.1 Preparation ......................................................................................................... 4-21
  4.3.2 Running the Setup Program ............................................................................... 4-21
  4.3.3 Verifying the GIS .INI files on the Server (Maryland Only) ............................... 4-23
4.4 Configuring the PC ........................................................................................................ 4-23
  4.4.1 Setting Up FEMIS User Accounts on Windows NT and UNIX .................. 4-23
    4.4.1.1 Adding User Accounts to Windows NT ........................................ 4-24
    4.4.1.2 Adding User Accounts to UNIX ................................................... 4-24
  4.4.2 FEMIS Startup Files ............................................................................................ 4-25
  4.4.3 Verifying the Temporary Directory and Environment Variables .......... 4-26
  4.4.4 Verifying the Clock Settings and Time Zone Settings ......................... 4-26
  4.4.5 Verifying the Time Synchronization Services ......................................... 4-27
    4.4.5.1 Verifying the AUTOEXNT.BAT File ........................................... 4-27
    4.4.5.2 Verify the AutoExNT Service ........................................................ 4-27
    4.4.5.3 Verify the Network Time Protocol (NTP) Service ...................... 4-28
  4.4.6 Verifying the Virtual Memory Setting ......................................................... 4-28
  4.4.7 Creating the FEMIS Icon ............................................................................... 4-28
  4.4.8 Final Steps for the FEMIS PC Installation and Configuration ............... 4-29
  4.5 Configuring FEMIS for All PCs at an EOC .................................................. 4-29
    4.5.1 Verifying the Zone Name Lookup for EMIS PAR ............................... 4-29
    4.5.2 Using FZONES.EXE Tool .................................................................. 4-30
  4.6 Guidelines for Updating All PCs at an EOC with New Files ....................... 4-30
  4.7 Validating the FEMIS PC Installation ................................................................. 4-31
    4.7.1 One Time at EACH EOC ........................................................................ 4-31
      4.7.1.1 Verify the Database Connection ................................................. 4-31
      4.7.1.2 Verify Default D2PC Case Exists ............................................. 4-32
      4.7.1.3 Verify the Evacuation Command Server .................................... 4-32
      4.7.1.4 Verify FEMIS/EMIS Data Exchange Interface (DEI) .................. 4-32
      4.7.1.5 Create a Plan for Validation Testing ........................................... 4-32
      4.7.1.6 Test the GIS on the Printer ......................................................... 4-34
      4.7.1.7 Verify E-mail ............................................................................... 4-34
      4.7.1.8 Verify the SEPR Icon Addresssee .............................................. 4-35
    4.7.2 Cleanup AFTER Validation ......................................................................... 4-35
      4.7.2.1 Delete Validation Datasets .......................................................... 4-35
      4.7.2.2 Ensure Exercise #1 Exists ............................................................ 4-35
      4.7.2.3 Remove Extraneous FEMIS UNIX User Accounts .................... 4-35
    4.7.3 Perform on EVERY PC ............................................................................ 4-35
      4.7.3.1 Ensure FEMIS Login Security ..................................................... 4-35
      4.7.3.2 Verify the PC Configuration ........................................................ 4-36
      4.7.3.3 Verify the PC Clock ..................................................................... 4-36
      4.7.3.4 Verify the Network Time Protocol (NTP) Service ...................... 4-36
      4.7.3.5 Verify Login ............................................................................... 4-37
      4.7.3.6 Verify Database Manager ............................................................ 4-38
      4.7.3.7 Verify the System Administration Utility ..................................... 4-38
      4.7.3.8 Verify D2PC ................................................................................. 4-38
      4.7.3.9 Verify D2PC Cases are Logged to the M: Drive ......................... 4-38
      4.7.3.10 Verify Notification Server ......................................................... 4-39
      4.7.3.11 Verify GIS ................................................................................ 4-39
      4.7.3.12 Verify Evacuation ...................................................................... 4-39
7.3.7 Building the Database................................................................. 7-5
7.3.8 Configuring the PC to Start the Database .................................. 7-6
7.3.9 Creating Database Schemas ....................................................... 7-7
7.3.10 Loading Data into the Database .............................................. 7-7
7.3.11 Creating Objects that Share Data ............................................ 7-8
7.3.12 Configuring FEMIS.INI for Stand-Alone Mode ....................... 7-8
7.3.13 Changing ODBC Data Source Values .................................... 7-8
7.3.14 Testing the Setup ...................................................................... 7-9
7.4 Remote Access Service ............................................................... 7-9
7.5 Verifying the Stand-Alone Installation ......................................... 7-10
### Acronyms and Definitions

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANAD</td>
<td>Name of a FEMIS database (Anniston Depot)</td>
</tr>
<tr>
<td>APR</td>
<td>Project file format (ArcView GIS)</td>
</tr>
<tr>
<td>BOM</td>
<td>Bill of Materials</td>
</tr>
<tr>
<td>COTS</td>
<td>Commercial-Off-The-Shelf</td>
</tr>
<tr>
<td>CSEPP</td>
<td>Chemical Stockpile Emergency Preparedness Program</td>
</tr>
<tr>
<td>CTOO</td>
<td>Name of a FEMIS database (Tooele County)</td>
</tr>
<tr>
<td>D2PC</td>
<td>Chemical wind dispersion model used in FEMIS</td>
</tr>
<tr>
<td>DAI</td>
<td>Data Acknowledgment Interface</td>
</tr>
<tr>
<td>DBMS</td>
<td>Database Management System</td>
</tr>
<tr>
<td>DEI</td>
<td>Data Exchange Interface</td>
</tr>
<tr>
<td>DNS</td>
<td>Domain Name Services</td>
</tr>
<tr>
<td>E-mail</td>
<td>Electronic Mail</td>
</tr>
<tr>
<td>EMIS</td>
<td>Emergency Management Information System</td>
</tr>
<tr>
<td>EOC</td>
<td>Emergency Operations Center</td>
</tr>
<tr>
<td>ESIM</td>
<td>Evacuation SIMulation, part of Oak Ridge Evacuation Modeling System (OREMS)</td>
</tr>
<tr>
<td>ESRI</td>
<td>Environmental Systems Research Institute, Inc.</td>
</tr>
<tr>
<td>FEMIS</td>
<td>Federal Emergency Management Information System</td>
</tr>
<tr>
<td>GB</td>
<td>Gigabyte–billion bytes</td>
</tr>
<tr>
<td>GID</td>
<td>Group Identification number</td>
</tr>
<tr>
<td>GIS</td>
<td>Geographic Information System</td>
</tr>
<tr>
<td>GMT</td>
<td>Greenwich Mean Time</td>
</tr>
<tr>
<td>HCL</td>
<td>Hardware Compatibility List</td>
</tr>
<tr>
<td>ICG</td>
<td>Oracle7 Installation &amp; Configuration Guide Release 7.3.3</td>
</tr>
<tr>
<td>IBS</td>
<td>Integrated Baseline System</td>
</tr>
<tr>
<td>IDYNEV</td>
<td>Interactive DYNamic EVacuation</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>KB</td>
<td>Kilobyte–thousand bytes</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>MB</td>
<td>Megabyte–million bytes</td>
</tr>
<tr>
<td>Met</td>
<td>Meteorological</td>
</tr>
<tr>
<td>NFS</td>
<td>Network File System</td>
</tr>
<tr>
<td>NTP</td>
<td>Network Time Protocol</td>
</tr>
<tr>
<td>ODBC</td>
<td>Open Database Connectivity</td>
</tr>
<tr>
<td>OREMS</td>
<td>Oak Ridge Evacuation Modeling System</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>PPP</td>
<td>Point to Point Protocol</td>
</tr>
<tr>
<td>PNNL</td>
<td>Pacific Northwest National Laboratory</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>RDBMS</td>
<td>Relational database management system</td>
</tr>
<tr>
<td>SBCCOM</td>
<td>U.S. Army Soldier and Biological Chemical Command</td>
</tr>
<tr>
<td>SMTP</td>
<td>Simple Mail Transfer Protocol</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SQL</td>
<td>Structured Query Language</td>
</tr>
<tr>
<td>SQL script</td>
<td>Sequence of SQL statements that perform database operations</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
<tr>
<td>TEAD</td>
<td>Name of a FEMIS database (Army Depot) and Tooele Army Depot</td>
</tr>
<tr>
<td>TNS</td>
<td>Transparent Network Substrate</td>
</tr>
<tr>
<td>UID</td>
<td>User Identification number</td>
</tr>
<tr>
<td>UNIX</td>
<td>Generic name for the Server Operating System</td>
</tr>
<tr>
<td>UTST</td>
<td>Name of a FEMIS database (Utah State)</td>
</tr>
<tr>
<td>WAN</td>
<td>Wide Area Network</td>
</tr>
<tr>
<td>WINS</td>
<td>Windows Internet Name Service</td>
</tr>
<tr>
<td>Windows NT</td>
<td>Microsoft Network Operating System for Workstations</td>
</tr>
</tbody>
</table>
1.0 Overview

The Federal Emergency Management Information System (FEMIS®)(a) is an emergency management planning and response tool that was developed by the Pacific Northwest National Laboratory(b) (PNNL) under the direction of the U.S. Army Soldier and Biological Chemical Command (SBCCOM). The FEMIS Installation Guide provides instructions for installing the FEMIS software package as well as the Commercial-Off-The-Shelf (COTS) software applications that are necessary for FEMIS to operate.

1.1 Point of Contact

We encourage you to contact us with suggestions or to ask questions. You can contact us by mail, telephone, fax, or E-mail:

Pacific Northwest National Laboratory
Ranata L. Johnson
P.O. Box 999, MS K7-28
Richland, WA 99352
Telephone: (509) 375-6311
Fax Number: (509) 375-3641
E-Mail address: ranata.johnson@pnl.gov

1.2 Document Organization

This document is organized into three sections and two appendices, which include details on the installation and configuration of FEMIS.

Section 1.0 - Overview – describes the point of contact, acknowledgment, document organization, software products, installation environment and storage requirements, and FEMIS directory structures.

Section 2.0 - FEMIS UNIX Installation – describes installing the UNIX operating system, the UNIX-based COTS software, installing the FEMIS UNIX software, and creating the FEMIS database.

Section 3.0 - FEMIS GIS Migration and Configuration – discusses the installation and configuration for upgrading the FEMIS GIS from v1.4.5 to v1.4.6.

Section 4.0 - FEMIS PC Installation – discusses the installation, configuration, and validation of the FEMIS application on client PCs.

(a) FEMIS software was copyrighted in 1995 by Battelle Memorial Institute.
(b) Pacific Northwest National Laboratory is operated for the U.S. Department of Energy by Battelle Memorial Institute under Contract DE-AC06-76RLO 1830.
Section 5.0 - Adding General Hazard Zones to the FEMIS Database – discusses the installation, configuration, and validation of adding this general hazard functionality.

Section 6.0 - Remote Evacuee Registration and Point-to-Point Protocol – discusses the Remote Evacuee Registration feature and establishing and setting up the Point-to Point (PPP)

Section 7.0 - Stand-Alone Installation of FEMIS v1.4.6 – discusses the installation configuration, and validation of the FEMIS Stand-Alone application.

1.3 Software Products

FEMIS integrates the following COTS software products.

<table>
<thead>
<tr>
<th>Software Application</th>
<th>Software Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>ArcView GIS</td>
<td>Environmental Systems Research Institute, Inc. (ESRI)</td>
</tr>
<tr>
<td>NFS Maestro</td>
<td>Hummingbird Communications Ltd.</td>
</tr>
<tr>
<td>Solstice NFS Client</td>
<td>Sun Microsystems, Inc.</td>
</tr>
<tr>
<td>Microsoft Windows NT Workstation</td>
<td>Microsoft Corporation</td>
</tr>
<tr>
<td>Microsoft Project for Windows</td>
<td>Microsoft Corporation</td>
</tr>
<tr>
<td>Oracle</td>
<td>Oracle Corporation</td>
</tr>
<tr>
<td>SQL*Net, TCP/IP Adapter, and ODBC Driver</td>
<td>Oracle Corporation</td>
</tr>
<tr>
<td>Solaris</td>
<td>Sun Microsystems, Inc.</td>
</tr>
</tbody>
</table>

FEMIS integrates the following government-furnished software products.

<table>
<thead>
<tr>
<th>Software Product</th>
<th>Software Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>D2PC (March 1998)</td>
<td>U.S. Army CBDCOM</td>
</tr>
<tr>
<td>PARDOS v3.1 (May 1997)</td>
<td>U.S. Army CBDCOM</td>
</tr>
<tr>
<td>Evacuation Simulation Model (ESIM v2.1f13)</td>
<td>Oak Ridge National Laboratory</td>
</tr>
</tbody>
</table>

The following software products are optional.

<table>
<thead>
<tr>
<th>Software Product</th>
<th>Software Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARC/INFO</td>
<td>Environmental Systems Research Institute, Inc.</td>
</tr>
<tr>
<td>Corel WordPerfect</td>
<td>Corel Corporation</td>
</tr>
<tr>
<td>Microsoft Office</td>
<td>Microsoft Corporation</td>
</tr>
</tbody>
</table>

1.4 Installation

This section discusses the FEMIS environment and storage requirements.
1.4.1 Environment

For FEMIS to operate correctly, the first step is to install all of the COTS software, including Oracle v7.3.4 on your UNIX system. FEMIS will not operate correctly if versions of the COTS software other than those specified in the *FEMIS Bill of Material (BOM)* are installed.

FEMIS uses NFS Maestro (a Hummingbird Communications Ltd. product) or Solstice NFS Client (a Sun Microsystems product) as its Network File System (NFS) for PC network communications. The NFS Maestro client and Solstice NFS Client have been tested by PNNL and are fully compatible with FEMIS requirements.

Although other vendors may claim to offer a fully standard NFS, PNNL has not verified and tested any other NFS configurations for PCs, and thus, cannot endorse such installations.

1.4.2 Storage Requirements

The FEMIS application requires disk space on both the client and server machines. PNNL has estimated the disk space requirements for each.

1.4.2.1 FEMIS Server

Disk space on the FEMIS server is used for:

- Server software (such as, the RDBMS [relational database management system] and the evacuation model).

- FEMIS application.

- FEMIS server utilities (notification, database monitor, replication).

- EOC databases (including archived and historic data).

- Storage of the FEMIS COTS software and the original GIS maps.

The above items can require 15+GB of storage to properly support FEMIS.

There are two sources of disk space associated with a FEMIS server as defined by the *FEMIS Bill of Materials (BOM)*:

1. System disk(s) resident in the Sun Server.

2. Sun SPARC storage Array connected to the Sun Server.
As stated in the *FEMIS Bill of Materials (BOM)*, PNNL recommends that the FEMIS storage requirement be fulfilled by using the Sun SPARCstorage Array to ensure that speed and reliability are provided to the FEMIS operational system. PNNL expects the FEMIS application to be placed in its entirety on the arrayed storage disks, which will enable the System Administrators (and PNNL) to better manage the FEMIS product and the EOC databases. PNNL expects the Sun SPARCstorage Array to be reserved solely for FEMIS use.

The system disks are not directly used by FEMIS. The disks are used for the operating system and the supporting applications. PNNL estimates that approximately 2GB of system disk space will be used for the operating system and swap space. Additional system disk space should be used at the System Administrator’s discretion.

### 1.4.2.2 FEMIS PC

Disk space on the client PC is required for the following:

- COTS software needed for FEMIS (Windows NT, ArcView GIS, Microsoft Project, SQL*Net, and other supporting applications).

- FEMIS application.

- Site specific GIS maps.

The amount of space required by the FEMIS application and supporting software will vary depending on the size of the GIS the user chooses to install. A medium size GIS installation requires approximately 900MB of disk space.

### 1.5 FEMIS Directory Structures

The following figures illustrate the FEMIS directory structure on the UNIX server and the directory structure for an emergency management PC workstation.
2.0 FEMIS UNIX Installation

The UNIX server is the primary data and information storage and distribution component. Its primary software elements consist of the Oracle database management system (DBMS); the Evacuation SIMulation (ESIM) model with supporting processes; the Notification Service; the command server; the meteorology (Met) data receiver; the FEMIS/EMIS Data Exchange Interface (DEI); and the sockets communications service.

The programs discussed require the UNIX environment on a Sun computer running Solaris v2.6 and utilizing standard Berkeley Sockets.

The FEMIS UNIX software installation consists of six major parts:

- Installing the UNIX Commercial-Off-The-Shelf (COTS)
- Installing the FEMIS UNIX Software
- Installing the FEMIS GIS and Database
- Checking the FEMIS Startup
- Utility to Add FEMIS User Account to the Database
- FEMIS AutoRecovery System.

The release media consists of files distributed on CDs, 8mm cartridge tapes, and floppy disks. The release material contains the necessary scripts and data to perform an initial installation or to upgrade existing FEMIS software to the current version. The Release Notes should be read before proceeding with the UNIX installation.

The FEMIS package consists of the following:

- COTS CD
- FEMIS application tape
- GIS/Database tape
- Suite of FEMIS documentation.

In addition to the FEMIS package, you will need Oracle media to complete the UNIX installation of FEMIS.

This guide is written assuming that your EOC is using local host network files. If your EOC is using some other facility, i.e., NIS/NIS+, you may have to use those facility-specific commands.
2.1 Installing the UNIX COTS

It is important to coordinate the UNIX group numbers between FEMIS and other software applications that are administered with NIS+. Possible conflicts may result in the FEMIS /etc/group file. To see which group numbers are currently used for NIS+, use the following command while logged in as root:

```bash
niscat /var/nis/data/group.org_dir
```

Make sure other Windows NT v4.0 software applications do not use drive M:\ because this drive is required by FEMIS. If the drive M:\ is currently being used by another application, coordinate with the software vendor to change this to another drive.

If you are installing for an NT account that has already been created, you will need to have the femisrun group added to the corresponding UNIX account on the server. If the UNIX account was created with NIS+, you may need to make a duplicate femisrun group in NIS+ with the same group number as used for femisrun in the /etc/group file.

The following sections describe the installation of the UNIX COTS.

2.1.1 Installing the Operating System

For installation or upgrade instructions, see the documentation provided with the operating system. Additional installation information is available on the FEMIS Web site at http://www.pnl.gov/femis under the Technical and User Support section.

Follow the instructions included with the Solaris v2.6 documentation.

*Note:* Installing operating system patches will require relinking the Oracle software. See Section 2.3.3.4, Relinking the Oracle Software.

Patch Cluster

Because all operating systems require patches to improve security and fix bugs, PNNL recommends installing Sun's Solaris 2.6 patch cluster. We have tested FEMIS v1.4.6 using the Dec 98 patch cluster.

If the patch cluster is not available, the following three patches must be installed for FEMIS v1.4.6. Use showrev -p to list your existing patches.

- Kernel patch – 105181-11
- Linker patch – 105490-04
- Syslog patch – 106439-02

*Note:* Check our web site (www.pnl.gov/femis/) for updates on patches that we have tested.
Y2K Compliance

Sun has released several patches that must be installed for Solaris 2.6 to be Y2K compliant. For these current patches, see http://www.sun.com/y2000/solaris26.html.

If you are using Sun’s DiskSuite software, you will need to install patch 104172-14 for it to be Y2K compliant.

To test your Solaris environment for Y2K compliance, Sun has developed SunScan (see www.sun.com/y2000). SunScan identifies hardware and software that is Y2K compliant, and it identifies patches that need to be installed.

Volume Manager/Storage Array Patches

PNNL is currently using Sun Enterprise Volume Manager version 2.5. In addition, we have installed SSA 2.5 patch number 105463-04.

Our SPARC storage array firmware is currently at version 3.12. To verify your version, use ssaadm display <controller> (where <controller> is your controller number, such as c1). We accomplished this by installing the following patches:

105223-04
105356-04
105375-08

Note: For firmware patches, be sure to follow the specific instructions in the Readme files.

Patch Locations

These and other patches are available from SunSolve Online at http://sunsolve.sun.com/ or the SunService Public Patch Page at ftp://sunsite.unc.edu/pub/sun-info/sun-patches/patches.html#agree (see the Readme file at http://sunsite.unc.edu/pub/sun-info/sun-patches/).

2.1.1.1 Automounting and FEMIS

Note: Using the automounter is optional, but strongly recommended by PNNL.

Note: If you have successfully installed FEMIS v1.4.5 or higher, then the automount points should have been set up. Review this section to verify they were set up correctly.

This section is intended to be an overview of automounting. Specific automounting instructions are located in the following sections.
FEMIS uses the automounter scheme to automatically and transparently mount file system resources for both home and application directories. The automounter uses a series of maps to define the file resources to be mounted. Setting up the automounter consists of defining the maps and starting the automounter program.

Master Map

The master map is located at /etc/auto_master. A master list, /etc/auto_master, provides a list of all maps on the system. It is read by the automounter daemon at system startup. The map for FEMIS looks similar to the following.

```plaintext
inet -hosts -noauid,nobrowse
/home auto_home
/apps auto_apps
/xfn -xfn
```

Indirect Maps

Indirect maps are used to mount file resources under a common directory. FEMIS needs two indirect maps for automounting: 1) /etc/auto_apps and 2) /etc/auto_home. The map, /etc/auto_home, contains the entries of the UNIX user login accounts to be mounted under /home. The indirect map for /etc/auto_home must look similar to the following.

Note: Your map should list users and directory paths at your site. Remember to replace system# with the name of your server.

```plaintext
femis -intr,rw,nosuid system1:/files3/home/femis
femx -intr,rw,nosuid system1:/files3/home/femx
usera -intr,rw,nosuid system1:/files5/home/usera
userb -intr,rw,nosuid system1:/files5/home/userb
userc -intr,rw,nosuid system1:/files5/home/userc
userd -intr,rw,nosuid system1:/files5/home/userd
usere -intr,rw,nosuid system2:/files5/home/usere
```

The /etc/auto_home map gives us a consistent view of home directories across a network. All home directories, whether remote or local, are mounted under each server's /home directory. As an example, a UNIX account for usere, which has a directory on system2 on partition /files5/home/usere, is mounted at /home/usere on the current system.

The indirect map for /etc/auto_apps should look similar to following.

```plaintext
oracle -intr,rw,nosuid system1:/files2/app/oracle
```
Automounter Map Availability

Changes to indirect maps are available right away. Changes to the /etc/auto_master are effective only by executing the automount command or by restarting the automount daemon.

```
# automount -v
```

or

```
# /etc/init.d/autofs stop
# /etc/init.d/autofs start
```

Note: Automount cannot reflect new file systems in cases where the currently automounted file system is moved out from underneath an actively automounted file system in lieu of a replacement file system. To replace a mapped automount file system, make sure no processes are active in the automount tree by using `fuser -nc <auto_mount_path>`, and that automount has released the mount point before changing an automounted file system.

FEMIS Users

Note: Actual UNIX user accounts are created as needed. Steps are provided for you to create accounts for Oracle and the FEMIS application in their respective installation sections.

If you are using the automounter, you will need to make an entry, in /etc/auto_home, for each new FEMIS user you add to your system. See Indirect Maps above for more information. For additional information on automounting and automount maps, see the man page on automount and your Solaris documentation.

2.1.1.2 Creating Users and Groups

This section provides an overview on guidelines and instructions for creating FEMIS UNIX user accounts and groups on your server. Specific instructions are supplied in the later sections.

You will need the following information to create a UNIX user account:

- Username
- User Identification Number
- Password
- Group Identification Number
- User Home Directory Path

Usernames

Note: The UNIX username must be the same as the corresponding Windows NT username.
Note: The PC must be restarted after a UNIX username has been changed.

Usernames, or login names, will allow the user to access the server with the appropriate access privileges. Your username should be:

- Unique within your organization
- Contain two to eight letters or digits
- One character must be lowercase
- First character must be a letter
- May not contain an underscore or space.

User Identification Numbers

A user identification (UID) number is assigned to each username. It identifies the user to the system and controls access to files and directories. UIDs have several requirements:

- UIDs must be unique for each user.
- UIDs must be whole numbers between 100 and 60000

Since many employers assign employees with unique employee numbers, System Administrators can use or manipulate employee numbers to get unique UIDs in the appropriate range. UIDs, along with the rest of the username data, is stored in the /etc/passwd file.

Password

Note: PNNL strongly recommends that the UNIX password be the same as the corresponding Windows NT password.

Each username must be assigned a password. Passwords have a big impact on systems security so follow these minimum conventions when creating your passwords. Your password should be:

- Be eight characters in length
- Include at least two digits
- Be changed often
- Avoid proper nouns, or any word a person could guess by knowing you
- Avoid words found in the dictionary
- Avoid Social Security numbers, phone numbers, and car license numbers.

Group Identification Numbers

A group is a collection of users who share files and other resources. Each group has a group name, a group identification (GID) number, and a list of usernames that belong to the group. A primary group is the group the operating system will assign to files created by the user. Each user belongs to one primary group. The primary group must already exist when adding a new user.
User Home Directory

The user's home directory is the space on disk that is allocated for a user. Use the fully qualified path name or see Section 2.1.1.1, Automounting and FEMIS, if automounting home directories.

Creating FEMIS User Accounts

All FEMIS accounts use the primary group femisrun. femisrun must already exist. See Section 13.1, Operating System Security, in the FEMIS System Administration Guide for more information.

Note: The user ID listed below is an example only. Select a user ID that is unique for your EOC.

1. Create the UNIX user account.

   # /usr/sbin/useradd -u NEWUID -g femisrun -c "Your Name" -d login_directory_path -s /bin/csh login_name

   Example:

   # /usr/sbin/useradd -u 4000 -g femisrun -c "John Doe" -d /files1/home/jdoe -s /bin/csh jdoe

   If automounting, the login directory path should be /home/login-name.

2. Create the appropriate home directories for the newly created accounts.

   # mkdir -p login_directory_path
   # chgrp femisrun login_directory_path
   # chown login_name login_directory_path

3. Set the account password.

   # passwd login_name

   If you are using the automounter, make the appropriate entry in the /etc/auto_home file. See Section 2.1.1.1, Automounting and FEMIS, for more information.

For additional information on UNIX user accounts and groups, see the man pages on useradd, groupadd, passwd, and your Solaris documentation.

STOP

If you have AutoRecovery installed on your server and will be installing or upgrading FEMIS, Oracle, or UNIX COTS software, you MUST stop AutoRecovery until you complete the UNIX installation.
To stop AutoRecovery, edit the root crontab file and comment out the lines pertaining to AutoRecovery.

1. Login as root.

2. Enter the following:
   
crontab -e

3. Comment out the lines following `#FEMISar`.

   Example:

   `#FEMISar
   #0 1-5 * * * LD_LIBRARY_PATH=/opt/local/bin/femis-watch > /dev/null 2>&1 #FEMISar
   #0 0 0 * * sh /opt/local/bin/logit > /dev/null 2>&1 #FEMISar`

When you have completed the UNIX installation process (upgrade or fresh install), be sure the lines in the crontab file are uncommented. AutoRecovery is the last UNIX item to be installed/upgraded. Installation and upgrading instructions for AutoRecovery are in Section 2.6, FEMIS AutoRecovery System Description and Installation.

2.1.2 Installing the NFS Authentication Services Daemon

FEMIS v1.4.6, you can install either NFS Maestro v 6.1 or Sun PC NFS v1.2 as your authentication service daemon. The following sections provide installation instructions for both NFS packages.

**CAUTION**

Before upgrading an NFS package, confirm that the package is not in use.

**Note:** If you have an older version of the NFS Maestro or Sun PC NFS package on your server, you must remove it. If the NFS software was installed manually (no packages were used), determine from the entries in `/etc/init.d` the location of the software and remove it along with its start/stop scripts in `/etc/init.d` and/or `/etc/rd#.d` directories.

2.1.2.1 Determining Version of NFS Daemon

If you do not know if NFS Maestro or Sun PC NFS has been installed as a package on your server, enter the following commands:
# pkginfo -1  HCLNFS
# pkginfo -1  SUNWpcnfd

2.1.2.2 Removing Previous NFS Daemon

To remove the old version of the NFS Maestro or Sun PC NFS package, enter the following commands:

# pkgrm HCLNFS
# pkgrm SUNWpcnfd

2.1.2.3 Installing Hummingbird NFS Daemon

Note: When installing the FEMIS package from the spool directory, it is possible to receive a Sun Package installation error, Broken Pipe. This error happens when the last package in the list is not selected for installation. This error will not cause any problems with the FEMIS installation. Continue with the installation.

The Hummingbird NFS Daemon (NFS Maestro v6.1) has been included with FEMIS v1.4.6. To install the NFS Daemon, complete the following steps.

1. Login as root and insert the FEMIS application tape into the tape drive.

2. Create a temporary spool directory.

   # mkdir /<dir>/spool
   # chmod 755 /<dir>/spool

   Spool the installation package from the 8mm tape using the Solaris software installation utility.

   # pkgadd -s /<dir>/spool -d /dev/mnt/??

   where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd utility to install the FEMIS package.

   # pkgadd -d /<dir>/spool

3. Select the HCLNFS application for installation.

4. Select y to continue when the following prompt displays: "This package contains scripts which will be executed with super-user permission during the process of installing this package."

5. Select q to quit after installing the HCLNFS package.
6. Use pkgchk to verify the package was installed correctly.

   # pkgchk -n HCLNFS

7. Ignore the following errors:

   ERROR: /etc/init.d/hclnfs
   Permission <0755> expected <0744> actual
   Group name <other> expected <sys> actual

   If you only see the above output, or you get a prompt with no output, the package installed successfully.

8. Enter the following command to start the Hummingbird NFS daemon:

   # sh /etc/init.d/hclnfs start

### 2.1.2.4 Installing Sun PC NFS Daemon

The Sun PC NFS Daemon (SUNWpcnfd) has been included with FEMIS v1.4.6. To install the Sun PC NFS Daemon, complete the following steps.

1. Login as root.

2. Insert the FEMIS application tape into the tape drive.

   To create a temporary spool directory, run the following:

   # mkdir /<dir>/spool
   # chmod 755 /<dir>/spool

   Spool the installation package from the 8mm tape using the Solaris software installation utility.

   # pkgadd -s /<dir>/spool -d /dev/mnt/??

   where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd utility to install the FEMIS package.

   # pkgadd -d /<dir>/spool

3. Select the SUNWpcnfd application for installation.

4. Select y to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.

5. Select q to quit after installing the SUNWpcnfd package.
6. Use pkgchk to verify the package was installed correctly.

   # pkgchk -n SUNWpcnfd

7. Ignore errors like the following:

   ERROR: /etc/init.d/SUNWpcnfd
   Permission <0755> expected <0744> actual
   Group name <other> expected <sys> actual

   If you only see the above output, or you get a prompt with no output, the package installed successfully.

8. Enter the following command to start the Solstice NFS daemon:

   # sh /etc/init.d/SUNWpcnfd start

2.1.3 Installing an E-mail Package

Install your E-mail package according to documentation provided by the vendor.

2.2 Installing the FEMIS UNIX Software

Before configuring the FEMIS UNIX software on the server, you must determine the FEMIS home directory

   Example: /home/femis

Using the Solaris software installation utility, pkgadd, the FEMIS application and support files will be installed to the Sun server.

2.2.1 Creating UNIX Accounts on the Server

   Note: If you have successfully installed FEMIS v1.4.5 or higher, then skip this section.

You will need to create several new UNIX accounts on the server to prepare for the FEMIS package installation.

   1. Login as root.

   2. Create the following accounts (numeric IDs are for example only):

      # /usr/sbin/groupadd -g 30510 femisrun
      # /usr/sbin/groupadd -g 30508 femis
      # /usr/sbin/useradd -u 30508 -g femisrun -c "FEMIS Account" -d /home/femis -s /bin/csh femis
If you are running DFI, create the following account:

Note: This should only be done on the onpost server.

# /usr/sbin/useradd -u 30509 -g femisrun -c "FEMX Account" -d /home/femx -s /bin/csh femx

3. Create the appropriate home directories for the newly created accounts. Make sure each directory has the correct owner and group.

# mkdir -p /<file system>/home/femis
# chgrp femisrun /<file system>/home/femis
# chown femis /<file system>/home/femis

Note: Creating the femx directory should only be done on the onpost server.

# mkdir -p /<file system>/home/femx
# chgrp femisrun /<file system>/home/femx
# chown femx /<file system>/home/femx

4. Set the account password.

# passwd femis

Note: Setting the femx password should only be done for the onpost server.

# passwd femx

5. Edit /etc/auto_home and add entries for both the femis and femx accounts, if your system uses automount maps. The entries must look similar to the following:

femis -intr, rw, nosuid systemname: path
femx -intr, rw, nosuid systemname: path

Example:

femis -intr, rw, nosuid mysystem:/<file system>/home/femis
femx -intr, rw, nosuid mysystem:/<file system>/home/femx

See Section 2.1.1.1, Automounting and FEMIS, for more information.

6. Add the following line to the /etc/dfs/dfstab file:

share -F nfs -o rw /<disk>/home/femis

where <disk> is whichever device /home/femis is on.
Note: To restrict NFS access, see the man pages on share and share_nfs in your Solaris documentation.

If you do not have any other entries in the dfstab file, you will need to start the NFS server process. If you do not start the NFS server process, you will see errors like “RPC: Program not registered” when entering the shareall command (see below). To start the NFS server process, type the following:

```
# /etc/init.d/nfs.server start
```

To make the /<disk>/home/femis directory available to NFS authentication services (daemon) type

```
# shareall
```

To check that the directory is available to NFS Maestro type

```
# share
```

You should see output similar to the following:

```
# - /<disk>/home/femis rw **
```

### 2.2.2 Upgrading the FEMIS Application

Note: If you are doing a new install of FEMIS, then skip this section. If you have successfully installed FEMIS v1.4.5 or higher, then you must complete this section.

To prepare for the new version (an upgrade) of FEMIS, check for the existence of required user accounts, backup the FEMIS directory, and remove the old FEMIS installation.

1. Login as root.

2. Copy the site-specific directories to another location using the following commands:

   Note: The <backup> directory in the following represents a file system of your choice on this server where you can save a copy of the files. You will need to restore the /home/femis/user directory at the end of the Section 2.2.3, Installing the FEMIS Package.

   ```
   mkdir <backupdir>
   # cd /home/femis
   # tar cf - user configd etc | (cd <backupdir>; tar xf -)
   ```

   Use these files to reference site-specific information, as needed.
3. Make sure both the femis and femisrun accounts exist, if you are installing on the onpost server. Otherwise, only the femis account needs to exist.

```
# grep femis /etc/passwd
```

Your output should look similar to this:

```
femisrun:x:30510:30510:FEMISrun Account:/home/femis/bin/date
femis:x:30508:30510:FEMIS Account:/home/femis/bin/csh
```

If your output is blank, you need to add the femis and femisrun accounts. See Section 2.2.1, Creating UNIX Accounts on the Server, to add these accounts.

If you are running DEI, the femx account should exist.

```
# grep femx /etc/passwd
```

Your output should look similar to the following:

```
femx:x:30509:30510:FEMX Account:/home/femx/bin/csh
```

If your output is blank, you will need to add the femx account. See Section 2.2.1, Creating UNIX Accounts on the Server, to add this account.

4. Before removing the FEMIS package, stop all FEMIS processes, such as DAI, DEI, and Notification.

Login as femis.

On all servers

```
% stopnotify  This will stop Notification.
```

Onpost only

```
% femisdei -kill
% stopdai.sh
```

5. Remove the FEMIS application. If the application is in package form, do the following:

Login as root.

```
# pkgrm FEMIS
```
You will most likely see warning messages about package dependencies similar to the following:

```
## Verifying package dependencies.
WARNING:
The <FEMISgs> package depends on the package currently being removed.
WARNING:
The <FEMISdb> package depends on the package currently being removed.
Dependency checking failed.
```

Do you want to continue with the removal of this package [y,n,?,q]

If this message appears, answer Yes by typing a y and pressing Enter.

6. Delete the site-specific directories that you backed up in Step 2.

```
# rm -r /home/femis/user
# rm -r /home/femis/configd
# rm -r /home/femis/etc
```

2.2.3 Installing the FEMIS Package

Note: When installing the FEMIS package from the spool directory, it is possible to receive a Sun Package installation error, Broken Pipe. This error happens when the last package in the list is not selected for installation. This error will not cause any problems with the FEMIS installation. Continue with the installation.

You will copy the FEMIS package to a spool directory and install FEMIS by completing the following steps.

1. Login as root.

2. Enter the following command to mount the FEMIS installation directory, if you are using the automounter.

```
cd /home/femis
```

3. Insert the FEMIS application tape into the tape drive.

The FEMIS application will require 40MB of disk space for a spool directory. To create a temporary spool directory, run the following:

```
# mkdir /<dir>/spool
# chmod 755 /<dir>/spool
```
Spool the installation package from the 8mm tape using the Solaris software installation utility.

```
# pkgadd -s <dir>/spool -d /dev/rmt/??
```

where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd utility to install the FEMIS package.

```
# pkgadd -d <dir>/spool
```

4. Select the FEMIS application for installation.

Ignore any warning messages about disk space.
If the femnx account was created prior to the installation, you will be asked if you want to install DEI.
If the server will be running the FEMIS DEI, select y to install the DEI options.

Select y to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.

5. Select q to quit, after the FEMIS application has been installed.

6. Use pkgchk to verify the FEMIS package has installed correctly.

```
# pkgchk -n FEMIS
```

Ignore the following errors:

```
ERROR: /etc/init.d/femis
permissions <0644> expected <0744> actual group name <other> expected <sys> actual
ERROR: /home/femis
permissions <0755> expected <0775> actual owner name <femis> expected <fem> actual
```

If you only see the above output, or you get a prompt with no output, the package installed successfully.

7. Remove the spool directory, only if you are not installing the GIS or database.

```
# rm -r <dir>/spool
```

8. Restore only FEMIS application user directories in the /home/femis/user directory from the backup you made in Section 2.2.2, Upgrading the FEMIS Application (Step 2), if you are upgrading the FEMIS application,
9. Set the setgid bit for the /home/femis/user directory.

   # find /home/femis/user -type d -exec chmod g+xs {} \\

10. Remove the FEMIS application tape from the drive.

### 2.2.4 Installing Network Time Protocol (NTP)

This section describes the steps required to remove the Network Time Protocol (NTP) package bundled with previous versions of FEMIS, and it steps you through configuring the NTP software bundled with the Solaris operating system.

If you have any version of the FEMIS NTP package on your server, you will need to remove it. If you do not know if NTP is installed as a package on your server, enter the following command:

   # pkginfo | grep XNTPD

A result similar to the following means the NTP package is installed on your server.

```
application XNTPD Network Time Protocol
```

#### Removing the Old Version of NTP

1. Stop the NTP daemon.

   # sh /etc/init.d/ntp stop

2. Save the old ntp.conf file for reference.

   # cp /etc/ntp.conf /etc/ntp.conf.old

To remove the old version of the NTP package, enter the following command:

   # pkgm XNTPD

Select y to continue when the following prompt displays: “Do you want to remove this package?”

Also select y for this prompt: “Removing installed package instance <XNTPD>. This package contains scripts that will be executed with super-user permission during the process of removing this package. Do you want to continue with the removal of this package [y,n,? ,q]”

#### Configuring NTP

**Note:** You do not need to configure NTP if you already have the Solaris version of NTP configured.
NTP is included with the Solaris operating system. To configure NTP complete the following steps.

1. Login as root.

2. cd /home/femis/install

3. Run the following script to configure an ntp.conf file in the /etc/inet directory and start the NTP daemon (xntpd). You may need information from the ntp.conf.old file in the /etc directory before running this script. Then you may remove the ntp.conf.old file.

   sh ntp_config

   The installation will ask if the server will get time from another server; select y if yes, otherwise select n.

   If you selected y above, the installation will prompt for the NTP server’s Internet Protocol (IP) address. Make sure the NTP server is accessible (available on the network) as the installation will attempt to ping the NTP server.

   The message: “/etc/inet/ntp.conf already exists. It will not be reconfigured.” means the script found an existing /etc/inet/ntp.conf file and exited without making any changes to the /etc/inet/ntp.conf file.

4. Check your NTP configuration.

   ntptrace <servername>

   It may take awhile before your output shows a traceback other than a “timeout”. Once the traceback information displays correctly, NTP is configured.

For additional information on NTP see the Section 12.0, Server Network Time Protocol (NTP) Set Up, in the *FEMIS System Administration Guide*.

Note: If the server is not synching with any time source, you must change the file so NTP will work. See Section 12.0, Server Network Time Protocol (NTP) Set Up, in the *FEMIS System Administration Guide* for instructions.

### 2.3 Installing the FEMIS GIS and Database

If this is a new installation of FEMIS, you will need to install both the Oracle software (v7.3.4) and the FEMIS GIS and database packages.

If you are upgrading to a new version of FEMIS, you may have to upgrade Oracle to v7.3.4, and may have to install the appropriate FEMIS GIS and database package from the tape if you did not previously have FEMIS v1.4.5 installed.
In FEMIS, database topologies are defined either as NxN or NxM, which are number pairs that indicate
the number of EOC databases and the number of servers. For example, a 3x3 (or NxN) configuration
indicates three EOCs on three servers. Likewise, an 8x4 (or NxM) configuration represents eight EOCs
on four servers.

On each server, Oracle schemas are created to store the EOC data. The schemas are broken into two
groups: 1) data owner schema or 2) snapshot owner schema. A data owner schema has the database
tables that store the data for an EOC. A snapshot owner schema has a set of specialized snapshot tables
that are created to support the replication of data.

On every NxN configuration, there is exactly one data owner and N-1 snapshot owners per server. By
definition, NxM configurations have more than one data owner on at least one of the M servers in the
configuration.

The terms data owner and snapshot owner will be used frequently throughout this section and as the
installation is performed. You will need to know which server has which data owner within your
configuration.

To properly complete the installation for your site, follow the instructions in the Section 2.3.1, Installing
the GIS and Oracle Database through Section 2.3.5.7, Setting Up the Oracle Crontab.

2.3.1 Installing the GIS and Oracle Database

Note: Complete this section only if you are installing a new FEMIS GIS and database package.
If you are upgrading the existing database skip to the next section.

To install the GIS and database package, complete the following steps.

1. Insert the GIS and database tape into the tape drive.

   This installation may require considerable disk space for a spool directory. To create a temporary
   spool directory, run the following commands but only if you did not create the spool when you
   installed the FEMIS package.

   # mkdir /<dir>/spool

   Spool the installation package from the 8mm tape using the Solaris software installation utility.

   # pkgadd -s /<dir>/spool -d /dev/rmt/??

   where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd
   utility to install the GIS and database package.

   # pkgadd -d /<dir>/spool
2. Select the numbers corresponding to your site’s GIS and database using commas as separators.

3. Select q to quit, after the GIS and database have been installed.

4. Use pkgchk to verify the packages were installed correctly.

   #pkgchk -n <package name>

   No output is expected as a result of this command.

5. Remove the spool directory.

   # rm -r /<dir>/spool

6. Remove the tape from the drive.

### 2.3.2 Database Cleanup Tasks

The following tasks describe how to prepare your existing database for an upgrade. Check each subsection to see if it pertains to your site.

#### 2.3.2.1 Dropping Database Objects and Exporting Data Owners

**Note:** Complete this section only if you have a previous version of FEMIS installed. If you do not have a previous version installed, skip this section and go to Section 2.3.2.2, Removing Current Oracle Installation.

1. Drop all the non-table objects. If you are upgrading on an NxM or NxN system, the master drop script will drop objects from all servers in the configuration; and therefore, only needs to be performed on one server.

   **Note:** Before using the master_dr.sql script, remove the “Quit” statement at the bottom of the master_rep_stop.sql script.

   As femis user:

   % cd /home/femis/database/eocdba
   % sqlplus /nologin
   SQL> @master_dr

   Watch the progress of the master_dr.sql script. If you do not have any problems, press Enter after each Pause statement is encountered.
2. Perform an export of all FEMIS data owners on each server. The export files created in this step will be re-imported later if you need to reinstall Oracle. If you are not going to reinstall or upgrade Oracle, then export this data as a safety precaution.

Note: To determine the "data owner" schemas, review the /home/femis/etc/eoclist.dat file. The first column lists all EOCs for your site. The third column lists the server where the EOC is a data owner. Perform an export for every EOC whose server matches your server.

As femis user:

% cd $/home/femis/database/exports/<site name>
% svrmgr
SVRMGR>connect internal (system response should be Connected.)
SVRMGR>shutdown immediate (system response should be Oracle instance shut down.)
SVRMGR>startup (system response should be "Oracle instance started...")
SVRMGR>exit
% exp userid=<data owner name>lcdata owner password> file=<EOC_name>_cdate (yyyymmdd)>dmp log=<EOC_name>_cdate.log

Repeat this export command for each data owner schema that resides on this server. For example, if you have eight EOCs at your site but only three EOC databases reside on this server, then you will make three database exports on this server. You must then export the remaining data owners from each of the other servers in the configuration.

2.3.2.2 Removing Current Oracle Installation

Note: The following tasks are only required if you are upgrading to Oracle v7.3.4. If you are installing Oracle for the first time or if you already have Oracle v7.3.4 installed, then skip this section.

1. Login as oracle user and enter the following to shutdown the old database, shutdown the listener, and delete the old Oracle files.

% svrmgr
SVRMGR>connect internal
SVRMGR>shutdown immediate
SVRMGR>exit
% lsnrctl
LSNRCTL>stop
LSNRCTL>exit

Note: Before removing the Oracle Product directory, confirm that all Oracle Instances (some facilities have multiple instances running) have been shutdown. Use the ps and grep commands to identify the Oracle processes. For example ps -ef |grep oracle | sort.
2. Identify the location of the Oracle data and log files, and delete them.

% cd
% ls files*/app/oracle/ordata/*
% rm/files*/app/oracle/ordata/*

% cd $ORACLE_HOME
% cd ..
% rm -rf <oracle_directory>

The oracle_directory is named after the version number, for example, for Oracle v7.3.3 the directory is named 7.3.3. To confirm the removal of this directory, enter

ls

3. Save the current configuration files in /var/opt/oracle.

% cd /var/opt/oracle
% mkdir bkp
% cp *.ora ./bkp

2.3.3 Installing Oracle Software or Relinking Oracle

Note: If you do not have Oracle v7.3.4 (the version required for FEMIS v1.4.6) installed, carefully review each of the following sections and determine which sections pertain to your site.

If you already have the Oracle v7.3.4 installed, you may need to relink the Oracle software. To determine if relinking is necessary, go to Section 2.3.3.4, Relinking the Oracle Software, and skip Sections 2.2.3.1, 2.2.3.2, and 2.3.3.3.

Before beginning the Oracle installation, you should review the installation guide provided by Oracle v7.3.4, Oracle7 Release 7.3.4 for Sun SPARC Solaris 2.x Installation Guide. The following steps are required to install Oracle and identify specific parameter settings required by FEMIS.

2.3.3.1 Creating the UNIX Environment for Oracle

Note: Numeric IDs in this section are for example only.

To create the UNIX environment for Oracle v7.3.4, complete the following steps.

1. Select a drive on which to install Oracle (this will be referred to as <install_drive>). The drive must have a minimum of 800MB available. Select two additional drives on which to locate the FEMIS database files (these will be referred to as <driveA> and <driveB>). Each of these drives should have a minimum of 500MB available. It is recommended that all drives used are RAID volumes. For
complete information on server drives, see the FEMIS Bill of Materials (BOM) or on the FEMIS web site at http://www.pnl.gov/femis. The following command will allow you to view the drives and their available storage space.

% df -k

2. Login in as root.

Check if there is a group named dba in the /etc/group file, and determine if oracle is a member of the dba group.

# grep dba /etc/group

Verify a line in the file resembles the following:

dba::26000:oracle or dba::26000:

If the line above does not exist, use the following command to add a dba group:

# /usr/sbin/groupadd -g 26000 dba

Note: You may select any number for your group identification (GID) number that is not currently being used. Be sure to check for the existence of a GID in both the /etc/group file and NIS+ (if your site uses NIS+).

3. Check if an oracle account already exists.

# grep oracle /etc/passwd

Verify a line in the file resembles the following.

oracle:x:300:26000:oracle account:/apps/oracle:/bin/csh

If the line does not exist, use the following command to add the oracle user assigned to the dba group:

# /usr/sbin/useradd -u 300 -g dba -c "Oracle Account" -d /<install_drive>/app/oracle -s /bin/csh oracle

Set the Oracle password to your desired value using the UNIX passwd process.

#passwd oracle

If an Oracle account already exists, verify that the login directory is correct. Change the password, if desired.
4. Create the following directories.

   ```bash
   % su -
   # mkdir -p /<install_drive>/app/oracle
   # chown oracle /<install_drive>/app/oracle
   # chgrp dba /<install_drive>/app/oracle
   # chmod 755 /<install_drive>/app/oracle
   # mkdir -p /<driveA>/app/oracle
   # chown oracle /<driveA>/app/oracle
   # chgrp dba /<driveA>/app/oracle
   # chmod 755 /<driveA>/app/oracle
   # mkdir -p /<driveB>/app/oracle
   # chown oracle /<driveB>/app/oracle
   # chgrp dba /<driveB>/app/oracle
   # chmod 755 /<driveB>/app/oracle
   # exit
   ```

5. Set up the automount map. If your system uses automount maps, edit /etc/auto_apps and add the following line:

   ```bash
   oracle -intr,rw,nosuid systemname:path
   ```

   Example:

   ```bash
   oracle -intr,rw,nosuid Mysystem:/<install_drive>/app/oracle
   ```

   See Section 2.1.1.1, Automounting and FEMIS, for more information.

6. Make sure there is adequate shared memory. Examine the following parameters in the /etc/system file.

   * semaphore set identifiers
     set semsys:seminfo_semmni=256
   * total semaphores
     set semsys:seminfo_semmns=1800
   * max Oracle processes per instance
     set semsys:seminfo_semmnl=600
   * max size (bytes) of a single shared mem segment
     set shmsys:shminfo_shmmax=83886080
   * min size (bytes) of a single shared mem segment
     set shmsys:shminfo_shmmni=1
   * max shared mem identifiers
     set shmsys:shminfo_shmmni=400
   * max segments per process
     set shmsys:shminfo_shmseg=36

   If there are no parameters, copy them from the template. As root, set them to the recommended values shown above or as high as possible for the operating system.
A copy of the recommended values can be found in

/home/femis/install/oracle_template/kernl_params.dat

Note: If any of these parameters are changed, you must reboot the server (as root, use the init 6 command to reboot) before proceeding.

7. Verify there is at least three times as much swap space as physical RAM. If additional swap space is required, see your System Administrator.

To determine how much physical RAM you have, enter the following command:

```
# prtconf | grep size
```

To determine the available swap space, enter the following command:

```
# /usr/sbin/swap -s
```

8. Verify that the necessary Solaris 2.6 packages are installed prior to installing Oracle.

```
#> pkginfo -i SUNWbtool SUNWtoo SUNWsprot SUNWare SUNWlibm SUNWlibms SUNWheaw SUNWmfrun
```

9. Install any of the packages that do not appear in the list that displays.

10. Verify there is a local bin directory /usr/local/bin. If the directory does not exist, then it should be created as root.

11. Create the /var/opt/oracle directory.

```
% mkdir -p /var/opt/oracle
% chown -R oracle /var/opt/oracle
% chgrp -R dba /var/opt/oracle
% chmod -R 755 /var/opt/oracle
```

12. Log completely off and back onto the server as oracle.

13. Copy the template files to the admin directory.

```
% cp -r /home/femis/install/oracle_template/* /<install_drive>/app/oracle/admin
% chown -R oracle /<install_drive>/app/oracle/admin
% chgrp -R dba /<install_drive>/app/oracle/admin
% chmod -R 755 /<install_drive>/app/oracle/admin
```
14. Copy the new configuration files to /var/opt/oracle.

   **Note:** If you previously had FEMIS installed, you should skip this step since the SQL*Net parameters on the server are already in place.

   ```
   % cd /<install_drive>/app/oracle/admin
   % cp -p listener.ora /var/opt/oracle
   % cp -p tnsnames.ora /var/opt/oracle
   % cp -p sqlnet.ora /var/opt/oracle
   ```

15. Create the product and documentation directories.

   ```
   % mkdir -p /<install_drive>/app/oracle/product/7.3.4/odoc
   % chown -R oracle /<install_drive>/app/oracle/product
   % chgrp -R dba /<install_drive>/app/oracle/product
   % chmod -R 755 /<install_drive>/app/oracle/product
   ```

16. Copy the new Oracle UNIX setup file to the installation directory.

   **Note:** If you previously had FEMIS installed, you should compare your existing configuration files with the new ones. If your existing files have been customized, then do not overwrite them but perform Step 16 to make sure the values are still correct for this server.

   ```
   % cd /<install_drive>/app/oracle/admin
   % cp -p oracle.mycshrc /<install_drive>/app/oracle/.mycshrc
   % cp -p oracle.cshrc /<install_drive>/app/oracle/.cshrc
   % cp -p oracle.oraclerc /<install_drive>/app/oracle/.oraclerc
   % cp -p oracle.login /<install_drive>/app/oracle/.login
   ```

17. Make sure the following environment variables are correct in .oraclerc file.

   ```
   ORACLE_TERM (set it to match the xterm for the given keyboard: xsun or xsun5)
   ORACLE_BASE = /<install_drive>/app/oracle
   ORACLE_HOME = /$ORACLE_BASE/product/7.3.4
   PATH includes:
   $ORACLE_HOME/bin
   /usr/local/bin
   /bin
   /usr/bin
   /usr/ccs/bin
   ORACLE_SID = fi<<
   ORACLE_DOC = $ORACLE_HOME/odoc
   LD_LIBRARY_PATH=/usr/dt/lib:/usr/ucb/lib:/usr/openwin/lib:/$ORACLE_HOME/lib:
   /usr/openwin/lib:
   ORACLE_NLS = $ORACLE_HOME/common/nls/admin/data
   TNS_ADMIN=/var/opt/oracle
   ```
18. Create the directories that Oracle uses for database backups.

% cd /<install_drive>/app/oracle/admin
% ./dbbackup_setup

This executable will check on needed environment variables and then create directories. If any errors are reported, correct them and then rerun the setup process.

2.3.3.2 Installing the Oracle Software

Complete the following steps to install the Oracle v7.3.4 software.

1. Log completely off and back onto the server as oracle.

2. Insert the Oracle7 Server v7.3.4 CD into the CD drive.

3. Mount the CD

   $ cd /cdrom/cdrom0/orainst

4. Run the installer.

   ./orainst /m

5. Install the Oracle products. Select the following from the installer menu items.

   Select Default install
   Select Install, Upgrade, or De-Install
   Select Install New Product – Do Not Create DB Objects
   Check variables and paths as requested, and edit as needed

   From the Software Asset Manager window, select all of the following products, and click Install:

   Advanced Replication Option  7.3.4.0.0
   Oracle On-Line Text Viewer    1.0.1.0.0
   Oracle Server Manager (Motif) 2.3.4.0.0
   Oracle Unix Installer        4.0.1.0.0
   Oracle7 Distributed DB Option 7.3.4.0.0
   Oracle7 Server (RDBMS)        7.3.4.0.1
   PL/SQL (V2)                   2.3.4.0.0
   SQL*Net (V2)                  2.3.4.0.0
Federal Emergency Information Systems (FEMIS)

SQL*Plus 3.3.4.0.1
TCP/IP Protocol Adaptor (V2) 2.3.4.0.0

6. Verify the following when prompted:

   - dba for DBA group
   - dba for OSOPER group
   - Accept the default for X-Windows libraries.

7. Select Yes to the message Would you like to regenerate shared version of the Oracle library for Pro C, OCI, and XA clients? Shutdown all applications using Oracle shared library.

   Select Yes, and the following message displays: Installation of shared Oracle library for ProC, OCI, and XA clients is complete. Click OK.

8. Exit the installer, close the current window session; and open a new one after the products have been installed. This will place the newly installed products in the Oracle path.

   Note: Ignore the message about running the root.sh script. You will run it later during this Oracle installation.

9. Rename the initx.ora file in $ORACLE_HOME/rdbms/install/rdbms, and replace it with the template file. This will set the db_block_size to 4096KB.

   $> cd $ORACLE_HOME/rdbms/install/rdbms
   $> mv initx.ora initx.org
   $> cp /<install_drive>/app/oracle/admin/initx.ora.

10. Restart the installer.

    $> cd $ORACLE_HOME/orainst
    $> ./orainst /m

    Select the Default Install
    Select Create/Upgrade Database Objects
    Select Create Database Objects
    Verify Environment Variables
    Accept the Default File Locations
    Install Oracle7 Server (RDBMS) v7.3.4 from the Software Asset Manager
    Select Create Product DB Objects
    Select Filesystem-Based Database
    Elect to distribute control files over three mount points
    Enter the mount points as entered in the following format: /<files x>/app/oracle
    Select US7ASCII character set
    Set all passwords to dba <SID#> (for example for fi6 use dba6)
    Elect to set passwords for the internal users (dba and operator)
Select the default of 1 concurrent dba users expected
Choose not to start the Multithreaded Server
Accept the default locations for the control files
Examine the default locations and sizes of the database files through the first two windows; then reject the default settings, and use the recommended locations and sizes given below:

- system01.dbf
  /<driveB>/app/oracle/ordata/100M
- redo01<01.log
  /<install_drive>/app/oracle/ordata/20M
- redo01<02.log
  /<driveA>/app/oracle/ordata/20M
- redo01<03.log
  /<driveB>/app/oracle/ordata/20M
- rbs01.dbf
  /<driveA>/app/oracle/ordata/200M
- temp01.dbf
  /<driveB>/app/oracle/ordata/50M
- users01.dbf
  /<install_drive>/app/oracle/ordata/15M
- tools01.dbf
  /<install_drive>/app/oracle/ordata/15M

The installer will show the values you have entered. Review them and accept the values if they have been entered correctly.

If asked, allow the installer to move the init<SID#>.ora file created during the product install to backup copies.

11. Exit the installer after the installation is complete.

12. Login as root, run the root.sh script in $ORACLE_HOME/orainst. The root.sh script will prompt for a value for the local bin directory. Set the local bin directory to /usr/local/bin. Ignore the following two warning messages.

   ORACLE_HOME does not match the home directory for $ORACLE_OWNER. Please raise the ORACLE owner’s ulimit as per the IUG.
13. Login in as oracle and edit the oratab in /var/opt/oracle and change the third field from no (N) to yes (Y) so that the database is brought up when the server is rebooted. Also make sure that the path is preceded by ORACLE_SID parameter followed by a colon as shown below (the example is for a database instance with ORACLE_SID = f6):

f6: /<install_drive>/app/oracle/product/7.3.4:Y

14. Verify the database is mounted.

% svrmgr1
SVRMGR>connect internal
Connected.
SVRMGR>exit

If the response to the connect internal command indicates you are connected to an idle instance, then the database is not running and should be started with the following command before exiting the Server Manager.

SVRMGR>startup

15. Edit the SQL*Net parameter files, listener.ora and tnsnames.ora, in the /var/opt/oracle directory.

In the listener.ora file, change GLOBAL_DBNAME, SID_NAME, ORACLE_HOME, and the two Key lines to the appropriate values you selected in Step 16 of Section 2.3.3.1, Creating the UNIX Environment for Oracle. Host should be changed to the server name at your EOC. The Port should be set to 1521.

The tnsnames.ora file needs to be edited with the correct database names, listeners, and IP addresses. For each listener on each server, this file should contain a section like the following. These will be used as the “Server” in the odbc.ini file. (The parts in Italics may need to be changed for your site):

```
<server name> =
(DESCRIPTION =
 (ADDRESS_LIST =
  (ADDRESS =
   (COMMUNITY = tcp.world)
   (PROTOCOL = TCP)
   (HOST = <server name>)
   (PORT = 1521)
  )
 (ADDRESS_LIST =
  (ADDRESS =
   (COMMUNITY = tcp.world)
   (PROTOCOL = TCP)
   (HOST = <server name>)
   (PORT = 1526)
  )
)
```
16. Verify that the listener is up.

```bash
% lsnrctl
LSNRCTL>status
```

If the response to the status command lists a summary of approximately 15 parameters, and one of these is uptime, then the listener is running. Exit by typing:

```bash
lsnrctl>exit
```

If the listener is not working, then start it by typing:

```bash
lsnrctl>start
```

17. Move the initfi<sid>.ora file.

```bash
%> cd /<install_drive>/app/oracle/admin/fi<sid>/file
%> mv initfi<sid>.ora initfi<sid>.old
```

18. Copy a template of the initfi<sid>.ora from the $HOME/admin directory. For most servers, copy the initfix_large.ora file. If your server has limited RAM, use the initfix_small.ora file.

```bash
$> cp /<install_drive>/app/oracle/admin/initfix_large.ora initfi<sid>.ora
```

19. Edit the initfi<sid>.ora file and the config<sid>.ora file, if required, in order to:

- Update the path for the ifile.
- Update the path for the log_archive_dest parameter (it should match $ORACLE_LOGS).
- Change the default SID from fi6 to the necessary value in the config<sid> file.

20. The dbstart and dbshut delivered with Oracle v7.3.4 do not run and should be replaced with corrected versions provided by PNNL.

```bash
%> cd $ORACLE_HOME/bin
%> mv dbstart dbstart. old
%> mv dbshut dbshut. old
%> cp -p /<install_drive>/app/oracle/admin/dbstart .
%> cp -p /<install_drive>/app/oracle/admin/dbshut .
```
21. Shutdown the database and restart it using svrmgr to institute the above changes.

```
% svrmgr
SVRMGR>connect internal
SVRMGR>shutdown immediate
SVRMGR>startup
SVRMGR>exit
```

22. Set optimal rollback segment size to 1600KB using svrmgrm, the graphical database administration tool.

```
%svrmgrm
```

- Log in as system using the password defined in Step 7
- Select the storage icon
- Select the rollback tab
- Highlight the first non-system rollback segment
- Select alter from rollback menu
- Select the storage tab
- Set optimal size to 1600KB
- Click alter
- Repeat for all non-system rollback segments
- Select quit from file menu to exit.

23. Run pupbld.sql as system. On an initial install, you should expect to see warning messages that certain tables do not exist.

```
$> cd $ORACLE_HOME/sqlplus/admin
$> sqlplus system/dba
SQL> @pupbld.sql
SQL> exit
```

24. Set up the automatic Oracle startup/shutdown process.

**Note:** If the links are identical, they were established in a previous installation. If the links do not exist, create them. If the links are different, drop them and recreate them.

```
% su - root
# cp /<install_drive>/app/oracle/admin/oracle.init.d
    /etc/init.d/oracle
# ln /etc/init.d/oracle /etc/rc0.d/K25oracle
# ln /etc/init.d/oracle /etc/rc3.d/S98oracle
```
Switch user to femis and copy the oracle environment parameter file to the femis home directory.

% su - femis
% cd -oracle
% cp .oracieerc /home/femis/oracieerc

25. Switch user to oracle, and put the database in archive mode.

% su - oracle
% svrmgr
  SVRMGR> connect internal
  SVRMGR> shutdown immediate
  SVRMGR> startup mount;
  SVRMGR> alter database archivelog;
  SVRMGR> archive log list;
  SVRMGR> shutdown immediate
  SVRMGR> startup
  SVRMGR> exit

2.3.3.3 Installing and Using Oracle Documentation

To install the online documentation, use the following procedure logged in as oracle:

1. Login in as oracle and start the Installer.
   
   $ cd $ORACLE_HOME/orainst
   $ ./orainst /m

2. Deselect the default, and select the Custom installation.

3. Choose the Install, Upgrade, De-Install software option at the Installation Activity Choice window.

4. Choose the Install Documentation Only option at the Installation Options window. Click OK on the Oracle Location window. Click OK on the Logging and Status window to accept the locations for the log files. Click OK on the oracle-doc window.

5. Modify the path at the documentation CD window to be as follows;

   /cdrom/734oradoc/DOC

   Insert the product documentation CD and click OK.

6. Highlight all documents on the left and click the Install button. The Installer notifies you when it has completed installing the documentation. Exit the Installer.
7. To read the Oracle documentation in the Oracle Product Documentation Library, invoke a browser, change to the $ORACLE_HOME/orainst directory and enter the following:

```
$ cd $ORACLE_HOME/orainst
$ ./oraview
```

**Note:** Ignore any error messages that display.

The oraview script invokes the appropriate browser for your environment. Within the browser, you can navigate to the products.html file.

### 2.3.3.4 Relinking the Oracle Software

**Note:** If you have Oracle v7.3.4 installed but were required to install, upgrade, or patch the operating system, then complete this section to relink the Oracle software.

If you just completed the steps in Section 2.3.3.2, Installing the Oracle Software, then skip this section because Oracle has already been relinked.

1. Shutdown Oracle by logging into UNIX as the oracle user and complete the following:

   ```
   % svrmgrl
   SVRMGR>connect internal
   SVRMGR>shutdown immediate
   SVRMGR>exit
   ```

2. Relink the Oracle software.

   ```
   % cd ORACLE_HOME/rdbms/lib
   % make -f ins-rdbms.mk install
   ```

   This process may take several minutes to complete.

3. Restart Oracle.

   ```
   % svrmgrl
   SVRMGR>connect internal
   SVRMGR>startup
   SVRMGR>exit
   ```
2.3.3.5 Configuring Existing Oracle for Latest Version of FEMIS

Note: If you already had Oracle v7.3.4 installed and are upgrading FEMIS, then you must complete this section.

If you have just installed Oracle per the steps in Section 2.3.3, Installing Oracle or Relinking Oracle, then skip this section.

1. Copy the template files to the admin directory.

   % cp -r /home/femis/install/oracle_template/* /<install_drive>/app/oracle/admin
   % chown -R oracle /<install_drive>/app/oracle/admin
   % chgrp -R dba /<install_drive>/app/oracle/admin
   % chmod -R 755 /<install_drive>/app/oracle/admin

2. Copy the new Oracle UNIX setup files to the installation directory.

   Note: If you previously had FEMIS installed, you should compare your existing configuration files with the new ones. If your existing files have been customized, then do not overwrite them but complete Step 3 to make sure the values are still correct for this server.

   % cd /<install_drive>/app/oracle/admin
   % cp -p oracle.myoshre /<install_drive>/app/oracle/.mycshre
   % cp -p oracle.cshre /<install_drive>/app/oracle/.oshre
   % cp -p oracle.oraderc /<install_drive>/app/oracle/oracerc
   % cp -p oracle.login /<install_drive>/app/oracle/login

3. Make sure the following environment variables are correct. Also make sure that all directories specified by the parameters exist and have their owner, group owner, and mode set to oracle, dba, and 755 respectively. These can be set using the chown, chgrp, and chmod commands.

   ORACLE_TERM (set it to match the xterm for the given keyboard: xsun or xsun5)
   ORACLE_BASE = /<install_drive>/app/oracle
   ORACLE_HOME = /$ORACLE_BASE/product/7.3.4
   PATH includes:
      $ORACLE_HOME/bin
      /usr/local/bin
      /bin
      /usr/bin
      /usr/ccs/bin
   ORACLE_SID = fict
   ORACLE_DOC = $ORACLE_HOME/doc
   LD_LIBRARY_PATH=/usr/dt/lib:/usr/ucb/lib:/usr/openwin/lib:$ORACLE_HOME/lib:
      /usr/openwin/lib:
   ORACLE_NLS = $ORACLE_HOME/common/nls/admin/data
   TNS_ADMIN=/var/opt/oracle
4. Switch user to femis and copy the oracle environment parameter file to the femis home directory.

% su - femis
% cd ~oracle
% cp .oradrc /home/femis/.oradrc

### 2.3.3.6 Modifying the Initialization Parameter

Due to changes in FEMIS, one of the Oracle initialization parameters may need updating. To determine if changes are necessary, log into UNIX as the oracle user and check the following:

% su - oracle
% cd admin/$ORACLE_SID>/pfile
% vi init<$ORACLE_SID>.ora

Look for an entry in this file, e.g., initf2.ora, like open_cursors = 300. If this line is not present, add it; or if the line exists but the number is less than 300, change the value to 300. If changes are made, the database must be shutdown and restarted (using the following commands) to make the change active.

% svrmgrl
SVRMGR> connect internal
SVRMGR> shutdown immediate Wait until the database is down, then:
SVRMGR> startup
SVRMGR> exit

### 2.3.4 Defining the Database Topology

**Note:** This section must be completed regardless if this is a new or upgrade installation of FEMIS.

Six configuration files are used to define a topology:

/home/femis/etc/eoclist.dat  EOC List  general topology
/home/femis/etc/grplist.dat  Group List  snapshot groups
/home/femis/etc/seqlist.dat  Sequence List  sequence ids
/home/femis/etc/tablist.dat  Table List  Table privileges
/home/femis/etc/vuclist.dat  View List  Views
/home/femis/etc/eocnum.dat  EOC Numbers  for this site
The primary configuration file is the EOC List file, `/etc/eoclist.dat`, which is used by many of the FEMIS shell scripts. The other configuration files are used only by the Make Configuration (`makecfg.sh`) code generator.

The EOC List file consists of one record for each EOC database. Each record consists of eight space-separated columns. Except for the Yes/No flag in column five, nothing should be uppercase.

1: EOC name  
2: Password  
3: Server  
4: Listener  
5: Onpost  
6: EOC #  
7: Port  
8: Other EOCs  
9: Remote EOCs

name of the EOC and Oracle user account  
initial password for the Oracle user account  
server where the data is located  
Oracle listener name for the account  
Y=onpost database, N=offpost database  
EOC number used for sequence IDs  
FEMIS notification port  
Comma-separated list of other EOCs on this server, w/o white space. If none, then 0 is used.  
Comma-separated list of remote EOCs, w/o white space. If none, then 0 is used.

The Group List file is used to define the database replication setup. It indicates which tables go in which replication groups, plus which tables must have what kind of snapshots. It contains N major sections, the first one normally for just the one onpost EOC (e.g., `tead`), and the remaining ones for the offpost EOCs (e.g., `ctoo` and `utst`). The onpost section is different from the offpost sections, which are alike except for the EOC name in the first column.

The Sequence List file is used to define the Oracle sequence IDs in the database, which are used to generate unique keys when inserting records into the database.

The `tablist.dat` file controls table privileges for database users. It has one row for each table in the database. It is possible to modify this file at the time of this installation but extreme care must be taken. See Section 4.5, Security Provisions, in the *FEMIS Data Management Guide* for a description of the format of this file.

The View List file is used to define which views are created on which tables. The views combine data from other EOCs into a site-wide version of shared tables. For example, the `S_FACILITY` view is a combination of the Facility tables in each of the EOC databases.

The `eocnum.dat` file is the basic file that determines the names of the EOCs at a site and assigns an EOC number to each. This file is used by the Build Topology Program, `bdtopo.sh` and is placed into the `/home/femis/etc` directory as part of the installation of the FEMIS package (Section 2.2, Installing the FEMIS UNIX Software).

### 2.3.4.1 Running the Build Topology Program

To define a topology, you must create the configuration files and put them in a standard location using the Build Topology program.
1. Login as femis.

2. Copy the eocnum.dat from /home/femis/database/exports/<site> to the /home/femis/etc directory, if you did not install a database package.

   % cp /home/femis/database/exports/<site>/eocnum.dat /home/femis/etc

3. Create the configuration files, and place the files in a standard location.

   % cd ~femis/etc
   % ~femis/database/dba/bldtopo.sh

The Build Topology program prompts you for information to define the general topology—the EOC List file. If at any point you do not specify something, the program will exit.

   How many servers?  ==> 

Enter the number of servers in the topology. For example, for a 3x1, enter 1; for a 6x6, enter 6; or for a 8x4 enter 4.

The build topology program reads the eocnum.dat file and displays the information back to the window.

   Enter server name for <eoc_name>  ==> 

Each time you get this prompt, you must enter the name of the Sun server where the FEMIS database for the EOC that is listed will reside. For example, for the TEAD database, enter teadsun.

   Enter listener for <eoc_name>  ==> 

Enter the Oracle listener name for that server. For example, fi3.

The loop then repeats, asking for the next server and listener until you have supplied all of them. If you have specified an Nx1 topology, then the script will ask you for the server and listener name only once.

After you answer all the prompts, the Build Topology program creates the remaining topology files automatically.

2.3.4.2 Setting Up the EOC DBA Directory (as femis)

As released, FEMIS contains a ~femis/database directory that has a number of subdirectories, none of which should be changed. However, for your own use, you need a working copy of some of the files. Plus, you need to generate brand new SQL scripts that are specific to your database topology. When you have completed the following steps, you will have your own ~femis/database/eocdba directory with all the scripts you will need to manage your FEMIS database.
1. Login as femis.

2. Create a working directory, eocdba, for your own use.

   % cd ~femis/database/dba
   % mkeocdba.sh

3. Generate the scripts used to load the stored procedures.

   % cd ~femis/database/eocdba
   % makeproc.sh

This shell script creates the driver scripts to create (master_cr_procedures.sql) and drop (master_dr_procedures.sql) the stored procedures in all the FEMIS EOC database schemas. The shell script also creates all the actual server-specific files, cr_procedures_SERVER.sql and dr_procedures_SERVER.sql.

4. Generate the scripts used to manage and control the database.

   % cd ~femis/database/eocdba
   % makecfg.sh

This shell script creates a very large number of SQL scripts.

It is essential that all FEMIS servers use the same database topology. Therefore, it is recommended that topology modifications be performed on one server. Copy the eocdba and etc directories to other servers. In an NxN configuration, the results are copied to all N servers.

2.3.5 Creating or Updating the FEMIS Database

2.3.5.1 Creating the Database Schemas

The following steps in this section (Section 2.3.5.1) must be done on each server in the site configuration. Verify that the files in both the /home/femis/etc and /home/femis/database/eocdba directories were copied to all servers (See Section 2.3.4.1, Running the Build Topology Program). Complete the following steps to create the database schemas.

1. Login as femis.

2. Change to the ~femis/database/eocdba directory.

   % cd ~femis/database/eocdba

3. Skip this step if you are updating the database; the tablespaces already exist.
To place the files in the desired directory(s), edit the cr_db_ts_<server name>.sql file. If possible, place the fmain and findex tablespaces on different disk drives. Place the fsnapshot and fsnaplog tablespaces on different disk drives as well. For example:

fmain.dbf  /<driveA>/app/oracle/oradata/fi<x>  200M
findex.dbf  /<driveB>/app/oracle/oradata/fi<x>  200M
fsnapshot.dbf  /<driveA>/app/oracle/oradata/fi<x>  300M
fsnaplog.dbf  /<driveB>/app/oracle/oradata/fi<x>  100M

4. Run the Master Create Database script for either a new installation or an update. This script creates the new tablespaces and schemas. If you are performing an update, then you will receive error messages stating that the tablespaces and some of the data schemas already exist. Disregard these messages during the update.

Note: In FEMIS v1.4.6, the sys user is required to run the master_cr_db script. In previous versions the system user was required to run this script.

% sqlplus sys/<PASSWORD>
SQL> @master_cr_db_<server name>.sql

2.3.5.2 Loading Data (as femis)

Note: Depending on what installation steps you have previously completed, you will either update the data in your database, or import data from one of two places and perform the update. Please review this section carefully.

If you had Oracle v7.3.4 installed and did not reinstall Oracle, then skip the following import process because the EOC data is still in the database.

If you installed Oracle v7.3.4 and had a previous version of FEMIS installed, then you will want to import the data that was exported in Step 2 of Section 2.3.2.1, Dropping Database Objects and Exporting Data Owners.

If you did not have a previous version of FEMIS and have installed the GIS and database package (Section 2.3.1, Installing the GIS and Oracle Database), then you will want to import the data found in the /home/femis/database_exports/<site> directory.

Note: Remember that you need to know where each of the N data owners are for your NxN or NxM database configuration. You will import the data for each data owner exactly one time across all the servers at your site. If you have an NxN configuration, you will perform one import on each server; but for an NxM configuration, some servers will have more than one data owner. You will not import any data into any of the snapshot owners.

1. Login as femis.
2. Complete the Oracle import function.

   % cd /home/femis/database/exports/<site name>
   % imp <USER1>/<PASSWORD> file=<EOC_name>_<EOC_date>.dmp log=<USER1_today's date>.log
   % imp <USER2>/<PASSWORD> file=<EOC_name>_<EOC_date>.dmp log=<USER2_today's date>.log
   ...and so on

The actual name of the .dmp files will be specific for your site and may contain a date stamp, e.g., anad_19961210.dmp.

The following is an example for an 8x8 Alabama configuration on a server with the ANAD data owner schema and seven snapshot owner schemas.

   % imp anad/anad file=anad_19961210.dmp log=anad_<today's date>.log

2.3.5.3 Upgrading Database from Previous Versions of FEMIS

STOP

Before continuing, make sure that the imports for all EOCs have been completed.

Note: Perform the following upgrade only if you currently have FEMIS version 1.4.5 installed. When these upgrade scripts are executed the database structure will be modified for all EOCs at your site. Therefore this upgrade process only needs to be performed once at one EOC.

1. Run the update structure/data scripts to update all the owner schemas and create the scripts for the upgrade from FEMIS v1.4.5 to v1.4.6. All databases must be up and available during this operation.

   % su - femis
   % cd /home/femis/database/udp/V1.4.5/V1.4.6
   % makerun.sh

2. Run the master_run.sql script if the makerun.sh script executes successfully. The update scripts will now be run one at a time. There are pause statements scattered liberally throughout the scripts. Watch closely for errors as each script is run. Ignore the error message, "Table or view does not exist".

Note: It is possible that the master_run.sql file needs to be edited. Before using it, please review and change it as appropriate for your site.

   % sqlplus /nologin
   SQL> @master_run
2.3.5.4 Creating Objects that Share Data (as femis)

STOP

Before continuing, make sure all servers are online, and the databases for all EOCs are configured for FEMIS v1.4.6.

At this point, you should have schemas on all servers and have loaded the data. You are now ready to create views, snapshots, synonyms, and other replication-support items.

Note: This create process needs to be performed once, but it must be done on the server that hosts the onpost EOC.

The Master Create SQL script (master_cr.sql) runs scripts that create the following:

- sequence numbers (All)
- alternate views (All)
- snapshot logs (NxN, NxM)
- snapshots (NxN, NxM)
- snapshot groups (NxN, NxM)
- synonyms for onpost tables (All)
- site views (All)
- replication tables and code (NxN, NxM)

To run the Master Create SQL script, which can take hours to complete on a multi-server configuration, complete the following:

1. Login as femis.

   % cd -femis/database/eocdb
   % sqlplus /nologin @master_cr.sql

   You need to watch its progress and occasionally press Enter when prompted. If errors occur, use Ctrl-C to stop the script so you can determine what caused the errors.

2.3.5.5 Upgrading Shared Data from Previous Versions of FEMIS

Note: Perform the following upgrade only if you currently have FEMIS version 1.4.5 installed. When these upgrade scripts are executed the database structure will be modified for all EOCs at your site. Therefore this upgrade process only needs to be performed once at one EOC.

1. Run the following update scripts. There are pause statements liberally scattered throughout the scripts. Watch closely for errors as each script is run. Press Enter to continue.
% su - femis
% cd /home/femis/database/upd/V1.4.5_V1.4.6
% sqlplus /nologin
SQL> @master_run_sview

2.3.5.6 Fixing the EOC Table (as femis)

Run the following script once for all EOCs. It will change the Notify port, the UNIX port, the Server
name, and EOC number to match the EOC List file. This process needs to be performed once at one EOC
to change the EOC data for all EOCs.

1. Login as femis.
   % cd ~/femis/database/eocdba
   % fixeoc.sh -fix

2.3.5.7 Setting Up the Oracle Crontab

   Note: The following needs to be performed once on all servers.

To set up the crontab to perform automatic database backups and exports, enter the following commands:

1. Switch to the oracle user.
   su - oracle
   $> cd ~/oracle/admin
   $> crontab oracle.crontab

2. Perform a full backup to another directory by entering the following commands:

   % cd /<install_drive>/app/oracle/admin
   % dbbackup_cold

For more information on the Oracle backups, see Section 14.0, Backup Strategy for FEMIS, in the
FEMIS System Administration Guide.

2.3.5.8 Starting Replication (as femis)

   Note: The following only needs to be performed once at one EOC.

If you have an Nx1 database configuration (3x1 or 8x1), then skip this step.

Because neither an NxN nor an NxM configuration store data for all EOCs on each server, the data must
be replicated by Oracle to make all of the data accessible to all servers.
Note: Do not start replication until all the FEMIS databases have been installed and configured on all servers at the site.

To start replication, run the Master Start Replication script.

1. Login as femis

   % cd ~/femis/database/eocdb
   % sqlplus /nologin
   SQL> @master_rep_start.sql

2.3.6 Configuring the FEMIS Files (as root)

Note: The following needs to be performed once on all servers.

This section explains how to configure the FEMIS files to accommodate the database topology by running the FEMIS configuration script. Before you run this script, you will need to determine some site-specific values.

Determine the Oracle settings

- **ORACLE_SID** (Example: ti4)
- **ORACLE_BASE** (Example: /files1/app/oracle)
- **ORACLE_HOME** (Example: /files1/app/oracle/product/7.3.4)
- **TNS_ADMIN** (Recommended: /var/opt/oracle)

If GroupWise is installed, find the

- domain directory (Example: /apps/groupwise)
- post office directory (Example: /apps/groupwise/po)

If DEI was installed, decide upon the following items

- **FEMX Home Directory** (Default: /home/femx)
- **EMIS Host Computer** (Example: teadsun)
- **EMIS User-Name** (Default: femx)
- **EMIS Password** (Example: femxfer)

The FEMIS configuration script uses the /home/femis/etc/eoclist.dat, system settings, the /home/femis/install/femis_info file, and Oracle database settings to create the FEMIS configuration files, which will be placed in the /home/femis/etc and /home/femis/conf/s directories.

Note: Before configuring FEMIS files, you must know the EOC name, the EMIS transfer account password, and your UNIX server netmask.
To configure the FEMIS files:

1. Login as root.

2. Change the directory to the FEMIS install directory, usually /home/femis/install.

3. Edit the femis_info file so the values match the system setup.
   
   If your site is using GroupWise, the GW_PATH should be set to the GroupWise Domain directory. 
   Set the GW_PO_PATH to the GroupWise Post Office directory.

   The Oracle environment variables should be set to match the values given in the ~oracle/.oracerc file.

   The FEMIS DEI variables only need to be set if the server will be running DEI
   EMIS_HOST should be set to the server name and the EMIS_USER should be set to emisx.

4. Change the directory to /home/femis/install/femis_template/etc.

5. Edit the femisdie.cfg file. Remove or comment out (by placing a "#" character at the beginning of the 
line) the line that starts with ORACLE_USER.

6. Change the directory back to /home/femis/install.

   Note: You must include the explicit file path for the Oracle directories listed in this file.
   Automount points will not work in this context.

7. Execute the ./configure_files.sh script. If you do not have GroupWise on your system, enter 
   # ./configure_files.sh G. Follow the install prompts for EOC name(s), EMIS transfer account 
   password and UNIX server netmask.

2.3.7 Configuring the FEMIS PC Files (as femis)

The following configurations are required to setup the default values used in the FEMIS PC installation. 
The files edited in this section are copied to the PCs during the installation of the FEMIS application.

2.3.7.1 Editing the /home/femis/configd/fsetup.ini File

Edit the /home/femis/configd/fsetup.ini file so that the defaults used by the Setup program will be correct 
during the FEMIS installations. The changes you must make to the /home/femis/configd/fsetup.ini file 
are described below.

The first section of the INI file, the [Setup Defaults] section contains entries that set defaults for the Setup 
program. Starred items (*) are those that you should edit.
Site*  Default site code. This should be changed to be your site code (Uppercase.)

EOC*  Default EOC code. This should be changed to be your EOC code (Uppercase.)

DestDir  Default installation destination directory. This is currently not being used. The installation destination is hard coded to C:\FEMIS.

Version  Gives the version of FEMIS for which this instance of FSETUP.INI was created.

mDriveNetPath*  Path to the FEMIS m:\ drive that the FEMIS startup script will connect. This does not need to be set if you use an alternate method to map the m:\ drive. Be sure to check the drive path for femis/femis. Only one femis entry is correct for this path.

lDriveNetPath  Network path for the GroupWise l:\ drive that the FEMIS startup script will connect. This is only necessary if you use GroupWise for your E-mail.

LocalStartupScript  Full path for a local startup script to be run by the FEMIS startup script. This is optional.

EMIS_StartupScript  Full path to the EMIS startup script file. The FEMIS startup script file will run this file.

DateThisFSETUPCreated  Gives the build date for this version of FEMIS.

The second section of the INI file, the [Sites] section, is used to fill the Site drop-down list in the Select Site and EOC window in the PC Setup program. You can edit this list to limit the possible selections available in Setup. Each site entry must be formatted as SiteNN=<SITECODE> where NN is a two digit integer and <SITECODE> all uppercase. If you shorten the list of sites to a single entry, the user will be forced to accept that entry when running Setup. If you edit the list, the NumSites entry must match the number of sites in the list, and the numbering for the sites must be sequential, starting at 01.

Subsequent sections are lists of EOCs for each site in the [Sites] section. Each site listed in the [Sites] section must have a corresponding [SITECODE] EOCs section. These sections are used to fill the EOC drop-down list in the Select Site and EOC window in the PC Setup program when the corresponding site is selected on the same window. The EOC list sections can be edited in the same manner as the Site list. Each EOC entry must be formatted as EocNN=<EOCCODE> where NN is a two digit integer and <EOCCODE> is all uppercase. If you shorten the list of EOCs to a single entry, the user will be forced to accept that entry when running Setup. If you edit the list, the NumEOCs entry must match the number of EOCs in the list, and the numbering for the sites must be sequential, starting at 01. EOC list sections that do not have a corresponding site listed in the [Sites] section will be ignored.
2.3.7.2 Updating Windows NT User Accounts

Because the Oracle connect information is stored on an NT-user by NT-user basis, several batch files are used to patch each Windows NT user account. Any new Windows NT user accounts must be verified to ensure that they have the correct values.

To set this up, you must copy the following files from /home/femis/configd to /home/femis/user.

- fupdate.tpl
- fup_odbc.tpl
- addodbc.bat

Also, you must copy the following files from /home/femis/pdfemmisc to /home/femis/user.

- odbcsub.bat
- pfemis.bat
- writereg.exe
- writeini.exe

Then rename fup_odbc.tpl to fup_odbc.bat and fupdate.tpl to fupdate.bat. Examine fupdate.bat, which calls fup_odbc.bat. When logging in, all FEMIS PCs will execute the fupdate.bat batch file. FUPDATE.BAT can be used to update any file(s) on all FEMIS PCs (such as the HOST file). View FUPDATE.BAT for specific instructions.

2.3.7.3 Correcting Group Ownership

Verify the group ownership is correct on the /home/femis, /home/femis/user, and /home/femis/pc/femtools and that they are in the femisrun group. If it is not correct, enter the following commands at the UNIX prompt.

```
# chgrp femisrun /home/femis /home/femis/user /home/femis/pc/femtools
```

2.3.8 Verifying the Configuration Files (as femis)

Having run the FEMIS configuration script (Section 2.3.6, Configuring the FEMIS Files), you must now verify whether the configuration files it created are correct.

1. Login as femis.

2. Check that the femis account is setup correctly.
The ORACLE_SID and ORACLE_HOME environment variables must be set. The values for these are site/server dependent. The ORACLE_SID should be set to the string "fi" followed by a server-specific number. The ORACLE_HOME environment variable will point to the home directory of your Oracle installation.

The PATH environment variable includes the following:

```
/home/femis/bin:/usr/bin:/$ORACLE_HOME/bin
```

3. Check that the FEMIS UNIX configuration files, such as cmdserv.conf, femis_event.conf, and femisd.conf are setup correctly.

If this is an onpost installation, you should also have the following files.

```
/home/femis/etc/femisdei.cfg
/home/femis/etc/femisdei.prf
```

4. Enter the following onpost only if you do not wish to send offpost acknowledgements back to EMIS at your site.

```
su - oracle
sqlplus <onpost DB name>/<onpost DB password>
   SQL> update EOC set DEI_USED='N';
   SQL> exit
```

5. Validate the `/home/femis/configd/hosts` file: The HOSTS file should be configured with the correct host names and IP addresses. This file should be a copy of `/etc/hosts` on the UNIX system.

6. Validate the `/home/femis/configd/addodbc.bat` file: FEMIS uses the `home/femis/configd/addodbc.bat` batch file to add all the necessary ODBC (Open Data Base Connectivity) values. Verify that the mapping from EOC code to listener ID is correct in each line. Copy good version of addodbc.bat to `/home/femis/user`.

   See Section 4.2.8, Validating I:\User Directory, for instructions on copying this file so that all the Windows NT user accounts are setup with the correct ODBC values.

7. Validate the `/home/femis/pc/ntnp/ntp.conf` file: The ntp.conf file should be configured with the correct IP address for the time server.
8. Check the system files to verify the FEMIS entries were added.

     /etc/services
     /etc/inetd.conf

     In the /etc/services file, you should see a service named femis setup for port 1776. In the
     /etc/inetd.conf file, you should see a femis entry pointing at the full file path of the femisd executable.

9. Check the FEMIS startup/shutdown script.

     /etc/init.d/femis

10. Check the FEMIS dot files.

      /home/femis/.femisrc
      /home/femis/.oraderc

2.3.9 Setting Up the Command Server Configuration File

The access block in the command server configuration file needs to be set up. This set up is not done
automatically during installation and needs to be set up manually. If this step is not performed and
completed correctly, FEMIS Evacuation and any other program needing the command server will
terminate with an Access Denied error.

During FEMIS UNIX installation, the command server configuration file cmdserv.conf is copied to
/home/femis/etc. Verify that this file exists.

In the cmdserv.conf file, locate the access block. This block begins with [ACCESS] and ends with [END].
The required directives within the access block are deny and allow. Each directive can contain an IP
address and an IP subnet mask. These arguments define the range of IP addresses that are to be allowed
or denied access to the command server. Also refer to Section 4.0, FEMIS Command Server, in the
FEMIS System Administration Guide for details on command server syntax.
The correct set up is to deny access by clients on all IP addresses except the ones that specifically are to
be allowed. To accomplish this, the first directive should be deny 0.0.0.0, and the remaining directives
should be combinations of allow and deny to establish the allowed IP address ranges.

The installer needs to obtain the IP address and subnet mask of the LAN on which the UNIX server was
installed, along with the same information for all other LANs on the Wide Area Network (WAN).
As an example, the following block is valid for the Oregon/Washington network:

```plaintext
[ACCESS]
Deny 0.0.0.0 # deny all except
Allow 198.176.0.0 255.255.248.0 # oregon
Allow 199.233.108.0 255.255.255.0 # benton county
Allow 199.47.32.0 255.255.255.0 # washington
Allow 131.92.39.0 255.255.255.0 # umcd
[END]
```

The above example access block is used on all six Oregon/Washington WAN servers.

To allow additional ranges of IP address to access the command server, simply add the appropriate allow directives in the access block.

Do not copy this file from host-to-host, as the file contains host/site dependent fields, such as host name, site name, Oracle instance name, and full Oracle path. Instead, edit each cmdserv.conf file on each host one at a time.

### 2.3.10 Setting Up femis_event

**Note:** If all of the UNIX hosts in your WAN have one and only one IP address, then this section can be disregarded. However, if any of the UNIX hosts have dual ethernet interfaces (i.e., they perform router functions, or have multiple IP addresses), then pay special attention to the following workaround.

Interconnections between notification servers are accomplished by including the service port and UNIX host name on the startup command line, e.g., `A> femis_event -c 9020@B 9020@C` where A, B, and C are names of UNIX hosts. For this example of setting up femis_event, assume that host B has multiple IP addresses, and that all such addresses are included in the `/etc/hosts` files on A and other nodes on the network.

First determine which IP addresses for B, and all multiple IP address hosts in the network, is the primary IP address for host B. Log into B’s femis account, and run femis_event with only the -i option. You should get a response such as the following:

```
B% femis_event -i
Last build .......... Thu Oct 17 11:54:08 PST 1996
Host name is ...... B
IP address is .... 111.111.111.111
Port number is ... 9020
```
Next, on all nodes where notification servers are to be executed, ensure there is a unique name in the /etc/hosts which resolves to the IP address reported above. For example:

A% grep B /etc/hosts
111.111.111.111 B
111.111.222.222 B

Be sure to substitute the actual host names for A, B, and C. Edit and modify the host’s file, adding a host, e.g., BB, name which resolves to a unique IP address. For example:

A% grep BB /etc/hosts
111.111.111.111 BB

From this step forward, you should always refer to the server with multiple IP addresses by the unique name associated with the IP address found in the femis_event-i command. In this example, BB is the IP address name.

Note: Failing to implement the above workaround for UNIX hosts having multiple IP addresses can have disastrous results. Under some conditions, a femis_event process can terminate with a bus error after running out of file descriptors if this workaround is not implemented as described.

2.4 Checking the FEMIS Startup

To check the FEMIS startup, you will need to reboot the server and verify the FEMIS programs are running.

2.4.1 Rebooting the Server (as root)

To activate some of the system-level changes that the FEMIS UNIX Installation script makes, complete the following steps to reboot the server.

1. Login as femis, and stop master replication.
   
   % cd /home/femis/database/eocdb
   % sqlplus /nologin @master_rep_stop.sql

2. Login as root.

3. Enter the following on a Solaris machine:
   
   # /etc/init 6

   As the server reboots, note the status messages during the startup of the FEMIS processes.
4. Login as femis, and start replication.

    %cd /home/femis/database/eocdba
    %sqlplus /nologin @master_rep_start.sql

2.4.2 Verifying the FEMIS Programs (as femis)

After the server has rebooted, verify that the FEMIS programs are running.

    Login as femis.

For an NxN configuration, there should be one FEMIS Notification Server process running. For an Nx1 configuration, there should be N of them running. For an NxM, there should be one FEMIS Notification Server process for each EOC per server in the configuration.

    % ps -ef | grep femis_event

If it is not running, restart it with logging turned on.

    % startnotify -log

Then use the Show Notify utility.

    % shownotify aux

Refer to Section 3.0, FEMIS Notification Service, in the FEMIS System Administration Guide for more information.

If DEI should be running, check it also.

    % ps -ef | grep femisdei

If it is not running, check the log file /home/femis/log/femisdei.log, to see what happened. The most common problem occurs when DEI cannot connect to Oracle. Check the configuration file, /home/femis/etc/femisdei.cfg, and restart DEI by typing femisdei. Refer to Section 7.0, FEMIS Data Exchange Interface (DEI), in the FEMIS System Administration Guide for more information.

If the onpost EOC is on your server, start DAI (Data Acknowledgment Interface) by typing:

        startdai.sh

2.5 Utility to Add FEMIS Login Account to the Database

The adduser utility enables you to add a FEMIS login account for a FEMIS user to the database. To use the utility, follow the procedure in the example, substituting the new login account name for wayne.
To create a FEMIS login account for wayne, complete the following steps:

1. Login as femis.

2. Run the following script with the appropriate command line parameters.
   
   To add a login account for a specific EOC, run
   
   ```
   % adduser.sh -user wayne -eoc <eocname> -run
   where <eocname> must be in lower case.
   ```
   
   or
   
   To add a login account on all EOCs in the configuration, run
   
   ```
   % adduser.sh -user wayne -all -run
   ```
   
   This script will create and run an SQL script to add the user to the database and give the new user all privileges. It takes a long time to run.

   The script does the following:

1. Adds a mostly empty record for the user to the PERSON table.

2. Adds a record to the FEMIS_USER table.

3. Adds many records (>200) to the USER_MODE_PRIV table.

   You should then be able to login to FEMIS on the PC as the new user (wayne) with the password femis.

### 2.6 FEMIS AutoRecovery System Description and Installation

**Note:** See Section 2.6.6, Installing AutoRecovery for installation instructions.

The FEMIS AutoRecovery system is used to monitor the FEMIS.

The following files are used by the FEMIS AutoRecovery system:

```
/opt/local/bin/femis_watch
/opt/local/bin/femis_watch.conf
/opt/local/bin/logit
/var/log/femislog
```
The two files, femis_watch and femis_watch.conf, are Perl scripts that comprise the heart of the FEMIS AutoRecovery system.

The FEMIS AutoRecovery system is run by cron. The run schedule is set in the root crontab. The default schedule is

- Mon thru Fri: 7:00a to 6:00p - run AutoRecovery every ten minutes
- 6:00p to 7:00a - run AutoRecovery every half hour
- Sat & Sun - run AutoRecovery hourly

To change the run schedule, edit the root crontab. See the UNIX man page on crontab before proceeding.

% su -
# crontab -e

### 2.6.1 Messaging Service

The AutoRecovery system uses three messaging services: logging, E-mail, and FEMIS Notification Service. By default the three messaging services are enabled.

To disable any of the messaging services, comment out the appropriate line:

```
/opt/local/bin/femis_watch.conf
```

To disable syslog messages, comment out the following line:

```
$syslog_it = 1; in /opt/local/bin/femis_watch.conf
```

To disable E-mail messages, comment out the following line:

```
$mail_it = 1; in /opt/local/bin/femis_watch.conf
```

To disable notification through the FEMIS Notification Service, comment out the following line:

```
$notify_it = 1; in /opt/local/bin/femis_watch.conf
```

### 2.6.2 Logging

AutoRecovery logging is performed through syslog and can be configured with the following levels:

- warn: log only warning messages
- notice: log warning messages and restart messages
- info: log all reported messages

The default log level is info.

2-54
To log both warning and restart messages, complete the following steps:

1. Edit /etc/syslog.conf and change to:

   local7.info to local7.notice

   Log archiving is performed by the script /opt/local/bin/logit. This script is run nightly from the root crontab. The default number of logs archived is 7 days. The number of days archived can be configured by changing the value for NUM_OF_DAYS_TO_ARCHIVE in the /opt/local/bin/logit script.

   The log file is set in /etc/syslog.conf. The default log file is /var/log/femislog. The log file can be changed by editing /etc/syslog.conf and /opt/local/bin/logit.

2. Restart syslogd.

   % su -
   # sh /etc/init.d/syslog stop
   # sh /etc/init.d/syslog start

2.6.3 Sending E-mail

AutoRecovery sends all warning messages via E-mail to the root user by default. This configuration can be changed or added to by editing the file /opt/local/bin/femis_watch.conf and changing or adding E-mail addresses to the $Custodian line. A single space separates each E-mail address. See the example below for clarification:

   $Custodian = 'root femis admin@smtp.foo.com';

E-mail can be sent to any valid SMTP recipient. For instance, addresses can be to real users, local and remote server aliases, other mail gateways, and to files and/or programs for filtering. For syntax, and mail configurations to support expanded E-mail capability, consult your site's mail server documentation.

2.6.4 Running Processes

AutoRecovery verifies certain processes are running. The processes are defined in

   /opt/local/bin/femis_watch.conf. The format is as follows: daemon name, minimum number of processes, maximum number of processes, status flag, restartable flag, and restart command.

The following line is the default configuration for receiving notification of less than 5 or more than 10 Oracle snapshot processes.

   ['ora_snp', 5, 10, 1, 0, '"'],

2-55
The following line is the default configuration for only one NFS Maestro daemon, and it will restart the daemon if the number of processes is less than one.

```bash
[ "hcinfsd",1, 1, 1, "sh /etc/init.d/hcinfs stop; sh /etc/init.d/hcinfs start" ],
```

**Note:** To effectively disable process monitoring (which we do not recommend), set min to 0, and max to a high number, such as 500.

### 2.6.5 Monitoring Swap and Disk Space

AutoRecovery monitors used disk and swap space. The thresholds are defined in `/opt/local/bin/femis_watch.conf` and can be customized for each server.

The following are two examples of configuration changes.

1. Complete the following steps to change the swap space monitoring to report 60% full instead of 80% full:
   
   **Edit** `/opt/local/bin/femis_watch.conf`

   **Change** `$swap = 80;` to `$swap = 60;`

2. Complete the following steps to change the disk space monitoring to report when `/ (root file system)` is 90% full:

   **Edit** `/opt/local/bin/femis_watch.conf`

   **Look for the** `@disks = ( ` section.

   **Edit the line by changing** `[ "r", 80 ]` to `[ "r", 90 ]`

### 2.6.6 Installing AutoRecovery

If you are upgrading FEMIS, remove the previous versions of the Perl and AutoRecovery packages using the following commands.

```
# pkgm Perl
# pkgm FEMISar
```

The FEMIS AutoRecovery system and Perl have been included with the FEMIS package. To install FEMIS AutoRecovery, you will need to create a spool directory that will require approximately 20MB of disk space.
1. Insert the FEMIS tape into the tape drive and enter the following commands as root:

```bash
# mkdir /<dir>/spool
# chmod 755 /<dir>/spool
```

2. Spool the installation package from the 8mm tape.

```bash
# pkgadd -s /<dir>/spool -d /dev/mnt/??
```

where ?? is the device number of the tape drive.

Select Perl and FEMISar from the available products.

3. Run the pkgadd utility to install the Perl and FEMISar packages.

```bash
# pkgadd -d /<dir>/spool
```

Select Perl and FEMISar and follow the prompts through the installation.

**Note:** Use <Ctri>-d to exit installation if you do not get a prompt following the message: Installation of <Perl> Successful.

4. Use pkgchk to verify that Perl and FEMISar were installed correctly.

```bash
# pkgchk -n FEMISar
# pkgchk -n Perl
```

**Note:** The packages installed successfully if no error output is displayed. Report any errors to PNNL.

5. Remove the spool directory.

```bash
# rm -r /<dir>/spool
```

### 2.6.7 Configuring AutoRecovery

To configure FEMIS AutoRecovery, complete the following steps.

1. Edit the AutoRecovery configuration file `/opt/local/bin/femis_watch.conf`. Example:

```bash
% su -
# vi /opt/local/bin/femis_watch.conf
```

Verify the restart commands are correct for all restartable processes.
Add additional $Custodians to receive E-mail when a problem is detected.

Verify the $ENV{FEMIS_HOME} variable points to the FEMIS installation directory.

Verify the $ENV{ORACLE_HOME} variable points to the Oracle installation directory.

Verify the E-mail processes are correct for your system. If you are not using GroupWise, set the first two numbers to 0.

Modify disk thresholds and default disk names; add disks as necessary.

Replace the host entries in the @network list with the other servers at you site.

2. Edit the FEMISSar lines in the root crontab.

   % su -
   # crontab -e

   Verify the Oracle path for the LD_LIBRARY_PATH environment variable.

   Uncomment the FEMISSar execution lines.

The FEMIS AutoRecovery should start running at the next scheduled FEMIS AutoRecovery (femis_watch) cron event. To verify it is running, check the log file for recent entries.

   % tail /var/log/femislog

2.7 AutoRecovery Web Reporting Application

AutoRecovery monitors the FEMIS server and reports any errors to your System Administrator, using a standard E-mail message. Your System Administrator must log into E-mail and examine the messages to determine a server problem. PNNL developed the AutoRecovery Web Reporting application to provide a more generic way for your System Administrator to examine the status of their systems.

Using the AutoRecovery Web Reporting application, E-mail can be sent to a central E-mail account. The E-mail is processed by AutoRecovery Web Reporting and displayed by a web server. Your System Administrator can view the status of your server using a browser application. AutoRecovery Web Reporting can be expanded to receive E-mail from each EOC. Using this capability allows all System Administrators to status their EOC server messages without installing a web server at each EOC.
2.7.1 Software Requirements

AutoRecovery Web Reporting requires the following applications:

- FEMIS AutoRecovery v2.1
- PERL v5.004-04
- MailTools v1.12 (a PERL extension)
- Apache Web Server v1.3.4

FEMIS AutoRecovery and PERL are packaged separately. The Apache Web Server, MailTools and the AutoRecovery Web Reporting scripts are included in the FEMISarw package.

2.7.2 Installing AutoRecovery Web Reporting

Note: This package has dependencies on the Perl 5.004. The Perl package must be installed before you can install AutoRecovery Web Reporting.

Note: This system must be in a quiet state.

To install AutoRecovery Web Reporting, which has been included with FEMIS v1.4.6, complete the following steps.

1. Login as root.
2. Insert the FEMIS application tape into the tape drive.

   To create a temporary spool directory, run the following:

   ```
   # mkdir /<dir>/spool
   # chmod 755 /<dir>/spool
   ```

   Spool the installation package from the 8mm tape using the Solaris software installation utility.

   ```
   # pkgadd -s /<dir>/spool -d /dev/mult/??
   ```

   where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd utility to install the FEMISarw package.

   ```
   # pkgadd -d /<dir>/spool
   ```

3. Select the FEMISarw application for installation.
4. The installation will ask several questions.
Select y to continue when the following prompt displays: “The following files are already installed on the system and are being used by another package:

```
op/local/lib/perl5/sun4-solaris/5.00404/perl/local.pod
```
Do you want to install these conflicting files.”

Select y to continue when the following prompt displays: “The following files are being installed with setuid and/or setgid permissions:

```
op/local/apache/bin/suexec <setuid root>
```
Do you want to install these as setuid/setgid files.”

Select y to continue when the following prompt displays: “This package contains scripts which will be executed with super-user permission during the process of installing this package.”

5. After installing the FEMISarw package select q to quit.

6. Use pkgchk to verify the package was installed correctly.

```
# pkgchk -n FEMISarw
```

7. Ignore the following or similar errors:

```
ERROR: /etc/init.d/apache
    Permission <0700> expected <0744> actual
```
If you only see the above output or your system prompt appears with no output, the package installed successfully.

8. Remove the spool directory.

```
# rm -r /<dir>/spool
```

9. Remove the tape from the drive.

### 2.7.3 Configuring AutoRecovery Web Reporting

To configure AutoRecovery Web Reporting, complete the following steps:

1. Login as root.

   The installation of the FEMISarw package creates two new users, femisar and www (if they do not already exist). Edit the /etc/passwd file, locate the line for femisar, and change it to the /bin/sh if the default shell is /bin/date. The femisar account cannot receive E-mail using /bin/date.

2. Be sure to set the femisar password. Example: passwd femisar.
3. Edit /opt/local/apache/htdocs/index.html. Change YOUR_SYSTEM_NAME_HERE to your servername (e.g., tomando.pnl.gov).

4. Edit /opt/local/apache/htdocs/femis/mb/index.pl. Change root@localhost to the System Administrator’s E-mail address (e.g., admin@pnl.gov).

5. Edit /opt/local/apache/home/femisar/bin/mail.pl. Change root@localhost to the System Administrator’s E-mail address (e.g., admin@pnl.gov).

6. Edit all html files in the /opt/local/apache/htdocs/femis/help directory. Change http://tomado.pnl.gov to http://YOURSERVERNAME.YOURDOMAIN. Change the E-mail address from root@localhost to the System Administrator’s E-mail address.

7. Run /opt/local/apache/bin/setup_femiaarw. When prompted, enter the name of each server that will send AutoRecovery E-mail messages. The script will create a directory for each server with the appropriate permissions.

8. Start the web server.

   sh /etc/init.d/apache start

9. Test the application with a web browser. The address should be http://YOURSERVERNAME.YOURDOMAIN (e.g., http://tomado.pnl.gov).

10. Edit the /opt/local/bin/femis_watch.conf on each server from which you will receive AutoRecovery E-mail, and add femisar to the Custodian list (e.g., $Custodian = ‘femisar@yoursystem.yourdomain’).

AutoRecovery Web Reporting is now available for you to use.

2.7.4 Customizing AutoRecovery Web Reporting

2.7.4.1 Setting the retainFlag Variable

The variable $retainFlag in /opt/local/apache/home/femisar/bin/clean.pl is used to control how old messages are removed from the MessageBase. The string is comprised of three parts. The first part is a single letter that specifies what method to use to remove the messages.

- If the letter is a p (pruned), then messages that are older than the current date minus the specification in the next two parts are removed.
If the letter is a t (truncated), messages are removed at a time that is a multiple of the unit specification and modulus of the unit specification. In other words, if the span and unit specification is a 1d (1 day), then the messages that are older than midnight GMT of the previous day would be removed.

The next two parts are the number of units and the type of the unit. The number must be a positive whole number or 0. The unit code may be one of the following: s, m, h, d, or w, which stand for seconds, minutes, hours, days, or weeks. These number and type of units could be used in a specification, such as t0d that would remove all messages before the current day (GMT).

The default is set to p24h.

2.7.4.2 Changing the Refresh Rate

To change the refresh rate of the AutoRecovery Web Reporting application, edit /opt/local/apache/htdocs/femis/mweb/index.pl. The default is set to 60 seconds. To change the default value, change content="$60" to your preferred refresh rate.

2.7.4.3 Accurate System Time

Proper operation of a public web server requires accurate time keeping, since elements of the HTTP protocol are expressed as the time of day.

2.7.4.4 Customizing the Apache Web Server

For additional information on customizing the Apache Web Server, see the online manual at http://YOURSERVERNAME/manual or go the Apache Web Page at http://www.apache.org.
3.0 FEMIS GIS Migration and Configuration

This section provides instructions on how to migrate/upgrade and configure the FEMIS GIS to v1.4.6 without overwriting any customization that has been done for your EOC.

The v1.4.6 migration and configuration of GIS files on the servers should proceed as follows:

- For each server at the site, determine which of the following three situations applies.
  1. The server contains FEMIS v1.4.5 GIS files that have not been customized or altered in any way.
  2. Some customization changes have been made to the v1.4.5 GIS files on the server, but the EOC does not wish to preserve those customizations.
  3. Some customization changes have been made to the v1.4.5 GIS files on the server, and the EOC wishes to preserve those customizations.

- On one of the servers in Group 1, perform a complete GIS server upgrade (Sections 3.1 through 3.5). This should be performed at the onpost EOC if it is in Group 1, because of the possible need to update the Met tower and Met cluster information in the onpost database.

- On each of the remaining servers in Group 1 and all of the servers in Group 2, delete all of the existing GIS files and replace them by copying all of the GIS files from the server on which the initial GIS server upgrade was performed (see previous bulleted item). See Section 3.6, Copying the v1.4.6 GIS Files to the Other Servers, for detailed instructions.

- On each of the servers (if any) in Group 3, perform an individual GIS server upgrade (Sections 3.1 through 3.5). This is necessary to preserve customization changes.

Note: As a precaution, you should backup the /home/femis/gis directory on the server using `cp -rp /home/femis/gis /home/femis/gis145` before making any changes to the GIS files.

3.1 IEM GIS Upgrade

Make sure that FEMIS GIS Database Upgrade from Innovative Emergency Management, Inc. (IEM) has been completed for your site before completing the FEMIS GIS migration from v1.4.5 to v1.4.6.

3.2 Preparing to Install FEMIS on One PC

Some of the steps in upgrading the GIS files to v1.4.6 format must be performed on a PC. The PC on which these steps will be performed must have the FEMIS v1.4.6 client software installed. However, the FEMIS Setup program will not be able to install the GIS until the GIS upgrade has been completed. Follow these steps to install the FEMIS client software without installing the GIS.
Note: If possible, select a PC on which the GIS has not been customized for performing this migration process. Any customization of the GIS that may have been done on this PC will be lost.

1. Install the PC COTS. See Section 4.1, Installing the PC COTS for instructions.

2. Configure the FEMIS Setup Program, as specified in Section 4.2, Configuring the FEMIS Setup Program.

3. Map a network drive to the server /home/femis/ directory.

4. Run `\PC\SETUP\SETUP.EXE` on the mapped drive.

5. Select the Site and EOC from the drop-down lists when the FEMIS Setup opens. Click Next.

6. Click OK for each of the three error messages regarding missing `fgis_sm.ini`, `fgis_md.ini`, and `fgis_lg.ini` files.

7. Verify that the FEMIS component has a checkmark on the Select Components window. DO NOT SELECT THE GIS TO BE INSTALLED. Click Next.

8. Accept the program folder by clicking Next.

9. Accept the default destination directory by clicking Next.

10. Start copying the files by clicking Next.

### 3.3 Editing the FEMIS.INI File for the GIS Upgrade

Since the FEMIS Setup program could not be used to install the GIS, some manual editing of the FEMIS configuration files may be needed. Edit the `%windir%\FEMIS.INI` file in a text editor to set the GIS paths as follows:

Go to the `[FemisGis]` section and edit the following parameters, if they are not correct. Add the values if they do not exist.

```
[FemisGis]
GISTopDirPC=<DRIVE>\FEMIS\GIS\<SITE CODE>
ViewmarkDir=\GIS\Viewmark
GISEditScript=<DRIVE>\FEMIS\GIS\<SITE CODE>\FEMISGIS.APR
GISTopDirNFS=X:\GIS
GISTopDirUNIX=/home/femis/gis
GisSize=unknown
```

where `<DRIVE>` is the drive specification for the GIS installation, such as C:. 

3-2
Add or edit the following parameters as needed, in the [FEMIS Misc] section.

[FEMIS Misc]
  ExerciseNum=0
  Site Code=<site code>
  EOC Code=<eoc code>

Add or edit the following parameters as needed, in the [<site code>] section.

[<site code>]
  _GISTopDirPC=<DRIVE>FEMIS\GIS\<SITE CODE>
  _ViewmarkDir=M:\GIS\Viewmark
  _GISEditScript=<DRIVE>FEMIS\GIS\<SITE CODE>FEMISGIS.APR
  _GISTopDirNFS=X:\GIS
  _GISTopDirUNIX=/home/femis/gis

Save the file and exit.

3.4 Populating the GIS-Related Tables

To create or update the FEMIS GIS point themes based on the current information in the FEMIS relational database, complete the following steps on the server:

1. login as femis.

2. Ensure that the UNIX environment variable femis_home is set to the path of the FEMIS home directory.

3. Run the gengis.sh shell script.

   % cd ~/femis/database/eocdba
   % ./gengis.sh

   This script runs a set of SQL*Plus scripts to generate the static FEMIS point themes from data in the relational database. The FEMIS point themes include Met towers and igloos. In FEMIS v1.4.6, the facility, siren, traffic control point, and known point themes are dynamic themes that will be regenerated each time FEMIS is run.

4. Copy the following files from your current directory to the following GIS directories.

   % cp -p <site code>_mt_evt /home/femis/gis/<site code>/mettower
   % cp -p <site code>_ip_evt /home/femis/gis/<site code>/igloo

   where <site_code> is the onpost EOC code (for example, anad).
5. Delete the following files, if they exist, from the indicated GIS data directories.

- `rm /home/femis/gis/<site code>/facility/facility.*`
- `rm /home/femis/gis/<site code>/siren/siren.*`
- `rm /home/femis/gis/<site code>/tcp/tcp.*`
- `rm /home/femis/gis/<site code>/known_p/known_p.*`

6. Examine your current directory for a file named clusters.dat. If the file exists, verify that it contains a line of column headings similar to `TOWER_NAME | CLUSTER_NUM` followed by a data line for each of the met clusters that are currently operational at the site.

**Note:** If the clusters.dat file does not exist, is empty, or contains only the single heading line, complete Steps 7-11 and then repeat Steps 3-6.

If the clusters.dat file exists and contains the proper data, complete the following step, skip Steps 7-11, and go to Section 3.5, Migrating the FEMIS GIS from v1.4.5 to v1.4.6.

Copy the file to the GIS site apr control file directory.

- `cp -p clusters.dat /home/femis/gis/<site code>_apr`

**Note:** Perform Steps 7-11 only if the Steps 1-6 failed to produce a valid clusters.dat file.

As part of the site-specific installation information, you should have a list of met tower cluster numbers and met tower heights. You will need this information to update the met cluster information for this site.

Complete the following steps once at the onpost EOC to update met cluster information:

7. Start the FEMIS Met Injector on a PC with FEMIS v1.4.6 installed by clicking the Met Injector icon (if the icon was installed) or double-clicking fmetsimw.exe in main FEMIS directory. Connect to the onpost database on the FEMIS Login window.

8. Select a tower (using the site-specific list of cluster numbers and heights for reference) from the Tower Name drop-down list.

9. Click the Add Cluster button. Add the appropriate cluster number and height for the given tower on the window that displays.

10. Repeat Steps 8 and 9 until you have entered all of the cluster numbers and heights for the appropriate towers.

11. Repeat Steps 3-6 to create a valid clusters.dat file and incorporate the met tower information into the GIS files.
3.5 Migrating the FEMIS GIS from v1.4.5 to v1.4.6

Several files need to be updated in order to migrate the FEMIS GIS from v1.4.5 to v1.4.6. The following sections detail how each file is to be updated.

3.5.1 Change Permissions on the Lookup Table

Enter the following commands to change the permissions on the lookup table.

```bash
% cd ~/femis/gis/<site code>/lookup
% chmod 777 obj_type.lut
```

3.5.2 Copy the GIS Files from the Server /home/femis/gis to a PC

From the /home/femis/gis directory on the server, use the PC on which the v1.4.6 upgrade will be performed to copy the GIS files to the PC.

1. Map a drive on the PC to the /home/femis directory on the server. Connect to the drive as the user femis.

2. Copy all of the files from \gis\<site code> on the mapped drive to <DRIVE>\FEMIS\GIS\<SITE CODE> on the PC.

3. Copy the defaults_template.txt, femisgis.apr, and femisgis_utilities.apr files from \gis\<site code> on the mapped drive to the <DRIVE>\FEMIS\GIS directory on the PC.

4. Copy the fgis_sm.ini, fgis_md.ini, fgis_lg.ini, and clusters.dat files from the \gis\<site code>\apr directory on the mapped drive to the <DRIVE>\FEMIS\GIS\<SITE CODE> directory on the PC.

If a FEMISGIS.INI file exists in the <DRIVE>\FEMIS\GIS\<SITE CODE> directory on the PC, rename it to FEMISGIS.INI.OLD.

3.5.3 Updating the Mettower Theme

The Mettower theme GIS attributes need to be updated for v1.4.6 using the femisgis_utilities.apr. To upgrade the Mettower theme, follow the procedures below.

1. Open ArcView v3.0a.

2. Select Open Project from the File Menu.
3. Browse to <DRIVE>FEMIS\GIS\<SITE CODE>FEMISGIS_UTILITIES.APR, and click OK.

4. Double-click on View1 to open a view in the open window.

5. Select Add Theme from the View menu.

6. Select the Mettower theme from the METTOWER directory (<DRIVE>FEMIS\GIS\<SITE CODE>\METTOWER\<SITE CODE>_MT.SHP).

7. Select Add Mettower Clusters from the Utilities menu.

8. Enter the mettower name (<SITE CODE>_MT.SHP) as labeled in the Legend. Click OK.

9. Rename the three files that are written to the <DRIVE>FEMIS\GIS\<SITE CODE> directory from METNEW.SHP, METNEW.SHX, AND METNEW.DBF to <SITECODE>_MT.SHP, <SITECODE>_MT.SHX, <SITECODE>_MT.DBF.

10. Close FEMISGIS_UTILITIES.APR.

11. Copy the three new (renamed) files back to the server to replace the files in /home/femis/gis/<site code>/mettower.

12. Copy the three new files back to the PC to replace the files in <DRIVE>FEMIS\GIS\<SITE CODE>\METTOWER.

3.5.4 Populating the defaults.txt File

The DEFAULTS.TXT file will contain the needed information to upgrade the existing v1.4.5 FEMISGIS.INI and OBJ_TYPE.LUT files to v1.4.6. Upon populating the file with site-specific information, the file will be written to the /home/femis/gis/<site code>_apr directory during the PC setup program installation.

A generic DEFAULTS_TEMPLATE.TXT file is in the <DRIVE>FEMIS\GIS\<SITE CODE> directory. This file may be used to create the DEFAULTS.TXT file because all the site-generic information has been included after the comment section. After the site-specific information has been added, rename the file DEFAULTS.TXT.

To populate the DEFAULTS.TXT file, complete the following steps.

1. Open the <DRIVE>FEMIS\GIS\<SITE CODE>\DEFAULTS_TEMPLATE.TXT file in a text editor (i.e., Notepad).

2. Go the [NEW PARAMETERS] section of the DEFAULTS_TEMPLATE.TXT file. Add the Site Code information to the [NEW PARAMETERS] section.
Example:
[NEW PARAMETERS]
siteCode=ANAD

3. Set the general hazard functionality parameters. The known polygon and the flood dynamic themes and the accompanying specifications, which were not in v1.4.5, must be included in this section. Create one known polygon for each EOC in the form kpoly_<eoc sitecode> (e.g., kpoly_anad) and one flood layer for each EOC in the form flood_<eoc sitecode> (e.g., flood_anad).

For reference, the sections of the DEFAULTS.TXT file are

[SPECIAL_CHAR]
[FEMIS_VERSION]
[LUT FILE NAMES]
[LUT NEW PARAMETERS]
[NEW LUT TYPES]
[FILE NAMES]
[NEW PARAMETERS]
[ADDITIONAL DYNAMIC THEMES]
[THEME PARAMETER COMMENTS]

To populate the DEFAULTS.TXT file, complete the following steps.

1. Set the special characters. The default is tab.

   [SPECIAL_CHAR]
   tabChar=" "
   end_SPECIAL_CHAR

2. Set the FEMIS version.

   [FEMIS_VERSION]
   FEMIS Version=1.4.6
   FEMISGIS Size designation=<size designation> (The default is unknown.)
3. Rename the lookup table (LUT) in the \LOOKUP directory.

[LUT FILE NAMES]
oldFileName=<v1.4.5 LUT filename>
newFileName=<v1.4.6 LUT filename>

4. Change the lookup table default values for new parameters.

[LUT NEW PARAMETERS]
background color = 0
outline color = 5

5. Verify your new lookup table types are similar to the following:

[NEW LUT TYPES]
5 0 3 0 44 COUNTY AL
5 0 3 0 44 COUNTY AR
5 0 3 0 44 COUNTY CO
5 0 3 0 53 COUNTY IL
5 0 3 0 44 COUNTY IN
5 0 3 0 44 COUNTY KY
5 0 3 0 44 COUNTY MD
5 0 3 0 44 COUNTY OR
5 0 3 0 53 COUNTY WA
5 0 3 0 44 COUNTY UT

6. Rename your FEMISGIS.INI.

[FILE NAMES]
oldFileName =<v1.4.5 filename>
newFileName =<v1.4.6 filename>

7. Set the following parameters for v1.4.6.

[NEW PARAMETERS]
siteCode=<4-digit site code>
defaultHazardTheme = zone
tgSpheroid = SPHEROID_CLARKE1866
customizationFlag = Yes
BgColor = 0
outlineColor = 5

8. Set the general hazard functionality parameters. The known polygon and the flood dynamic themes and the accompanying specifications, which were not in v1.4.5, must be included in this section. Create one known polygon for each EOC in the form kpoly_<eoc site code> (e.g., kpoly_anad) and one flood layer in the form flood_<eoc site code> (e.g., flood_anad).
9. Theme Parameter Comments.

[THEME PARAMETER COMMENTS] – This section contains comments describing the sections in the FEMISGIS.INI file to be written to the FEMISGIS.INI file. All information in this section will be written to the FEMISGIS.INI file, regardless if it is commented out.

For an example of DEFAULTS.TXT file, see the end of this section.

3.5.5 Save the DEFAULTS.TXT File

To save the DEFAULTS.TXT file, complete the following steps.

1. Save the edited DEFAULTS_TEMPLATE.TXT file to <DRIVE>\FEMIS\GIS\<SITE CODE>\DEFAULTS.TXT.

2. Copy the file to the \gis\<site code>_apr directory on the mapped drive.

3.5.6 Upgrading the femisgis.ini and obj_type.lut Files to v1.4.6

Complete the following steps to upgrade the femisgis.ini and obj_type.lut files to v1.4.6.

1. Rename the FGIS_SM.INI, FGIS_MD.INI, and FGIS_LG.INI files in the <DRIVE>\FEMIS\GIS\<SITE CODE> directory to FGIS_SM.OLD, FGIS_MD.OLD, and FGIS_LG.OLD so that the files are preserved when the new v1.4.6 files are created.

2. Rename the <DRIVE>\FEMIS\GIS\<SITE CODE>\LOOKUP\OBJ_TYPE.LUT to <DRIVE>\FEMIS\GIS\<SITE CODE>\LOOKUP\OBJ_TYPE.OLD.

3. Open the FEMISGIS_UTILSITIES.APR in ArcView GIS v3.0a.

4. Select Convert LUT and INI from the Utilities menu.

5. Select Convert LUT to convert the OBJ_TYPE.OLD to v1.4.6 format.

6. Select the v1.4.5 OBJ_TYPE.OLD file from the Enter Input Filename window. If the file is not in the default directory, browse to find the file. Click OK when the file has been selected.
Note: The following steps may encounter files permissions on destination files placing file(s) on the UNIX server. Adjust permissions accordingly on the UNIX file server to allow file placement to occur.

7. Name the updated file OBJ_TYPE.LUT and place in the `gis\<site code>`\lookup directory on the mapped drive. Keep `ARCVIEW.EXE` open during this and the following steps.

8. Select Convert INI to convert one of the .INI files (small, medium, or large) to v1.4.6 format.

9. Select FGIS_SM.OLD from the Enter Input Filename window. If the file is not in the default directory, browse to find the file. Click OK when the file has been selected.

10. Save the updated file as FGIS_SM.INI, and copy it to the `gis\<site code>_apr` directory on the mapped drive.

11. Convert the medium and large v1.4.5 .INI files by selecting Convert INI from the Utilities menu for each file (FGIS_MD.INI, and FGIS_LG.INI). Save the updated medium .INI file as FGIS_MD.INI and the updated large .INI file as FGIS_LG.INI, and place them in the `gis\<site code>_apr` directory on the mapped drive.

12. Copy the v1.4.6 FEMISGIS.APR from the server to your `<DRIVE>\FEMIS\GIS\<SITE CODE>` directory, if you not done so already. On the PC, rename the file to FEMPTY.APR.

13. Copy the small .INI file (FGIS_SM.INI) to FEMISGIS.INI, and run the .APR in ArcView GIS by double-clicking on the FEMPTY.APR file. Verify that the .APR runs to completion and loads all of the GIS themes without error. Delete the FEMISGIS.INI file and repeat for the medium (FGIS_MD.INI) and large (FGIS_LG.INI) files. Do not delete the FEMISGIS.INI file after testing the third file.

Note: If there are .INI files for each EOC (e.g., Maryland), the FGIS_SM.INI, FGIS_MD.INI, and FGIS_LG.INI files must be upgraded for each EOC.

3.5.7 Troubleshooting the Migration

Verify the following, if the FEMISGIS_UTILITIES.APR did not run successfully:

- The OBJ_TYPE.LUT and FEMISGIS.INI files are in a valid v1.4.5 format (see Section 3.4.2.1, Checking the v1.4.5 FEMISGIS.INI File).

- Check the OBJ_TYPE.LUT and FEMISGIS.INI files are not Read-only.

- The files are in the correct directories.
• The files are correctly named.

• The DEFAULTS.TXT file is correctly populated and the filenames are correct.

• The FEMIS.INI file’s [FEMIS_GIS] section parameters are correct.

3.5.7.1 Checking the v1.4.5 FEMISGIS.INI File

The FEMISGIS.INI file should be in a valid v1.4.5 format. An example FEMISGIS.INI file is shown at the end of this section, with the site-specific information in the brackets (<>).

The version should be listed in the comment section at beginning of the file only and should have the following sections only:

• [SiteCode] – See the v1.4.5 example at the end of the section for formatting parameters.

• [PROJECTION_PARAMETERS] – See the v1.4.5 example at the end of the section for formatting parameters.

• [AREA_OF_INTEREST] – See the v1.4.5 example at the end of the section for formatting parameters.

• [THEME_PARAMETERS] – Should be delimited by the pipe (|) character, there should be 16 records for each theme only, and any themes that the user does not want displayed should be commented with a single quote (‘).

The fields in the femisgis.ini file are Theme, Db Object Type, Visible Status, Label Field, Obj Lookup Category, Classification Field, Default Legend, Min Scale, Max Scale, Legend Name, Symbol, Color, Size, Path, and Alternative Prefix.

3.5.7.2 Checking the v1.4.5 obj_type.lut File

The lookup table file can be found in /home/femis/gis/lookup/obj_type.lut. Check to make sure there are five columns, and each record is delimited with the pipe (|) character. The first three columns are the Symbol, Color, and Size definitions; and these are numeric entries. The fourth column is the Theme type (facility, tcp), and the fifth column is the Legend descriptor. There should not be a header row.

Example: 89 | 46 | 12 | facility | school

3.6 Copying the v1.4.6 GIS Files to the Other Servers

Copy the GIS files from the server on which you performed the first GIS migration/upgrade to all the other servers that do not have customization changes which need to be preserved.
Note: Before using the following procedure, make sure that the servers being “copied to” allow rsh commands from the server being “copied from” as a trusted host (no password prompt). See the UNIX man page on rsh for further details.

1. Enter the following on the GIS converted server as root, or femis user.

   #cd /home/femis/gis

2. Preserve old data.

   rsh <server name> ‘cd /home/femis/gis; mkdir bkp; mv <site code>*</site code>bkp’

3. Tarring the files may take a while to complete.

   #tar of - <site code>* | (rsh <server name> cd /home/femis/gis; tar xf -)

   where <site code> is your site code (lower case), such as anad.
   <server name> is the host name of the server you are copying to.
   The * is a literal asterisk for wild card expansion.

4. Restore old rsh privileges, if desired.

5. Repeat Steps 2-4 for any additional servers the files need to be mirrored to.

### 3.7 Completing the Installation on This PC

Go to Section 4.4, Configuring the PC, to continue and complete the installation on this PC.
[SiteCode]
SiteCode: <4 digit sitecode>

[PROJECTION_PARAMETERS]
Central Meridian: -87
Reference Latitude: 0
False Easting: 500000
False Northing: 0
Scale: <scale>
Spheroid: SPHEROID_CLARKE1888

[AREA_OF_INTEREST]
origin: <lat> <lon>
size: 58.00 27.00

[THEME_PARAMETERS]

<table>
<thead>
<tr>
<th>Theme</th>
<th>Object Type</th>
<th>Status Field</th>
<th>Category</th>
<th>Field</th>
<th>Legend</th>
<th>Scale</th>
<th>Legend Name</th>
<th>Symbol</th>
<th>Color</th>
<th>Size</th>
<th>Path prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>'im_{1,2}'</td>
<td>Image</td>
<td>off</td>
<td>None</td>
<td>None</td>
<td>500000.0</td>
<td>1500000.0</td>
<td>Map Image: 11M</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>im_{1,2}anlonan1m.tif</td>
</tr>
<tr>
<td>'im_{5,6}'</td>
<td>no</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>80000.0</td>
<td>50000.0</td>
<td>Map Image: 100K</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>im_{5,6}anlonan100k.tif</td>
</tr>
<tr>
<td>'idc_{1,2}'</td>
<td>no</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>20000.0</td>
<td>90000.0</td>
<td>1:100K Images</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>idc_{1,2}onan100k.tif</td>
</tr>
<tr>
<td>'idc_{1,2}'</td>
<td>no</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>20000.0</td>
<td>90000.0</td>
<td>Rome: 1:100K</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>idc_{1,2}onan100k.tif</td>
</tr>
<tr>
<td>'idc_{1,2}'</td>
<td>no</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>20000.0</td>
<td>90000.0</td>
<td>La Grange: 1:100K</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>idc_{1,2}onan100k.tif</td>
</tr>
<tr>
<td>'contour'</td>
<td>no</td>
<td>Line</td>
<td>Elev</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>contour_solidcontour</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'contour'</td>
<td>no</td>
<td>Line</td>
<td>Elev</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>contour_solidcontour</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'odeblock'</td>
<td>yes</td>
<td>Polygon</td>
<td>Block</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>odeblock_solidodeblock</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'odeblock'</td>
<td>yes</td>
<td>Polygon</td>
<td>Block</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>odeblock_solidodeblock</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'place'</td>
<td>no</td>
<td>Polygon</td>
<td>City</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>place_{1}anplace</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'place'</td>
<td>no</td>
<td>Polygon</td>
<td>City</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>place_{1}anplace</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'place'</td>
<td>no</td>
<td>Polygon</td>
<td>City</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>place_{1}anplace</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'administrative'</td>
<td>no</td>
<td>Polygon</td>
<td>Name</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>administrative_angre</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'administrative'</td>
<td>no</td>
<td>Polygon</td>
<td>Name</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>administrative_angre</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zonalized'</td>
<td>no</td>
<td>Polygon</td>
<td>Zone</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zonalized_azure</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zonalized'</td>
<td>no</td>
<td>Polygon</td>
<td>Zone</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zonalized_azure</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zonalized_paz'</td>
<td>no</td>
<td>Polygon</td>
<td>Zone</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zonalized_paz</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zonalized_paz'</td>
<td>no</td>
<td>Polygon</td>
<td>Zone</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zonalized_paz</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zonalized_res'</td>
<td>no</td>
<td>Polygon</td>
<td>Zone</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zonalized_res</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zonalized_res'</td>
<td>no</td>
<td>Polygon</td>
<td>Zone</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zonalized_res</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'blockpop'</td>
<td>no</td>
<td>Point</td>
<td>Population</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>blockpop_solidblockpop</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'blockpop'</td>
<td>no</td>
<td>Point</td>
<td>Population</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>blockpop_solidblockpop</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'blockpop'</td>
<td>no</td>
<td>Point</td>
<td>Population</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>blockpop_solidblockpop</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'blockpop'</td>
<td>no</td>
<td>Point</td>
<td>Population</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>blockpop_solidblockpop</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'railroad'</td>
<td>no</td>
<td>Line</td>
<td>Frames</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>railroad_solidrailroad</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'railroad'</td>
<td>no</td>
<td>Line</td>
<td>Frames</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>railroad_solidrailroad</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'roadmap'</td>
<td>no</td>
<td>Line</td>
<td>Frames</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>roadmap_solidroadmap</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'roadmap'</td>
<td>no</td>
<td>Line</td>
<td>Frames</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>roadmap_solidroadmap</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'rt_cst'</td>
<td>no</td>
<td>Line</td>
<td>Route</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>rt_cst_solidrt_cst</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'rt_cst'</td>
<td>no</td>
<td>Line</td>
<td>Route</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>rt_cst_solidrt_cst</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'rt_cst'</td>
<td>no</td>
<td>Line</td>
<td>Route</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>rt_cst_solidrt_cst</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'rt_cst'</td>
<td>no</td>
<td>Line</td>
<td>Route</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>rt_cst_solidrt_cst</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'highway'</td>
<td>no</td>
<td>Line</td>
<td>Street</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>highway_solidhighway</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'highway'</td>
<td>no</td>
<td>Line</td>
<td>Street</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>highway_solidhighway</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'highway'</td>
<td>no</td>
<td>Line</td>
<td>Street</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>highway_solidhighway</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'highway'</td>
<td>no</td>
<td>Line</td>
<td>Street</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>highway_solidhighway</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'pt_nameml'</td>
<td>no</td>
<td>Point</td>
<td>Name</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>pt_nameml_solidpt_nameml</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'pt_nameml'</td>
<td>no</td>
<td>Point</td>
<td>Name</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>pt_nameml_solidpt_nameml</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'pt_nameml'</td>
<td>no</td>
<td>Point</td>
<td>Name</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>pt_nameml_solidpt_nameml</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'pt_nameml'</td>
<td>no</td>
<td>Point</td>
<td>Name</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>pt_nameml_solidpt_nameml</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zone_shape'</td>
<td>no</td>
<td>Polygon</td>
<td>Objectname</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zone_shape_solidzone_shape</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zone_shape'</td>
<td>no</td>
<td>Polygon</td>
<td>Objectname</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zone_shape_solidzone_shape</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zone_shape'</td>
<td>no</td>
<td>Polygon</td>
<td>Objectname</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zone_shape_solidzone_shape</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'zone_shape'</td>
<td>no</td>
<td>Polygon</td>
<td>Objectname</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>zone_shape_solidzone_shape</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'metertower'</td>
<td>yes</td>
<td>Point</td>
<td>on</td>
<td>Name</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>metertower_solidmetertower</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'metertower'</td>
<td>yes</td>
<td>Point</td>
<td>on</td>
<td>Name</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>metertower_solidmetertower</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'metertower'</td>
<td>yes</td>
<td>Point</td>
<td>on</td>
<td>Name</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>metertower_solidmetertower</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>'metertower'</td>
<td>yes</td>
<td>Point</td>
<td>on</td>
<td>Name</td>
<td>None</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>metertower_solidmetertower</td>
<td>none</td>
<td></td>
</tr>
</tbody>
</table>
Example of a defaults.txt file.

```plaintext
[SPECIAL_CHAR]
tabChar= " "
end_SPECIAL_CHAR

[FEMIS_VERSION]
FEMIS Version=1.4.6
FEMISOIS Size designation=medium

[LUT FILE NAMES]
oldFileName = obj_type.old
newFileName = obj_type.hut

[LUT NEW PARAMETERS]
background color = 0
outline color = 5

[NEW LUT TYPES]
5 | 0 | 3 | 0 | 44 | COUNTY | AL
5 | 0 | 3 | 0 | 44 | COUNTY | AR
5 | 0 | 3 | 0 | 44 | COUNTY | CO
5 | 0 | 3 | 0 | 53 | COUNTY | IL
5 | 0 | 3 | 0 | 44 | COUNTY | IN
5 | 0 | 3 | 0 | 44 | COUNTY | KY
5 | 0 | 3 | 0 | 44 | COUNTY | MD
5 | 0 | 3 | 0 | 44 | COUNTY | OR
5 | 0 | 3 | 0 | 53 | COUNTY | WA
5 | 0 | 3 | 0 | 44 | COUNTY | UT

[FILE NAMES]
oldFileName = femisgis.old
newFileName = femisgis.ini

[NEW PARAMETERS]
siteCode = ANAD
defaultHazardTheme = zone
fgSpheroid = SPHEROID_CLARKE1866
customizationFlag = Yes
BgColor = 0
outlineColor = 5

[ADDITIONAL DYNAMIC THEMES]
kpoly_anad yes [Polygonizes | off] [20]Objectname|None simple | None | 1000.0 | 10000000.0 | anad Known Polygons | [No | 8] | 44 | 2 | 0 | 53 | kpoly/kpoly_anad | none
FLOOD_anad yes [point] yes | off [19]Objectname|None simple | None | 1000.0 | 20000000.0 | anad Flooded Areas | [No | 36] | 28 | 2 | 0 | 34 | kpoly/kpoly_flood_anad | none
kpoly_sena| yes [Polygonizes | off] [18]Objectname|None simple | None | 1000.0 | 15000000.0 | seana Known Polygons | [No | 8] | 44 | 2 | 0 | 53 | kpoly/kpoly_sena | none
FLOOD_sena| yes [point] yes | off [17]Objectname|None simple | None | 1000.0 | 20000000.0 | seana Flooded Areas | [No | 36] | 28 | 2 | 0 | 34 | kpoly/kpoly_flood_sena | none
kpoly_ccal| yes [Polygonizes | off] [16]Objectname|None simple | None | 1000.0 | 15000000.0 | cca| Known Polygons | [No | 8] | 44 | 2 | 0 | 53 | kpoly/kpoly_ccal | none
FLOOD_ccal| yes [point] yes | off [15]Objectname|None simple | None | 1000.0 | 20000000.0 | cca| Flooded Areas | [No | 36] | 28 | 2 | 0 | 34 | kpoly/kpoly_flood_ccal | none
kpoly_ccla| yes [Polygonizes | off] [14]Objectname|None simple | None | 1000.0 | 15000000.0 | ccla Known Polygons | [No | 8] | 44 | 2 | 0 | 53 | kpoly/kpoly_ccla | none
```
C. Theme parameters

Each line of the input table contains the following theme data in sequence:

0 "Theme", Theme name in the FEMIS Database Fems Object table. Null = otherwise.

1 "FEMIS Accessible", Feature themes: Yes or no flag of whether the theme is in the Fems object table

2 "Type", Feature type; it must be one of: Image, ImgCat, point, line, polygon, event

3 "Status", Theme visibility status when forming the apr

4 "DisplayOrder", #1 is the theme at the top of the table of contents, and is loaded first (on top of all the other themes)

5 "Label Field", Field name used as the default labeling field

6 "Obj Category", Feature theme category; it must be one of the types listed in the _HOME/Lookup/obj_type.lut file. Currently: zone, sbpc, igloo, facility, tcp, road, siren, known_p.

7 "Min Scale", Below the minimum scale, the theme is not displayed.

8 "Max Scale", Above the minimum scale, the theme is not displayed.

9 "Legend Name", Name desired for the legend

10 "Customize", The Customization Flag is meaningful only in the Dynamic themes: "Yes" Yes – Use the current symbolization parameters in this theme line in the INI file (do not overwrite when dynamic is updated). No --> Allow symbol parameters in this line of the INI to be overwritten with values from DB when dynamic theme is updated. N/A is for static themes.

11 "Symbol", Symbol number to be used in a simple classification.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Color&quot;</td>
<td>Foreground and outline color for theme symbols, if they can be colored</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Symbol size</td>
</tr>
<tr>
<td>&quot;BackGround Color&quot;</td>
<td>Background Color of polygonal symbols</td>
</tr>
<tr>
<td>&quot;Outline Color&quot;</td>
<td>Outline Color of polygonal symbols</td>
</tr>
<tr>
<td>&quot;Path&quot;</td>
<td>Appended to the Home value specified in the femis.ini file for the gis data.</td>
</tr>
<tr>
<td>&quot;Alternate prefix&quot;</td>
<td>Used as a prefix to the &quot;Path&quot; instead of the Home value. Only the load themes script uses this prefix to locate and read alternate source directory for big files. Any auxiliary files will be written using the Home prefix.</td>
</tr>
<tr>
<td>&quot;Dynamic Theme&quot;</td>
<td>True or false flag set by the location of theme in the ini file. (in the static or dynamic theme section)</td>
</tr>
</tbody>
</table>
4.0 FEMIS PC Installation

The following sections describe the steps needed to install FEMIS on a PC.

4.1 Installing the PC COTS

The order for installing the COTS on a new FEMIS PC is as follows:

1. Windows NT Workstation v4.0 and Windows NT Service Pack 4
2. Hummingbird NFS Maestro v6.1 or Solstice NFS Client v3.2
3. Oracle SQL*Net v2.3.4
4. ArcView GIS v3.0 and v3.0a patch
5. Microsoft Project 98 Service Release 1

Installing the following COTS products is optional.

   E-mail application   (if applicable)
   Word processor      (if applicable)
   Spreadsheet         (if applicable)
   Graphics presentation (if applicable).

At the end of this section, PNNL has provided two checklists that can be used for each PC installation.

- FEMIS PC Installation Checklist and
- FEMIS PC Validation Checklist.

**Note:** If you have a previous version of FEMIS installed, verify that your COTS software packages are the same version as those listed in the FEMIS Bill of Materials (BOM). If they are the same, proceed to Section 4.3, Installing the FEMIS Client Software, to install the FEMIS application.

4.1.1 Installing Windows NT v4.0

4.1.1.1 Before Installing Windows NT

Issues you should consider before beginning the Windows NT installation include hardware requirements, multi-boot capabilities, installation tips, and storage device detection.
Hardware Requirements

There are two sets of information, which you must consider regarding hardware requirements for Windows NT. First, you must check the Windows NT Hardware Compatibility List (HCL) published by Microsoft. This document covers every type and model of hardware that has been tested for compatibility with Windows NT. The list is updated regularly and can be accessed at Microsoft's Web site (http://www.microsoft.com/hwtest/hcl/default.htm). Check the HCL to verify that every major component of your computer system is compatible with Windows NT. If one or more components are not listed, contact Microsoft or the hardware vendor to see if new drivers or compatibility aids are available. If not, you should think twice before installing Windows NT on your computer.

The second requirement that must be considered is minimum hardware requirements, which can be found in the FEMIS Bill of Materials (BOM). If your computer does not meet these minimum requirements, it is unlikely that Windows NT will work acceptably on this system.

Multi-Boot

Windows NT can coexist with other operating systems, including MS-DOS, Windows for Workgroups, and Windows 95/98. The Windows NT installation program can detect these operating systems and include them on the Windows NT bootup menu. However, MS-DOS and 16-bit Windows are only supported if they were installed first, before Windows NT. Installing them afterward is strongly discouraged by Microsoft and can cause unreliable Windows NT operation.

Windows NT Installation Tips

Installing Windows NT can be a very intimidating experience. There are many points where the operator must make a choice, but very little information is available about how to choose or the potential consequences of a choice. Fortunately, this problem is not insurmountable. If you plan ahead and collect the necessary information before you begin, the installation process is much easier. Be sure to select Custom installation.

After you select Custom installation for Windows NT v4.0, you will be given the following installation options:

- Set Up Only Components You Select
- Set Up Network
- Set Up Local Printer
- Set Up Applications on the Hard Disk
- Gathering information about your computer
- Installing NT networking
- Finishing Setup.

For modular installation, enable the Set Up Only Components You Select and Set Up Network options and disable the others so you will be able to install printer support and set up applications later.
Storage Device Detection

During the Hardware Setup phase, the Windows NT installation program displays a list of mass storage devices found on your computer. This list includes SCSI adapters and CD drive devices but does not include IDE components. Do not worry—IDE devices are indeed recognized and will be supported by the installation.

Gathering Configuration Information

Prior to installation obtain the following information from your System Administrator:

- Computer name (for each machine)
- IP address (for each machine)
- Subnet mask
- Default Gateway
- Workgroup
- Domain
- DNS (Domain Name System) service search order
- WINS servers, if applicable
- FEMIS server name
- FEMIS server IP address.

If this information is unavailable from the System Administrator, it can be determined by using the steps below to check a previously installed machine—provided one is available. It is important that you have this information prior to installation. This information allows you to setup your NT Networking.

4.1.1.2 Running the Installation Program

**Note:** Before you install Windows NT from the FEMIS COTS CD, read Section 4.1.1.1, Before Installing Windows NT.

**Note:** You will need to know the 10-digit CD Key number to enter during the Windows NT installation. The CD Key number is located on your licensed Windows NT installation disk.

**Note:** The CD drive is usually your D:\ drive and will be referred to as the D:\ drive in the following instructions.

1. Place the FEMIS COTS CD into the CD drive, and enter \V386\WINNT /B at the C:\ prompt.

   **Note:** Be sure to include /B or you will be prompted to insert three formatted disks.

2. At the D:\ prompt, enter \V386, and the Windows NT Setup window will be displayed. Please wait while Setup copies files to your hard drive.
3. Restart the computer and continue with the Windows NT Setup.

4. Press Enter to continue setting up WINNT per the Welcome window that displays.

5. Press Enter to continue installation. Windows NT Setup displays a list of mass storage devices found on the computer. This list includes SCSI adapters and CD drive devices but does not include IDE components. The <SCSI Adapter> and <CD drive devices> will display. This indicates that Setup has recognized mass storage devices in the computer.

6. Page down and select F8 to agree when the Windows NT Licensing Agreement window displays.

7. Press Enter to continue when the Windows NT Setup displays the computer's hardware and software components.

8. Install Windows NT on the highlighted partition <C:FAT>.

9. Setup will install Windows NT on the partition. Leave the current file system intact (no changes).

10. Setup will install WINNT files on the hard disk. Choose the location where you want these files to be installed, a common location is WINNT.

11. Setup can also examine the hard disks for corruption.

   - To allow Setup to perform an exhaustive secondary examination, press Enter.
   - To skip this step, press the Esc key.

   Though this is not necessary and takes several minutes, we recommend you complete this step.

12. Restart the computer once this portion of the Setup has completed successfully.

The Windows NT Setup is gathering information about the computer. Advanced users can customize all available setup options. You will be prompted regarding the next three parts of the Setup: 1) Gathering Info, 2) Installing Windows NT Networking, and 3) Finish Setup.

Part One of Setup—Gathering Info


14. Enter the name and organization associated with the computer. Click Next to continue.

15. Enter the 10 digit, CD Key. The Windows NT registration number is located on the back of the Windows NT CD cover.

16. Enter the computer name.
17. Enter the Administrator password for the Windows NT Administrator account. Repeat this step to confirm the password.

18. Create at least two Emergency Repair disks for each type of computer on which Windows NT v4.0 is being installed.

   - Select Yes to create an Emergency Repair disk
   - Select No if you do not want to create an Emergency Repair disk.

19. Click Next to continue.

20. Click Next to accept the default list of components on the Select Components window that displays.

Part Two of Setup—Installing Windows NT Networking

21. Select 2. Installing NT Networking. Click Next to continue.

22. Click Next to continue and accept the defaults: This computer will participate on a network and Wired to the network.

23. Select Start Search to allow Setup to locate the default network adapter. Once the default network adapter has been located click Next to continue.

24. Select TCP/IP Protocol for the networking protocols that are used on your network. This is the protocol used to connect to the Internet and Wide Area Networks (WANs). Check with your System Administrator to see if any additional protocols should be selected. Click Next to continue.

25. Click Next to accept the default—All Network Services. Install the selected components

   - RPC Configuration
   - NETBIOS Interface
   - Workstation
   - Server

   Click Next to continue.

26. Check with your System Administrator about special settings that may be required for the network adapter card and in addition to host name resolution. If there are none, accept the default values associated. Click Continue.

27. Select use Network Parameters, even if they cannot be verified.

28. Click No to use DHCP on the TCP/IP Setup Window that displays.
29. Enter the IP Address, Subnet Mask, and Default Gateway values specified by your System Administrator.

30. Check with your System Administrator to see if the domain is required for Domain Name System (DNS). Select the DNS tab, and enter the domain, if required. The Hostname will have been entered by default when the computer was named. If necessary, select Add DNS Search Order.

31. Select Add Primary and Secondary WINS Servers, if required, for the Windows Internet Name Services (WINS).

32. Accept the default—Enable LMHOSTS Lookup. Check with your System Administrator to see if this is required.

33. Enable DNS lookups, if required. Check with your System Administrator regarding DNS setup configuration.

34. Check with your System Administrator to see if Routing is required. Click the Routing tab, and enable the IP forwarding. Click Apply and OK to continue.

35. Accept the defaulted network components that will communicate using this protocol. Check with your System Administrator to see which items should be selected. The Show Bindings window will display.
   - Click Next to accept the default—All Services.
   - Click Next again to start the network.

36. Select Workgroup, and enter the value.

Part Three of Setup—Finish Setup

37. Select 3. Finishing Setup. Click Finish to continue.

38. Select the appropriate Time Zone, and check Automatically adjust clock for daylight savings time on the Date and Time Properties window that displays. Click Close to continue.

39. Accept the default if the system found a video adapter for the computer. Click OK to continue.

40. Select Test to preview settings from the Display Properties window that displays. If the size and number of colors for the computer's display do not match the settings below, change them to match the following.

   Color palette — 65536 colors
   Desktop Area — 800 x 600 pixels
   Font — Small font
   Refresh Frequency — 72 Hertz
The new mode will be tested. Click OK and wait 5 seconds to determine whether it works properly. Click Yes and OK to continue.

41. Restart the computer for Windows NT to setup and save the previous choices. Select Windows NT4.0 as your operating system. Press Enter to continue.

4.1.1.3 Installing Windows NT Service Pack 4

The Windows NT v4.0 Service Pack 4 is needed to successfully run FEMIS and the time resynchronization services that FEMIS installs.

To install Windows NT Service Pack 4, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login into Windows NT as Administrator.

2. Close any open applications.

3. Start Windows NT Explorer, browse to D:\NT4SP4\UPDATE.

4. Run UPDATE.EXE.

5. Click to accept the Software License Agreement.

6. Check the option to backup your current files to uninstall the Service Pack at a later time. This requires more disk space.

7. Click Install to install the Service Pack.

8. Click Restart to restart the computer.

When the system restarts after the installation is complete, it may inform you of Y2K updates needed for any of the following software:

- Microsoft Internet Explorer 4.01 Service Pack 1
- Microsoft Data Access Components 2.0 Service Pack 1
- Microsoft Site Server Express 3.0

If you received the message about Y2K updates needed, run the Y2K updates by completing the following steps.
Note: If you run the Y2KSETUP.EXE, it will upgrade your current Microsoft Internet Explorer to v4.0. This process is time consuming, and if you do not use Internet Explorer, you may want to remove Internet Explorer before proceeding.

1. Click Start → Run → Browse → D:\Program Files\Internet Explorer\Y2KSETUP.EXE
2. Restart the PC.

4.1.2 Installing an NFS System

For FEMIS v1.4.6, you may install either NFS Maestro v6.1 or Solstice NFS Client v3.2 for your NFS System.

**CAUTION**

Do not install an NFS system until after you have completely installed Windows NT, including the network setup.

Note: If NFS Maestro v6.0.1 or earlier was previously installed on the PC, it must be removed before you install NFS Maestro v6.1 or Solstice NFS Client v3.2

4.1.2.1 Uninstalling NFS Maestro v6.0.1 (or earlier)

Complete the following steps to remove NFS Maestro v6.0.1 (or earlier) and migrate to NFS Maestro v6.1 or Solstice NFS Client v3.1+. To verify the version that has been installed, go to Start → NFS Maestro → Share Editor → Help → About Share Editor. If NFS Maestro has not been installed on the PC, skip this section.

1. Click Start → Programs → NFS Maestro → Uninstall.
2. Click Yes on the NFS Maestro Client – Uninstall window. The default radio button is set to Remove completely from Systems for all Users.
3. Click Yes when prompted to remove the directories.
4. Click Yes “I Agree” on the License Agreement window.
5. Click Yes to restart the computer.
4.1.2.2 Installing NFS Maestro v6.1

Note: To install NFS Maestro v6.1, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login into Windows NT as Administrator.

2. Click Start → Run → Browse → D:\MASTRO61\SETUP.EXE. Click Open and OK.

3. Click Next on the Close Any Open Applications window.

4. Click Custom Installation.

5. Click Yes to Allow All Users of this Machine to See this Installation.

6. Specify the Maestro Home directory. Click Next to accept the default C:\PROGRAM FILES\MAESTRO.NT.

7. Specify the Maestro User directory. Click Next to accept the default C:\PROGRAM FILES\MAESTRO.NT\USER.

8. Deselect all the default components—especially the Jconfig Daemon because it will cause problems later.

9. Select and install All NFS Client Related Components. Click Finish to begin your Maestro installation.

10. Click the Skip button on the Site Information window. Click Finished.

11. Click Yes to create a shortcut on your desktop—this is optional. Click Next to continue.

12. Check the TCP box, and verify the following are selected on the Client Configuration window:

For User and Group, R W X (Read, Write, and Execute)
For Other, R X (Read and Execute)

Increase the Read and Write sizes to maximum (32K).

Click OK to continue.

13. Click OK once the installation is complete.

14. Click Yes to restart the computer. Login to Windows NT.
15. Select Continue and run the remote server to test using these parameters:

- Remote Host: <servername>
- FileSystem: <serverpath>
- UserName: <femis>
- Password: <password>
- Select TCP, and click OK to continue.

This program takes from 10 to 15 minutes to run. Accept the best transfer rate.

### 4.1.2.3 Installing Solstice NFS Client v3.2

For an upgrade or new installation of Solstice NFS Client v3.2 on a PC, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login into Windows NT as Administrator.
2. Run the SOLSTICE\SUNWFILE.EXE program on the COTS CD.
3. Enter your Solstice NFS Client v3.2 serial number on the User Information window.
   
   **Note:** If you are upgrading, your old serial number will display but might not work. If you select Evaluation, your product will expire in 30 days, and FEMIS will not work correctly.

   Click Next to continue.
4. Click Yes to continue on the Registration Confirmation window.
5. Accept the default installation directory on the Choose Destination Location window, and click Next to continue.

   If you are upgrading from Solstice NFS Client v3.1+, click OK for the setup to upgrade your current installation.
6. Select Typical installation on the Setup Type window that displays, and click Next.
7. Click Next to configure the software on the Setup Configuration Wizard window.
8. Click Next to accept the Windows Default Name Service.
9. Click Next to start copying files. If prompted, click Yes to overwrite read only files.
10. Select No, I will restart my computer later. Click Finish.
To properly configure Solstice, complete the steps in the following section, Configuring Solstice NFS Client v3.2.

4.1.2.4 Configuring Solstice NFS Client v3.2

To configure Solstice NFS Client v3.2, complete the following steps:

1. Click Start -> Settings -> Control Panel -> Network -> Services tab.

   If this is a new installation, you will need to click Add, select the Solstice NFS Client, and click OK.

2. Select the Solstice NFS Client on the Services tab, and click Properties.


4. Select Read, Write, and Execute for the User and Group on the Default File Creation Permissions section. For Other, only select Read and Execute.

5. Select the Use a Specific Authentication Server, and enter your EOC’s server. Click OK and Close the Network window.

   Note: The server needs to be running the Solstice pcnfsd daemon. See Section 2.1.2.4, Installing Sun PC NFS Daemon.

6. Click Yes to restart the computer now.

   Note: When the computer restarts and is logged into the network, the Solstice NFS Client will try to validate the user name and password on the authentication server that was entered in Step 6. If the user does not have an account on this server or passwords on the PC and server are not the same, you will be prompted for a user name and password for Solstice NFS Client as well as your NT workstation login.

4.1.3 Installing or Upgrading Oracle SQL*Net v2.3.4 and ODBC v2.5.3

To install or upgrade Oracle SQL*Net v2.3.4, insert the FEMIS COTS CD into the CD drive, and perform the following steps:

1. Login into Windows NT as Administrator.

2. Click Start -> Run -> Browse -> D:\orainst\SETUP.EXE. Click Open and OK.

3. Accept English as the language.

4. Enter the appropriate company name in the Oracle installation settings window.
5. Select Custom Installation from the Oracle 7 Server Workgroup window. Click OK to continue.

6. Double Click on + (All Products) to reveal the products list.

7. Double Click on + Oracle Networking Products.

8. Select the following products by using the Ctrl key function:
   - Oracle Installer 3.2.2.1.0A
   - Oracle SQL Net Client 2.3.4.0.0
   - Oracle 7 32 bit ODBC Driver 2.5.3.1.0B

9. Select Install in the center of the Installer Window.

10. Click OK on the Installation Completed Successfully window.

11. Verify the following products have been installed and displayed in the right hand window:
   - Oracle Installer 3.2.2.1.0A
   - Oracle Named Pipes Protocol Adapter 2.3.4.0.0
   - Oracle TCP/IP Protocol Adapter 2.3.4.0.0
   - Oracle Trace Collection Services 7.3.4.0.0
   - Oracle 7 32 bit ODBC Driver 2.5.3.1.0B
   - Required Support Files 7.3.4.0.0
   - SQL Net Client 2.3.4.0.0

12. Exit the Oracle Installer.

13. Restart the computer.

**4.1.4 Installing ArcView GIS v3.0 and v3.0a Patch**

**Note:** If you reinstall ArcView GIS after having already installed FEMIS, the correct version of the file DEFAULT.APR will be overwritten by the ArcView GIS installation. Copy the DEFAULT.APR file from your C:\FEMIS directory to the <DRIVE>\ESRI\ArcGIS30\ArcView\ETC directory on the PC. If you cannot find C:\FEMIS\DEFAULT.APR, then the file may be copied from /home/femis/pc/femmisc/ on your server.

**Note:** ArcView GIS v3.0 must be installed on the computer before you install the v3.0a patch, and the patch must be installed for FEMIS to work properly.

If an older version of ArcView GIS is currently on the PC, remove it before installing ArcView GIS v3.0.
Note: If more than one version of ArcView GIS is installed on the PC, FEMIS will find the most recently installed version. If you have multiple versions of ArcView GIS installed, check the \%windir%\FEMIS.INI file after the FEMIS installation is complete to make sure that the file reference the correct installation.

4.1.4.1 Installing ArcView GIS v3.0

You will need to have the ArcView GIS license number for this installation. The CD key number is located on the ArcView GIS installation disk.

To Install ArcView GIS v3.0, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login to Windows NT as Administrator.
2. Click Start → Run → Browse → D:\AV3.0\SETUP.EXE. Click Open and OK.
3. Click Next on the Close Any Open Applications window.
4. Select Custom, and click Next to continue.
5. Deselect the Map data. Click Next to accept the default destination directory.
6. Click Next to accept the defaults for Program Folders and Existing Folders. The Start Copying Files window displays.
7. Verify the program files, extensions, and help files are displayed in the Current Settings window that displays.
8. Click Yes and Finish on the Setup Complete window to restart the computer.
9. Click Start → Programs → ESRI → ArcView GIS version 3.0 → ArcView GIS version 3.0.
10. Enter the name and organization and the ArcView GIS license number.
11. Click OK, and ArcView GIS will start. Click File → Exit to close.

4.1.4.2 Installing ArcView GIS v3.0a Patch

ArcView GIS v3.0 must be installed before installing ArcView GIS v3.0a. To Install ArcView GIS v3.0a patch, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login to Windows NT as Administrator.
2. Click Start → Run → Browse → D:\AV3.0\AV30A.EXE. Click Open and OK.
3. Click Yes to continue the installation of ArcView GIS v3.0a Patch.

4. Click Next on the Close Any Open Applications window.

5. Click Next to accept the default Local Install.

6. Click Next to accept the default destination location.

7. Click Next to accept the defaults for Program Folders and Existing Folders.

8. Click Finish on the Current Settings window that displays.

9. Click Finish to continue the installation after the files have been copied on the Start Copying Files window.

10. Click Finish and the installation is complete.

### 4.1.4.3 Creating the ArcView GIS Icon for All Users

During the FEMIS installation, make sure that you set up the ArcView GIS icon for **ALL Users**. If you do not create an icon for All Users (one per session), the icon will not show up when other users logon.

ArcView GIS will be available to all users by completing the following steps:

1. Establish the following path using Windows NT Explorer: `C:\WINNT\PROFILES\ALL USERS\START MENU`.

2. Establish a second path: `C:\WINNT\PROFILES\ADMINISTRATOR\START MENU\PROGRAMS`. Drag the ESRI folder to the path established in Step 1 from the path established in this step (`C:\WINNT\PROFILES\ADMINISTRATOR\START MENU\PROGRAMS`). The ESRI icons will be displayed on the Desktop → Start → Programs.

### 4.1.5 Installing Microsoft Project 98 Service Release 1

If a previous version of Microsoft Project has been installed, completely uninstall the previous version before completing this installation.

You will need to have the Microsoft Project license number during the installation. The CD key number is located on your licensed Microsoft Project installation disk.

To install Microsoft Project 98 Service Release 1, insert the FEMIS COTS CD into the CD drive, and complete the following steps:
1. Login into Windows NT as Administrator.

2. Click Start → Run → Browse → D:\msp9\sr1\SETUP.EXE. Click Open and OK.

3. Select Continue on the Close Any Open Applications window.

4. Enter the name and organization information. Click OK.

5. Click OK to confirm the name and organization.

6. Enter the Microsoft Project CD key number.

7. Click OK to acknowledge the Product ID.

8. Accept the default destination folders.

9. Click Custom Install.

10. Click Data Access and Change Option. Select the Database Drivers Utility option, and click OK to continue.

11. Click Continue to begin copying files.

12. Click OK when the installation is complete.

4.1.6 Installing Other COTS

The following COTS products should be installed using the installation documentation for each product.

E-mail application (if desired)
Use the standard product installation notes provided with the software.

Word processor (if desired)
Use the standard product installation notes provided with the software.

Spreadsheet (if desired)
Use the standard product installation notes provided with the software.

Graphics Presentation (if desired)
Use the standard product installation notes provided with the software.
4.2 Configuring the FEMIS Setup Program

CAUTION

Configuration is only done once at each EOC. Stop PC installation until all configuration has been performed.

Several other files must be configured for your site or EOC. Most of these files should have been configured during the FEMIS UNIX installation but should be validated before installing the FEMIS application on the PCs.

Note: Directories specified below are from the PC. You will need to use the UNIX version of these directories if you are editing files from the UNIX server.

4.2.1 Connecting the Network Install Drive

To connect the FEMIS network drive to the install directory, complete the following steps. The parts in italics are what should be changed.

1. Obtain the path of the FEMIS account home directory from your System Administrator.
   Example: /<file system>/home/femis

2. Open the Windows NT Explorer.

3. Select Tools → Map Network Drive menu option, and the Connect Network Drive window appears.

   If the PC is using NFS Maestro, using the following:

   Drive: 1:
   Path: <server name>\<file system>\home\femis
   Connect as: femis
   Enter <network password> when prompted.

   If the PC is using Solstice NFS Client, using the following:

   Drive: 1:
   Path: <server name>\<file system>\home\femis
   Connect as: femis
   Enter <network password> when prompted.

The FEMIS network drive will be displayed in the All Folders pane on the left side of the Windows NT Explorer window.
4.2.2 Validating l:\CONFIGD\FSETUP.INI File

The FEMIS Setup program uses a configuration file to determine the defaults for the installation. Validate that the l:\CONFIGD\FSETUP.INI file was correctly configured during the server installation.

The [Setup Defaults] section of FSETUP.INI should contain at least the following entries:

- Site=<site_code> Default site code. This should be your site code in upper case, e.g., ANAD
- EOC=<eoc_code> Default EOC code. This should be your EOC code in upper case, e.g., AEMA
- DestDir=<directory> Default FEMIS installation directory, e.g., C:\FEMIS\%

This section may contain other entries as well. For more information on how to set the defaults in this file, see Section 2.3.7.1, Editing the /home/femis/configd/fsetup.ini File.

4.2.3 Validating l:\CONFIGD\HOSTS File

The HOSTS file should be configured with the correct host names and IP addresses. This file should be a copy of /etc/hosts on the UNIX system. This file must contain an entry for the FEMIS server used by your EOC, and should contain entries for each of the FEMIS servers for your site.

Note: The setup program will not copy the HOSTS file to a PC if that PC already has a HOSTS file. See Section 2.3.7.2, Updating Windows NT User Accounts, if you need to update the HOSTS file on all of the PCs that will be running FEMIS.

4.2.4 Validating l:\CONFIGD\TNSNAMES.ORA File

The TNSNAMES.ORA file should be configured with the correct database names, listeners, and IP addresses. This file should be a copy of /TNS_ADMIN/TNSNAMES.ORA on the UNIX server. For each listener on each server, it should contain a section like the following. The parts in *italics* are what should be changed. (see Section 2.3.3.2, Installing the Oracle Software, Step 10 to edit the var/opt/tnsnames.ora file):

```
fl_cottoo =
    (DESCRIPTION =
        (ADDRESS_LIST =
            (ADDRESS =
                (COMMUNITY = TCP)
                (PROTOCOL = TCP)
                (HOST = ctoosun.utah.gov)
                (PORT = 1521)
            )
        )
    )
    (CONNECT_DATA =
        (SID = fl_cottoo)
    )
)
...```
Note: The setup program will not copy the TNSNAMES.ORA file to a PC if that PC already has a TNSNAMES.ORA file. See Section 2.3.7.2, Updating Windows NT User Accounts, if you need to update the TNSNAMES.ORA file on all of the PCs that will be running FEMIS.

4.2.5 Validating I:\CONFIGD\ADDODBC.BAT File

FEMIS uses the I:\CONFIGD\ADDODBC.BAT batch file to add all the necessary ODBC data source names to each PC. Verify that the mapping from EOC code to listener ID is correct for each line.

If any changes are made to this file, the modified file needs to be copied to the I:USER directory, and the I:USER\FUP_ODBC.BAT file needs to be updated. This propagates the updates to the other PCs.

4.2.6 Validating the AUTOEXNT.BAT File

During the installation process, the AUTOEXNT.BAT file is copied to the %windir%\system32 directory, usually C:\WINNT\SYSTEM32. This file should contain the following commands. The <TEMPLATE_HOSTNAME> is what should be changed.

```
net stop NetWorkTimeProtocol
%windir%\system32\ntpd -b TEMPLATE_HOSTNAME
net start NetWorkTimeProtocol
```

Where <TEMPLATE_HOSTNAME> is the name of the UNIX server from which the PC normally synchronizes time. The AUTOEXNT.BAT file is invoked at boot up. Its purpose is to synchronize time on the PC while bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC to be the same as on the UNIX server. After boot up, the usual NTP algorithms apply.

4.2.7 Validating I:\PC\NTP\NTP.CONF File

During the installation process, the NTP.CONF file is copied to the %windir% directory, usually C:\WINNT.

The NTP configuration file on the PC should contain at a minimum one drift file and one-or-more server directives. The format of the drift file directive is driftfile %windir%\ntp.drift, where %windir% usually is C:\WINNT.

The format of the server directive is server <hostname>, where hostname is the name of the UNIX server from which the PC is to acquire time synchronization. Generally, this is the UNIX computer located on the same Local Area Network (LAN) as the PC. PCs should acquire time synchronization first from the closest UNIX computer and not from some distant host on the WAN or the Internet. Distant hosts can be used as a secondary time synchronization source. To designate the primary NTP host, include the keyword, prefer, in the server directive.
As an example, the following NTP.CONF file is the preferred format for NTP configuration. It lists the local UNIX server as the preferred time server and the other (far away) servers as secondary. In this manner, if the preferred host is inaccessible, one of the secondary servers can provide time synchronization:

```
server <IP address of UNIX server> prefer
server <IP addresses of other servers on WAN>
server <IP address of server on the Internet>
driftfile C:\WINNT\ntp.drift
```

The Network Time Protocol service is very sensitive to the format of this file. Occasionally, in transferring this file from between UNIX and Windows computers, extra carriage return characters will be appended to the end of each line in this file. These extra characters are not detectable in a PC editor, but show up as "^M" characters at the end of each line in a UNIX editor, such as VI. These extra characters at the end of a line with a server directive will prevent the Network Time Protocol service from loading correctly. If the Network Time Protocol service does not appear to be working, this should be checked.

For more details on NTP set up and configuration methods, see Section 12.0, Server Network Time Protocol (NTP) Set Up, in the FEMIS System Administration Guide.

### 4.2.8 Validating \i:\USER Directory

Because the Oracle connect information is stored on an Windows NT-user by NT-user basis, several batch files are used to patch each Windows NT user account. The correct values must be verified for any new Windows NT user account (see Section 2.3.7.2, Updating Windows NT User Accounts).

Verify the following files are located in \i:\USER directory.

- ADDODBC.BAT
- FUP_ODBC.BAT
- FUPDATE.BAT
- ODBCSUB.BAT
- PFEMIS.BAT
- WRITEREG.EXE
- WRITEINI.EXE

### 4.2.9 Configuring the \i:\PC\FEMTOOLS\FEMIS.DB File

To configure the servers and routers to match your network configuration, you will need the server names for all EOCs at the site.
Connect your \:\ drive to \(\text{server}\)/home/femis/ in Windows NT Explorer.

1. Delete or rename the existing l:\PC\FEMTOOLS\FEMIS.DB to something else, such as l:\PC\FEMTOOLS\FEMIS_DB.OLD.

   Note: If the old FEMIS.DB file is not renamed, and its attributes are set to read-only, then WS_WATCH.EXE will not be able to save the new configuration you create, but it will not give any indication of an error.

2. Run l:\PC\FEMTOOLS\WS_WATCH.

3. Select Edit \(\rightarrow\) Add \(\rightarrow\) Host. An icon will display. Position the icon where you want it.

4. Click once on the new host, and the host information window displays. Enter the following information.

   Display Name: <server name>
   Address/Name: <server name>
   System Type: <server or router>
   Type: TCP/IP

5. Click Accept.

   Note: Repeat Steps 2 through 4 for all servers.

6. Select END_EDIT, File \(\rightarrow\) Save As, and enter the following:

   l:\PC\FEMTOOLS\FEMIS.DB

7. Exit WS_WATCH.EXE.

4.3 Installing FEMIS Client Software

This software is for the PC workstations that are connected to the FEMIS data server and contains the FEMIS client software and a collection of GIS theme files. The installation program for the FEMIS client software assumes the necessary COTS packages have already been installed.

The FEMIS client software is installed over the network from a UNIX server. The client software contains over 120 files representing approximately 35MB of file space.
The FEMIS executable and other FEMIS support files will be loaded to the following locations:

- In the current \%windir\% directory, usually C:\WINNT.
- In the \%windir\%\SYSTEM32 directory.
- In the C:\FEMIS directory.
- In the Microsoft Project directory.

All files needed by the installation process should have previously been copied from the release tape or CD to the server. The files specified in Section 4.2, Configuring the FEMIS Setup Program, should have been configured or validated before the FEMIS client software is installed.

4.3.1 Preparation

To prepare for starting to install FEMIS v1.4.6, complete the following steps:

1. Login to Windows NT as Administrator or to a Windows NT account that has Administrator privileges. Setup will abort if it is run from a Windows NT account that does not have Administrator privileges.

2. Verify that all COTS needed by FEMIS are installed on the PC. At the minimum, the following should be installed (the Setup program will also verify that these are installed). You should also consult the FEMIS Bill of Materials (BOM) and verify that the correct versions of the software products are installed.
   - Microsoft Windows NT
   - Oracle ODBC
   - Oracle SQL*Net
   - Hummingbird NFS Maestro or Sun Solstice NFS Client
   - ESRI ArcView GIS

4.3.2 Running the Setup Program

The FEMIS Oracle database on the UNIX server must be operational before the setup program is run.

1. Close all programs that are running, especially all FEMIS programs, including KeyPrint.

2. Connect your l:\ drive as specified in Section 4.2.1, Connecting the Network Install Drive, if you have not already done this.

3. Run the l:\PC\SETUP\SETUP.EXE program. The setup will bring up several windows that require your response.
Select Site and EOC: This allows you to select the Site and EOC from drop-down lists. The contents of the lists are controlled by the \PC\SETUP\FSETUP.INI file.

Select Components: This allows you to select which FEMIS components will be installed. The GIS and Additional Icons components have options that are accessed by highlighting the component and clicking the Change button.

Select Program Folder: This allows you to specify which folder in the Start menu will be used for the FEMIS icons. The default is FEMIS.

Choose Destination Location: This allows you to specify the drive and directory where FEMIS will be installed. If FEMIS has previously been installed on the PC, the default is the last place where FEMIS was installed. If this is the first time FEMIS has been installed on the PC, the default location is C:FEMIS.

GIS Data Path: This allows you to select a destination for the GIS files. The default location is C:FEMIS\GIS<site code>.

Note: You may see improved performance from the FEMIS GIS if you choose to install the GIS on a separate physical disk than the one on which you are installing FEMIS, or on the same physical disk but on a separate partition.

Start Copying Files: This displays an information window showing the options that have been selected. Select Next to begin copying files.

4. The next part of the Setup program will take several minutes to configure the PC. You may receive prompts or setup may wait for confirmation before performing some items. Watch and click OK or press Enter, as needed. These configuration operations will

- Update the FEMIS.INI for the PC name, FEMIS and GIS directories, and COTS paths.
- Open ArcView to convert the FEMISGIS.INI file to v1.4.6 format (if applicable).
- Open ArcView to regenerate the FEMISGIS.APR file.

Note: When the FEMISGIS.APR is generated, the system checks to see if any private GIS ViewMarks exist in the VIEWMARK.ODB file in the M:SITCODE\USERCODE\GIS\VIEWMARKS directory. If a file exists, it is assumed valid and will be used so that no old ViewMarks are lost. If no VIEWMARK.ODB file exists, a new file is generated with only one default ViewMark. This same check process is repeated for the shared ViewMarks.
- Update the FEMISDB.INI for the default EOC database selected.
- Add ODBC information for the FEMIS databases.
- Update the NTP.CONF to have the correct paths.
- Start the NTP service to synchronize time on the PC with the server.
- Create the C:\WINNT\SYSTEM32\AUTOEXNT.BAT file.
- Set the system to use FEMIS’s own GLOBAL.MPT file with Microsoft Project.
- Remove obsolete files from older FEMIS installations.
- Verify the required COTS packages are installed.
- Add FEMIS environment variables, if needed.

5. Select Yes, I want to restart my computer now. on the Setup Complete window. Click Finish.

6. Log back in as Administrator after the computer restarts.

4.3.3 Verifying the GIS .INI files on the Server (Maryland Only)

The Maryland GIS has one set of INI files (small, medium, and large) for each EOC. Each of the other sites has one set that is used by all EOCs. Consequently, an extra step is necessary in Maryland to ensure that the correct set of INI files are in place before installing FEMIS to the PCs.

The /home/femis/gis/sbcc_apr directory on the server is where Setup will look for the INI files. This directory has a subdirectory for each EOC that contains the three INI files. Before running Setup on the PCs, log onto the server as the user femis and copy the files from the subdirectory for your EOC. For example, at the MEMA EOC, you would log onto the server and enter the commands

```
%cd /home/femis/gis/sbcc_apr
%cp . /mema*/ .
```

4.4 Configuring the PC

4.4.1 Setting Up FEMIS User Accounts on Windows NT and UNIX

For Windows NT to be able to connect to the required FEMIS drives located on the FEMIS server, a UNIX user account on the FEMIS server must be created for each Windows NT user account that will be used to run FEMIS. Each of these UNIX user accounts must have the same username and password as its corresponding Windows NT user account. These are separate from the usernames and passwords that are used to log into the FEMIS application. The usernames and passwords used to log into the FEMIS application do not need to match the UNIX or Windows NT usernames and passwords.

**Note:** Both of the Windows NT and UNIX user accounts must have the same username and password so that network drives can connect correctly. Windows NT and UNIX usernames and passwords are case sensitive. For example: JSmith and jsmith will not work.
You can set up individual user accounts (such as jsmith) on one or on all of the PCs and the FEMIS server. Positional accounts (such as sheriff) can be set up on one or all of the PCs and the FEMIS server. One global (such as femisuser) can be set up on all of the PCs and the FEMIS server, or some other combination.

Note: Setting up and maintaining individual or positional accounts on all of the PCs and the FEMIS server can be time consuming, especially if you have many accounts and many PCs. If the password is changed for an account on one PC, it must be changed on all the others so they can all still connect to the network drives correctly.

4.4.1.1 Adding User Accounts to Windows NT

To add a Windows NT user account on a Windows NT PC, complete the following steps.

1. Click Start → Program → Administrative Tools → User.

2. Select New User and fill in the following fields on the User Manager window:
   - Username:
   - Full Name:
   - Description:
   - Password:
   - Confirm Password:

3. Check with your System Administrator to determine which of the following options should be checked.
   - User must change Password at Next Logon
   - User cannot change Password
   - Password never expires
   - Account disabled

After creating the Windows NT account, verify the following two items.

- The username and password entered are the same as those for this user on the UNIX server.
- The Windows NT account is at least in the Users group under the Groups button.

4.4.1.2 Adding User Accounts to UNIX

Refer to Section 2.1.1.2, Creating Users and Groups, for instructions on adding users to the UNIX server.
4.4.2 FEMIS Startup Files

FEMIS requires that several network drives be connected in order for all items to work correctly. Running the FSTARTUP.EXE program connects these drives, and this program should be run automatically when a user logs into Windows NT. Depending on how your network and PCs are set up, use one of the two methods listed below for the program to run automatically.

**Note:** Most sites should use Method 1 and only add the Windows NT user accounts that will actually be running FEMIS and have corresponding accounts on the UNIX server.

**Note:** If users will be logging into this PC using Windows NT domain accounts and running FEMIS, Method 1 will not work and you must use Method 2.

**Note:** If both FEMIS and EMIS are being installed on a single Windows NT account, you will need to edit the FEMIS.INI file. See Section 2.3.7.1, Editing the /home/femis/configd/fsetup.ini File, for details. This should be done once on the UNIX server before FEMIS is installed on the PCs.

**Method 1: As a User Login Script**

1. When the Setup program completes, select User Manager in Administrative Tools in the Program Manager or Start menu.

2. For every Windows NT user account that will use this PC to run FEMIS, select the user in the list. Then select the menu item Properties under User, and click the Profile button on the form that appears.

3. In the Logon Script Name field, enter FSTARTUP.EXE.

**Method 2: In Startup Folder**

1. Using Windows NT Explorer, open the C:\WINNT\PROFILES\ALL USERS\START MENU\PROGRAMS\STARTUP folder. From the File menu, select New -> Shortcut, and a Create Shortcut dialog box displays. At the Command Line, enter %WINDIR%\SYSTEM32\REPL\IMPORT\SCRIPTS\FSTARTUP.EXE, and click Next. Enter a name for the shortcut, such as FEMIS Startup Script.

2. Follow the steps later to verify that the icon is in the common Startup folder instead of a personal Startup folder.

Refer to Section 2.3.7.1, Editing the /home/femis/configd/fsetup.ini File, if you wish to customize the startup. You can specify additional drives to be mapped by the FEMIS startup script, and specify local startup scripts to be run after the drives have been mapped.
4.4.3 Verifying the Temporary Directory and Environment Variables

The GIS and other programs need a directory to store temporary files. Use the following steps to verify that this process was completed correctly by the Setup program.

1. The directory C:\TEMP should exist on the PC.

2. Click Start → Settings → Control Panel → System.


4. Verify there is a User Variable named TEMP (usually C:\TEMP). If not, enter TEMP in the Variable field and C:\TEMP in the Value field. Click Set.

5. Determine the directory where Oracle SQL*Net software was installed on this PC. (Usually C:\ORANT). Verify that in the System Variables box the ORACLE_HOME=something (usually C:\ORANT) is the correct directory where Oracle SQL*Net is installed. If not, select it and change the value in the Variable and Value text boxes, and click Set.

6. Verify that a FEMISSTOPDIR=C:\FEMIS\ (where FEMIS was installed) environment variable exists in the System Variables box. If not, select it and change the value in the Variable and Value text boxes, and click Set.

   Note: If you change anything, you must log out of Windows NT and login again for the changes to take effect.

7. Click OK to exit the System Configuration in the Control Panel.

4.4.4 Verifying the Clock Settings and Time Zone Settings

To set the date format preferences so that FEMIS can process the date correctly:

1. Click Start → Settings → Control Panel → Regional Settings.

2. Select the Date tab in the Regional Settings window.

3. Set your short date format order to dd-MMM-yy (Day - Month - Year).

4. Select the Time tab in the Regional Settings window.

5. Verify that you are either using a 24-hour clock (uppercase “H” in the Time Style field) or that you using a 12-hour clock (lowercase “h” in the Time Style field) set with the AM and PM Symbols are set to AM and PM (not case sensitive).
If time zone was not correct, select the Date/Time option from Control Panel. Select the correct time zone, and click OK.

4.4.5 Verifying the Time Synchronization Services

To verify the time synchronization services, the files and services discussed in the following sections should be verified.

4.4.5.1 Verifying the AUTOEXNT.BAT File

The AUTOEXNT.BAT file is located in the %windir%\system32 directory, usually C:\WINNT\SYSTEM32. This file should contain the following commands.

```
net stop NetWorkTimeProtocol
%windir%\system32\ntpd -b TEMPLATE_HOSTNAME
net start NetWorkTimeProtocol
```

Where `<TEMPLATE_HOSTNAME>` is the name of the UNIX server from which the PC normally synchronizes time. The AUTOEXNT.BAT file is invoked at boot up. Its purpose is to synchronize time on the PC while bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC to be the same as on the UNIX server. After boot up, the usual NTP algorithms apply.

**Note:** The batch file AUTOEXNT.BAT starts the Network Time Protocol service. Network Time Protocol should not be started automatically by the control panel. See Sections 4.4.5.2, Verify AutoExNT Service and 4.4.5.3, Verify Network Time Protocol (NTP) Service below.

4.4.5.2 Verify the AutoExNT Service

To verify that the AutoExNT service was installed and configured correctly, complete the following steps:

1. Click Start → Settings → Control Panel → Services.
2. Select AutoExNT. The Status should be blank, and the Startup should be Automatic.
3. Click Startup. Verify the radio buttons for Automatic, under Startup Type, and System Account, under Log On As, are selected. Also verify the checkbox to Allow Service to Interact with Desktop is checked.
4. Click OK and Close to return to the Control Panel window.
4.4.5.3 Verify the Network Time Protocol (NTP) Service

To verify that the Network Time Protocol (NTP) service was installed and configured correctly, complete the following steps:

1. Click Start ➔ Settings ➔ Control Panel ➔ Services.

2. Select Network Time Protocol. The Status should be Started, and the Startup should be Manual.

3. Click Startup, and verify the radio buttons for Manual (under Startup Type) and System Account (under Log On As) are selected.

4. Click OK and Close to return to the Control Panel window.

4.4.6 Verifying the Virtual Memory Setting

For FEMIS to run as efficiently as possible, the computer should be set to have at least 250MB (megabytes) of virtual memory. To check the virtual memory setting, and increase it, if necessary, complete the following steps while logged in as Administrator.

1. Click Start ➔ Settings ➔ Control Panel ➔ System.

2. Select Performance.

3. Click Change.

4. Increase the Maximum size (MB) to 250, if necessary click Set.

5. Click OK, click Close, and select Yes to reboot, if prompted.

4.4.7 Creating the FEMIS Icon

To make the FEMIS icon available to All Users, complete the following steps.

1. Open the C:\FEMIS directory using Window NT v4.0 Explorer.

2. Right click on the FEMIS.EXE file, and choose Create Shortcut.

3. Drag the shortcut to the desktop or to the C:\WINNT\PROFILES\ALL USERS\DESKTOP directory.

The FEMIS icon should be displayed on the desktop.

Note: If an icon or a shortcut is not created in the All Users profile, the FEMIS icon may not show up when another user logs on.
4.4.8 Final Steps for the FEMIS PC Installation and Configuration

Note: If this is an upgrade installation, you may wish to clean up old icons from the Program Manager. These may include old icons for the FEMIS program and old icons for running the startup batch files in the Startup group.

The following are the final steps for the FEMIS installation.

1. Log out of Windows NT.

2. Log into Windows NT as the appropriate user account. Run FEMIS.

3. Verify the installation of the first PC thoroughly by following Section 4.7, Validating the FEMIS PC Installation, before any more PC installations are started. If you must edit any of the configured files (e.g., ADDODBC.BAT, TN$NAMES.ORA), copy the corrected file back to the server and install again to be sure that it will work correctly.

4.5 Configuring FEMIS for All PCs at an EOC

The following validation steps need to be performed one time at each EOC. Since these configuration changes affect values stored in the FEMIS database for the EOC, they will take effect on all of the PCs using the same database.

4.5.1 Verifying the Zone Name Lookup for EMIS PAR

Note: If both of the following two conditions are true, you must complete this section:
1. You are currently installing FEMIS on an onpost PC.
2. EMIS is used onpost at your site.

Note: You can skip this section if you are upgrading from an earlier version of FEMIS, and you performed these steps when that version was installed.

Because EMIS allows users to change zone names at will, there is a possibility that FEMIS and EMIS zone names will not match exactly. It is important, however, for FEMIS to be able to map its zone names to the zone names used in EMIS so that Protective Action Recommendations (PARs) may be shared between the systems. For this reason, a simple utility named FZONES.EXE has been added to the list of system administration software tools available on the PC. This tool allows your FEMIS System Administrator to set up the EMIS zone name aliases so FEMIS will be able to correctly map PAR information sent from EMIS. If EMIS is part of the site configuration, then this utility must be run on the onpost FEMIS at installation and again whenever EMIS changes their zone names.
4.5.2 Using FZONES.EXE Tool

FZONES.EXE is a system tool that runs on the PC. Before you can run this tool, you will need to install at least one PC with system tools.

This tool displays a two-column spreadsheet of zone information. In the first column, there is a read-only list of FEMIS zone names. In the second column, there is a writable copy of the EMIS zone names. When you first start this utility, it will load the values currently in the database for the FEMIS and EMIS zone names. If at any time during the editing process you wish to reload the spreadsheet based on the values in the database, click the Reset Spreadsheet button.

To populate the FEMIS/EMIS zone lookup table, you will need to get a list of all the EMIS zone names for the site. This information may be found on the EMIS server in the following file: `/<disk>/emis3run/emisdyn/data/<site code>/emisgis/giszne.dat`. The `<disk>` and `<site code>` will be site specific. Once you have the EMIS list of zones, the simplest way to populate the lookup table is to run the FZONES utility, and then type the EMIS zone names directly in the spreadsheet next to the corresponding FEMIS zone name. When the spreadsheet is complete, click the Save button.

4.6 Guidelines for Updating All PCs at an EOC with New Files

Windows NT user accounts must be updated with batch files on all the PCs at an EOC. If files need to be updated in the future, general guidelines for updating files for all PCs are provided.

In case there is a need to update all the PCs with a new file (such as new GIS data files) all FEMIS PCs are configured to execute a batch file automatically if it exists in a specific directory on the server. This batch file can copy files as needed to update the PC.

The FSTARTUP.EXE program, which connects to the L:\ and M:\ network drives when a user logs into Windows NT, will execute a file named M:\FUPDATE.BAT (if such a file exists). This will allow your System Administrator to update all PCs by editing a batch file and then just logging into each PC.

**Note:** The M:\FUPDATE.BAT file should only be edited by your System Administrator.

A template called FUPDATE.TPL file will be in the l:\CONIF|G\directories. It uses the following structure to run an update only once per machine. Only running an update once is especially important if the update is copying large GIS data files that can take a long time to copy.

```bash
::**Do patch #1 if hasn't been done already.
set patchxx=%femistopdir%patches\patch01.bat
if exist %patchxx% goto SKIP_PATCH01
Echo ** ** MSG: Doing Patch 01
```
This method will allow you to edit the FUPDATE.BAT file so it can contain many patches and will only run those that need to be run on a PC.

4.7 Validating the FEMIS PC Installation

To run correctly, FEMIS software relies on many integrated components: the FEMIS database, commercial and government supplied software products, the FEMIS application, and system support services. Therefore, it is important to ensure that the FEMIS system is fully operational. This section will assist your System Administrator to validate that the FEMIS system has been properly installed and is operating correctly.

The FEMIS PC Validation Checklist, provided at the end of this section, includes items that need to be checked to ensure that the FEMIS system is operating properly. The Checklist correlates to the items listed below. These items are tested from the PC to ensure access and integration into the FEMIS application. This checklist provides a method to validate that the server and external communications are properly installed.

If problems are encountered during the validation, refer to Section 17.0, FEMIS Application Error Messages and Troubleshooting, in the FEMIS System Administration Guide for suggestions and guidance.

4.7.1 One Time at EACH EOC

The following validation steps must be performed one time at each EOC.

4.7.1.1 Verify the Database Connection

After logging into FEMIS, select the Operational mode button. Access the Current Info item under the Help menu. You should see the types of information associated with your operational information. Click on the Site and EOC Data tab to see how you are interfacing with the FEMIS system. The Tracking Navigator (Operational) window should display site and EOC data. By selecting different EOCs from the EOC drop-down list, the values and colors of the Tracking Navigator window should change, which validates FEMIS is connected to your EOC’s database and is receiving replicated information from other EOCs.
4.7.1.2 Verify Default D2PC Case Exists

On the Tracking Navigator (Operational and also for every previously created exercise) if a D2PC case description is displayed, click the “x” in the D2PC box to reset the current operational case to <none>. Click the D2PC button. A message should tell you there is no Operational case and a site default case is being used. Attempt to run the site default case.

Note: If the verification is successful, the following message is displayed: There is no current D2PC case selected. An attempt will be made to create a new case based on site defaults.

If the verification is not successful, the following message is displayed: There is no current D2PC case selected. You will need to create a site default D2PC case and repeat this verification step.

4.7.1.3 Verify the Evacuation Command Server

To verify the Evacuation Command server is working properly, you will need to import and run an Evacuation case. Evacuation cases are located on the I:\data\evac directory where I:\ is <server name>\home\femis. See the FEMIS Help for guidance on importing and running a case. Make it your current operational case (on the Evac main window, File → Make Case Current Operational).

4.7.1.4 Verify FEMIS/EMIS Data Exchange Interface (DEI)

Note: The definitive description of this interface can be found in Section 7.0, FEMIS Data Exchange Interface (DEI), in the FEMIS System Administration Guide.

Click the Status button in Operational mode and the select Met Condition. If the current meteorological (Met) data appears in the table, then the DEI is probably running.

4.7.1.5 Create a Plan for Validation Testing

To create a planning dataset that is shared so it can be used for PC validation, complete the following steps:

1. Change to Planning mode.

2. Choose Create New Shared Dataset from the Dataset drop-down list.

3. Name the new dataset, and click OK. The Tracking Navigator displays.

4. Click on Plan → Select Plan.
5. Click No on the message that states: Threat Area out of synch. Do you want AuOCalc to synchronize?

6. Select Basic Template from the Current Plan drop-down list, and click OK.

7. Click the New Data button.

From the Tracking Navigator, you will need to create a Protective Action Decision (PAD) and a Community Condition as part of this validation test.

Complete the following steps to create a PAD for the validation test.

1. Click on the PAD Function box and OK to the message box that displays.

2. Select the Edit radio button.

3. Click No on the message that states: Threat Area out of synch. Do you want AuOCalc to synchronize?

4. Create a new PAD by entering a name in the PAD Name field, and click OK.

5. Click the New Data button.

6. Click on Edit under Tasks, and click Yes on the first message box and OK on the second message box. Microsoft Project is displayed.

Complete the following steps to create a Community Condition for the validation test.

1. Click on the Community Function box and OK to the message box that displays.

2. Select the Edit radio button.

3. Create a new Community Condition by selecting Default from the Name drop-down list, rename it, and click OK and then Yes to create a new Community Condition.

4. Click the New Data button.

Complete the following steps to create a Validation plan.

1. Click on Plan → Copy Current Plan.

2. Enter a name for the new plan, and click OK.

3. Click on Plan → Select Plan
4. Click No to AutoCalc synchronization message that displays.

5. Select the plan name created in Step 2, and click OK.

6. Click the New Data button.

7. Click on Edit under Tasks, and click OK on the message box. Microsoft Project is displayed.

Complete the following steps to add a task in Microsoft Project.

1. Click on an empty row.

2. Click on the Task Details Form button (far left side of the toolbar).

3. Select items from the Agency and Stage drop-down lists, select the Times & Misc tab, and click OK → OK → Close. Click on FEMIS on the status bar to display the Tracking Navigator.

4. Click on Save under Tasks on the Tracking Navigator to save this plan, which will be used to Verify Electronic Planning (item 15 on the FEMIS PC Validation Checklist).

5. Click the New Data button.

4.7.1.6 Test the GIS on the Printer

Not all printers display graphics the same. For each printer to which you anticipate printing, use both KeyPrint and the Print option on ArcView GIS to print a GIS map that contains a D2PC case, Threat Area, Risk Area and one or more facilities under each. Review the printout to ensure that it prints graphics in such a way that:

- Risk and No Risk can be differentiated.

- One feature does not totally obscure an underlying feature (e.g., you can still see facilities located in the Threat Area, and the Threat Area does not wipe out the D2PC isopleths.).

4.7.1.7 Verify E-mail

Verify E-mail can be sent to users in all other EOCs.
4.7.1.8 Verify the SEPR Icon Addressee

Verify the addressee in the SEPR (Software Enhancement/Problem Report) icon file (only available with GroupWise E-mail) is the desired addressee for that EOC. Some EOCs want to compile/review the SEPRs before they send them to PNNL. Check the policy of the EOC and modify the SEPR template as needed. If they want it to go directly to PNNL, use ranata.johnson@pnl.gov (Ranata Johnson’s E-mail address).

4.7.2 Cleanup AFTER Validation

Note: Do not perform the following cleanup procedures until completing the validation steps in Section 4.7.3, Perform on EVERY PC.

After completing the above validations steps, the following cleanup validation steps need to be performed one time at an EOC, not on every PC.

4.7.2.1 Delete Validation Datasets

Delete the planning dataset created for validation in Section 4.7.1.5, Create a Plan for Validation Testing, as well as any other planning datasets that were created for the purpose of installation or validation.

4.7.2.2 Ensure Exercise #1 Exists

Ensure Exercise #1, or whatever Exercise is recognized by EMIS has been created. This will allow EMIS to communicate with FEMIS in Exercise mode.

4.7.2.3 Remove Extraneous FEMIS UNIX User Accounts

Remove extraneous FEMIS UNIX user accounts that were created during installation. Be sure to leave the one user account, authorized by your System Administrator that will be used during the Shakedown Test.

4.7.3 Perform on EVERY PC

The following validation steps should be performed on every PC.

Note: Login to Windows NT with Administrator privileges.

4.7.3.1 Ensure FEMIS Login Security

If the PC has a “femis” account under windows NT, make sure that the password is not set to femis.
4.7.3.2 Verify the PC Configuration

Verify each of the following items to make sure the PC's configuration is correct.

- FEMIS shortcut icon is on the desktop for all users.

- Icons left from previous installations of FEMIS but are no longer linked to a program should be removed from the Start → Programs → FEMIS folder.

- KeyPrint is in the Startup group for all users.

- Virtual memory maximum size is set to 250MB.

- The FEMIS startup file is called either in each user's profile or from the Windows NT Startup folder.

- System Environment variable FEMISTOPDIR is defined and set to C:FEMIS.

- System Environment variable ORACLE.HOME is defined and set to the directory where Oracle is installed, usually C:ORANT.

- The directory %ORACLE_HOMEBIN is included in the system path.

4.7.3.3 Verify the PC Clock

Verify the PC clock is using either a 24-hour clock or a 12-hour clock set to AM and PM. From Control Panel Start → Settings → Control Panel, click Regional Settings to verify your date format order is MDY (Month, Day, Year). Make sure you either are using a 24-hour clock (uppercase "H" in the Time Style field) or that you using a 12-hour clock (lowercase "h" in the Time Style field) set with the AM and PM Symbols are set to AM and PM (not case sensitive).

4.7.3.4 Verify the Network Time Protocol (NTP) Service

To verify the Network Time Protocol (NTP) will synchronize with the server for small variations in time when the PC is booted up, complete the following steps:

- Click Start → Programs → Administrative Tools → Event Viewer to the Event View window. Under the Log menu item, select Application. Check for warning or error messages (yellow or red icon) with NTP as the source. Troubleshoot as necessary.

- Verify the Network Time Protocol startup is set to Manual.
- Verify the fifth line of C:\WINNT\SYSTEM32\AUTOEXNT.BAT has been changed to read NTPDATE -b <hostname>, where <hostname> is the name of your UNIX server.

- Change the PC clock to a significantly different time (1 hour or more).

- Restart the PC (Start → Shut Down → Restart the Computer?).

- Login using a Windows NT account with Administrator privileges, and check that the PC time is correct after restarting the computer.

- Change the PC clock to be slightly different (5 to 10 minutes) from the UNIX server clock.

- Log off (Start → Shut Down → Close all programs and log on as a different user?). Do not select Shutdown the computer? or Restart the computer?

- Login to Windows NT with general user privileges.

- Watch the clock on the PC. You can watch the clock on the Windows taskbar (on the bottom of the main FEMIS window); or you can run the Windows Clock program to display a clock in a separate window by clicking Start → Run and enter CLOCK.EXE, and click OK.

Continue to monitor the clock. This process will take approximately 10 minutes for the PC clock to synchronize with the UNIX server clock. You can perform other tasks during this process.

If NTP does not appear to be functioning, try entering the command ntpq peers from a DOS prompt. This should return a list of the servers specified in the C:\%windir%\ntp.conf file. If this does not happen, see Section 4.2.7, Validating the I:\PC\XT\NTP\NTP.CONF File for more information on this file.

Note: Do not use Administrator privileges to perform the rest of the validation steps. You should already be logged in using general user privileges.

4.7.3.5 Verify Login

For Windows NT v4.0, check to make sure a shortcut to FEMIS exists.

- Validate the ability to access the FEMIS application by double clicking on the FEMIS icon.

- Confirm that the correct default Site/EOC is highlighted.

- Enter a valid usercode and password. The Select Mode window should display.

If there are Oracle problems with FEMIS from a particular Windows NT machine, check its path (Control Panel → System Environmental Variables). If there is an Oracle directory (i.e., S:\EMIS\DYN\ORANT\BIN) referenced that is not pointing to where FEMIS installed Oracle (either on

4-37
the C:\ or D:\ drive), then this portion of the path must be removed. Check with the other software vendors, as appropriate, to be sure this will not cause problems to their software.

- Verify that Operational mode works.

4.7.3.6 Verify Database Manager

Select Start → Programs → FEMIS → Database Manager to validate the access to the FEMIS Data Administration functionality. If the icon is not available, select Start → Run and enter C:\FEMIS\FDATAMGR.EXE.

4.7.3.7 Verify the System Administration Utility

Select Utility → System Utilities → System Admin from the main FEMIS menu bar to validate the access to the system administration functionality.

4.7.3.8 Verify D2PC

Complete the following steps to verify D2PC.

- Click the D2PC Function box on the FEMIS Tracking Navigator (Operational mode) window. Be patient while the initial connection is made to the D2PC application and the FEMIS database. D2PC should come up with a default case and be ready to run. Click Edit.

- Verify the Log Runs checkbox is checked and that you are in Edit mode. From the Run menu, select the Run Model item. You should quickly get a user interface window containing the results of the D2PC run.

- Save the D2PC case.

Note: Onpost users may get messages about sending the D2PC case offpost. Click Yes, and close the D2PC window.

4.7.3.9 Verify D2PC Cases areLogged to the M: Drive

Go to the M:\ drive under D2LOG<oracle id of d2 case>\ex0\run<m>\ to verify the D2PC case has been logged (i.e., d2inp.dat, d2log.dat, plot.dat, and summary.dat have the correct time and date). Where <m> is the number of times this case has been logged. The Oracle ID of the current operational D2PC case can be found under Help → Current Info → Case Information from the FEMIS main toolbar or by expanding the last (hidden) column on the open D2PC window.

Make the Current D2PC Case Operational by clicking under File → Make Case Current Operational.
4.7.3.10 Verify Notification Server

On the Tracking Navigator, you should see a blinking icon (New Data button) that looks like a package. A magenta bar on the D2PC Function box should also appear. This means that FEMIS data notifications are being sent and passing messages to your PC. Click the New Data button.

4.7.3.11 Verify GIS

Click the MAP button from the main FEMIS toolbar. The ArcView GIS application should be initiated, and you should see a base map displayed within an ArcView GIS window.

To check the link between FEMIS and the GIS, select the i+ button on the ArcView GIS toolbar; and then click a facility icon on the map. A view-only facility/resource window should appear. This window has tabs for General, Contact, and Resource Information.

Do not close the GIS as it will be used in the following steps.

4.7.3.12 Verify Evacuation

If the one-time validation steps have been successfully completed, there should be a current Evacuation case displayed on the Tracking Navigator. Click the Evacuation Function box on the Tracking Navigator. If Evacuation has not been previously executed on this PC, you will get a message telling you to create a network. Under File, select Create Network. It should display on the GIS. If the network was previously created on this PC, you will not get the message nor need to create the network. You can merely observe the network is displayed on the GIS.

4.7.3.13 Verify Electronic Planning (Planning Mode)

To run FEMIS Electronic Planning in the Planning Mode, you must have Microsoft Project loaded on your PC and a FEMIS Access Database properly attached. To validate this, go to Planning Mode from the FEMIS Tracking Navigator window; and select the validation dataset created in the one-time steps (Section 4.7.1.5, Create a Plan for Validation Testing). Examine the Tracking Navigator window to be sure a Plan has been selected. Click on Edit under Tasks, which is next to the Plan on the FEMIS Tracking Navigator (Planning) window. Microsoft Project will open and display the selected Plan. If you can do this without any errors or error messages, and tasks appear in the grid; then the FEMIS Planning software should work properly.

The Microsoft Project calendar should be set to a 24-hour clock and a 7-day calendar. Select Tools \ Change Working Time. Every day is gray, and the working time is 12:00 a.m. to 12:00 a.m.

4.7.3.14 Verify Help

Click Help to activate the online Help to verify the Help subsystem is working properly.
4.7.3.15 Verify Printer

Verify KeyPrint was enabled at log in. Use KeyPrint or the Print Screen button on any FEMIS window to ensure the PC is properly connected to a printer.

4.7.3.16 Verify E-mail

Select the MAIL button from the FEMIS toolbar. This should bring up the GroupWise E-mail software or the E-mail package for this EOC. Verify that you can send an E-mail message to another PC.

4.7.3.17 Verify SEPR Icon

If GroupWise is the E-mail package being used, make sure the SEPR icon is on the GroupWise Shelf. Send a test SEPR message.

4.7.3.18 Verify FEMIS Tools

Verify on a FEMIS PC with System Tools installed. Click on each of the FEMIS Tools (FEMIS Monitor PC, FEMISMon Watcher, and Network Monitor) to ensure they are operational.
# FEMIS PC Installation Checklist

<table>
<thead>
<tr>
<th>Machine Name:</th>
<th>NT License #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin Password:</td>
<td>ArcView License #</td>
</tr>
<tr>
<td>IP Address:</td>
<td>MS Project License #</td>
</tr>
<tr>
<td>Subnet Mask:</td>
<td>Server Name:</td>
</tr>
<tr>
<td>Default Gateway:</td>
<td>Server IP Address:</td>
</tr>
<tr>
<td>DNS:</td>
<td>Company:</td>
</tr>
<tr>
<td>Domain:</td>
<td>Organization:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WorkGroup:</th>
<th>Task</th>
<th>Complete</th>
<th>Init.</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Reformat Disk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>4.1.1 Installing Windows NT 4.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Editing the Hosts File; Site Specific</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4.4.1.1 Adding User Accounts to Windows NT</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>4.1.1.3 Installing Windows NT Service Pack 4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>4.1.2 Installing an NFS System; Maestro or Solstice</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>4.1.3 Installing Oracle SQL *Net v2.3.4 and ODBC v2.5.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4.1.4.1 Installing ArcView GIS v3.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>4.1.4.2 Installing ArcView GIS v3.0a Patch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>4.1.5 Microsoft Project 98 Service Release 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>4.1.6 Installing Other COTS; Site Specific</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>4.2 Configuring The FEMIS Setup Program (Once at Each EOC)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>4.3 Installing the FEMIS Client Software</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>4.4.2 FEMIS Startup Files</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>4.4.3 Verify Temporary Directory and Environment Variables</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>4.4.4 Verify Clock and Time Zone</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>4.4.5 Verify the Time Synchronization Services</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>4.4.5.3 Set Network Time Protocol Start to Manual</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>4.4.6 Set Virtual Memory Max = 250</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>4.4.7 Creating the FEMIS ICON</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>4.7.3.2 KeyPrint is in the Startup Group for all Users</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# FEMIS PC Validation Checklist

<table>
<thead>
<tr>
<th>PC Name:</th>
<th>IP Number:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validated using NT Login:</td>
<td></td>
</tr>
<tr>
<td>One Time at Each EOC:</td>
<td>Initials</td>
</tr>
<tr>
<td>1 Verify Database Connection</td>
<td></td>
</tr>
<tr>
<td>2 Verify Default D2PC Case Exists</td>
<td></td>
</tr>
<tr>
<td>3 Verify the Evacuation Command Server</td>
<td></td>
</tr>
<tr>
<td>4 Only on the server with the depot database, Verify FEMIS/EMIS Data Exchange Interface (DEI)</td>
<td></td>
</tr>
<tr>
<td>5 Create a Plan for Validation Testing</td>
<td></td>
</tr>
<tr>
<td>6 Test the GIS on the Printer</td>
<td></td>
</tr>
<tr>
<td>7 Verify E-mail</td>
<td></td>
</tr>
<tr>
<td>8 Verify that SEPR Icon Addressed</td>
<td></td>
</tr>
<tr>
<td>Clean Up AFTER Validation:</td>
<td></td>
</tr>
<tr>
<td>1 Delete Validation Datasets</td>
<td></td>
</tr>
<tr>
<td>2 Ensure Exercise #1 Exists or Whatever Exercise is Recognized by EMIS</td>
<td></td>
</tr>
<tr>
<td>3 Remove Extraneous User Accounts</td>
<td></td>
</tr>
<tr>
<td>Perform on Every PC:</td>
<td></td>
</tr>
<tr>
<td>1 Ensure Windows NT Login FEMIS/FEMIS Does Not Exist</td>
<td></td>
</tr>
<tr>
<td>2 Verify the PC Configuration</td>
<td></td>
</tr>
<tr>
<td>3 Verify the PC Clock</td>
<td></td>
</tr>
<tr>
<td>4 Verify Network Time Protocol (NTP) Service</td>
<td></td>
</tr>
<tr>
<td>5 Verify Link to L: Drive (if GroupWise is used as the E-mail program)</td>
<td></td>
</tr>
<tr>
<td>6 Verify Login</td>
<td></td>
</tr>
<tr>
<td>7 Verify COTS Software</td>
<td></td>
</tr>
<tr>
<td>8 Verify Database Manager</td>
<td></td>
</tr>
<tr>
<td>9 Verify System Administration</td>
<td></td>
</tr>
<tr>
<td>10 Verify D2PC</td>
<td></td>
</tr>
<tr>
<td>11 Verify D2PC Cases Are Logged to the M: Drive</td>
<td></td>
</tr>
<tr>
<td>12 Verify Notification Server</td>
<td></td>
</tr>
<tr>
<td>13 Verify GIS</td>
<td></td>
</tr>
<tr>
<td>14 Verify Evacuation</td>
<td></td>
</tr>
<tr>
<td>15 Verify Electronic Planning (Planning Mode)</td>
<td></td>
</tr>
<tr>
<td>16 Verify Help</td>
<td></td>
</tr>
<tr>
<td>17 Verify Printer</td>
<td></td>
</tr>
<tr>
<td>18 Verify E-Mail</td>
<td></td>
</tr>
<tr>
<td>19 Verify SEPR Icon</td>
<td></td>
</tr>
<tr>
<td>20 Verify FEMIS Tools on Appropriate PC(s)</td>
<td></td>
</tr>
</tbody>
</table>

4-42
5.0 Adding General Hazard Zones to the FEMIS Database

In FEMIS v1.4.6, enhancements have been made to support real or potential emergencies created by general (non-CSEPP) hazards. The CSEPP emergency zones that exist in FEMIS are specifically designed to plan for and manage chemical accidents at the depot. These geographical zones may not be appropriate for implementing risk area analysis and protective action decisions during other types of hazards, such as floods or fires. The addition of other polygonal map layers to the GIS and the database allow FEMIS to better support the management of non-CSEPP hazards. As an initial demonstration of the general hazard capabilities in FEMIS, the FEMIS v1.4.6 site databases will include county boundaries as the “zones” for general hazards.

The following describes the process for adding a polygonal map layer and registering the polygons as “emergency zones” in the FEMIS database. Although county boundaries are used as an example, the process applies to any GIS polygonal theme that contains a properly structured set of contiguous polygons covering the geographic area of interest. The process consists of a set of GIS steps followed by a set of database steps that result in updating the FEMIS database and GIS with the required information on the new general hazard zones.

5.1 Business Rules

The business rules below define what options are available when counties are added to future site databases. We recommend a default implementation, but a site may choose to make other choices. Also, the database may be altered after the basic information is loaded to further customize the new hazard.

- One EOC defines the “county” GIS layer. This results in only one EOC having county records in the GEO_OBJECT table. The other EOCs see these records in the S_GEO_OBJECT view. It is recommended that the state EOC (or the selected state EOC in the case there is more than one state at the site) be used to define the county layer.

- Counties at a site belong to one or more types. For example at the UMCD site, WA can be the type for Washington State counties and OR for Oregon counties. In Utah, one type called UT will suffice. Each county type can have a GIS symbol.

- Each county is “administered” by a specified EOC. This is not to be confused with the definition of the county GIS layer in first bulleted item. A county EOC normally administers its county and any other counties that do not have their own EOC that have requested this. For other counties, the state EOC is recommended. Each county is put into each EOC’s ZONE, EOC_ZONE, and PA_UNIT database tables. At this time, it is only possible to define a unique EOC for each county. If the site desires to share administration of counties, then the database must be updated after the basic information is added.
Federal Emergency Information Systems (FEMIS)

Information Systems (FEMIS) June 25, 1999—Version 1.4.6

- A facility is in a county if its location is within the county extent. (Not all facilities are within counties due to 00 latitude/longitudes or null latitude/longitudes or not having the county in the site database). When a facility is in a county, an EOC responsible for that facility is specified. The EOC assignment is based on which EOC has the facility in its database. It is possible to have the same facility in more than one EOC database. For each facility in a county, a record is placed in the GEO_OBJECT_ZONE table for the EOC that is responsible for the facility.

- For a facility in a county, a protective action is built if this facility previously had a CSEPP protective action for the Operational mode (i.e., exercise_num = 0). In the database, this results in a record being added to the PA_UNIT table for the Operational mode if the conditions are met.

5.2 GIS Processing

To complete the GIS processing, you will need to identify the general hazard theme, setup the general hazard attributes, and create the export files. Where the following procedures specify <DRIVE> (e.g., <DRIVE>\FEMIS\GIS), this is prompting for the drive letter where the GIS has been installed. Where the procedures specify <SITE CODE>, this is prompting for the 4-digit site code of the site interaction (e.g., ANAD). Where the procedures specify <EOC CODE>, this is prompting for the 4-digit EOC code for one of the EOC site installations and <EOC NAME> is the full EOC name in the database.

5.2.1 Identify a General Hazard Theme

Identify a set of general hazard zone polygons in support of one or more hazards. County boundaries are used as the initial example in FEMIS v1.4.6 to support flood, fire, and other general community emergencies.

5.2.2 Setup General Hazard Attributes

To create the general hazard theme, follow the procedures below. There are two methods of adding a general hazard theme: 1) using Copy Attributes from the FEMIS\GIS_UTILITIES.APR, or 2) manually add the fields with ArcView GIS functionality. Use the Copy Attributes with the generic_hazard theme on the server (/home/femis/gis).

5.2.2.1 Automatically Adding the General Hazard Attribute Fields

If a general hazard theme already exists with the correct attributes, the fields can be copied by selecting Copy Attributes from the General Hazard menu in the FEMIS\GIS_UTILITIES.APR. An ArcView GIS v3.0a theme has been provided in /home/femis/gis named generic_hazard that has the correct field properties (the three files that make up the theme are generic_hazard.shp, generic_hazard.shx, and generic_hazard.dbf).

5.2.2.2 Select Copy Attributes from the General Hazard Menu

1. Copy femisgis_utilities.apr from the server /home/femis/gis to <DRIVE>\FEMIS\GIS\<SITE CODE>, if not done already.
2. Copy the generic_hazard theme (*.shp, *.shx, and *.dbf) files to <DRIVE>\FEMIS\GIS\<SITE CODE>.

3. Open the FEMISGIS_UTILITIES.APR in ArcView GIS v3.0a, or double-click on the file using Windows Explorer.

4. Open a View in ArcView GIS by double-clicking on View 1 in the open window, or by double-clicking on the Views icon on the left-side of the window.

5. Open the old general hazard theme (or generic_hazard theme) in the View by selecting Add Theme from the View menu. Browse to find the file, and click OK.

6. Open the polygonal layer that is to be converted into a general hazard theme (for county hazard, the file is in <DRIVE>\FEMIS\GIS\ISTIC\COUNTY) in the View by selecting Add Theme from the View menu. Browse to find the file, and click OK.

Note: The file attributes (in Windows NT Explorer) must not be Read-only.

7. Select Copy Attributes from the General Hazard menu.

8. Select the theme to copy the attributes to in the drop-down list. This is the polygonal layer that is to be converted to a general hazard theme, i.e., county theme. Click OK.

9. Select the theme to copy the attributes from in the drop-down list. This is the theme with the correct field properties, i.e., generic_hazards.shp. Click OK.

10. Select, from the list provided, all the fields to be copied to the new general hazard layer from the old general hazard layer. Make multiple picks by holding down the Shift key and selecting the fields. The fields needed are Zone_id, Type, Zone, Par_Pad, Risk_Area, Objectname, Objecttype, Objectid, and Eoc_name. Caution: Do not select the Shape field. Click OK when all the fields are selected.

5.2.2.3 Copy Attributes using Generic ArcView GIS Functionality

If a theme has already been converted to a general hazard theme in the previous section, move to Section 5.2.2.4, Populating the General Hazard Attribute Table. If not, follow the procedures below.

1. Make a copy of the general hazard theme files (*.shp, *.shx, and *.dbf) and place in the <DRIVE>\FEMIS\GIS\<SITE CODE> directory.

2. Copy femisgis_utilities.apr from the server /home/femis/gis to <DRIVE>\FEMIS\GIS\<SITE CODE>.

3. Open the FEMISGIS_UTILITIES.APR in ArcView GIS v3.0a, or double-click on the file using Windows Explorer.
4. Open a View in ArcView GIS by double-clicking on View 1 in the open window, or by double-clicking on the Views icon on the left-side of the window.

5. Open the polygonal layer that is to be converted into a general hazard theme (for county hazard, the file is `<DRIVE>\FEMIS\GIS\STCOUNTY\<SITE CODE>_CB.SHP`) in the View by selecting Add Theme from the View menu. Browse to find the file, and click OK.

6. Select the theme in the View by holding down the Shift key and clicking on the legend name of the theme. The legend box for the theme should appear raised.

7. Select Table from the Theme menu to display the GIS attribute tables for the theme.

8. Select Start Editing from the Table menu.

9. Select Add Field from the Edit menu.

10. Add the following fields in order, with these parameters for the Name, Type, and Width entries:

    Zone_id – string, size 10
    Type – string, size 8
    Zone – string, size 30
    Par_pad – string, size 20
    Risk_area – string, size 20
    Objectname – string, size 30
    Objecttype – string, size 8
    Objectid – string, size 10
    Eoc_name – string, size 30

11. Select Stop Editing from the Table menu when done, and save the file.

5.2.2.4 Populating the General Hazard Attribute Table

1. Click on the legend name of the theme to be a general hazard, the legend should appear raised. Select Table from the Theme Menu.

2. Click the title bar of the attribute table of the general hazard theme.

3. Select Start Editing in the Table menu.

The "general hazard name" is the name given to the original polygon (i.e., county name).

4. Copy the general hazard name into the Zone field for each record by selecting the Edit Tool icon (the icon with the arrow pointer and the cursor – see ArcView GIS Help for details). Using the Edit Tool, select the records in the general hazard name field. Highlight the record in the cell, Copy (Ctrl+C), select the new cell, and Paste (Ctrl+V). Repeat for each record to be copied.
The "general hazard fields" is all field to the right of Zone_id inclusive.

5. Select the old general hazard name field by clicking on the field name (column name in the table), and select Delete Field from the Edit menu. All fields other than the shape field and the general hazard fields must be deleted.

6. Populate the new fields according to the following parameters using the Edit Tool:

   Shape: Polygon
   Zone_id: Numeric identification of zone. Will be populated later from the hazard.txt file.
   Type: Two-digit State code for state that owns layer, such as WA.
   Zone: Name of zone.
   Par_pad: Default is No recommend.
   Risk_area: Default is Not at Risk.
   Objectname: Should be same as Zone.
   Objectype: Should be same as Type.
   Objectid: Should be same as Zone_id (this can be left blank in this step).
   Eoc_name: The name of the EOC that administers the zone (this can be left blank in this step).

7. Select Stop Editing from the Table menu, and save the theme in the correct subdirectory, replacing the old theme.

5.2.3 Create the Export Files

The polygonal theme export scripts from the FEMISGIS_UTILITIES.APR will create a set of four theme definition files that describe each polygon and will identify the facilities that are located within each polygonal boundary. The files are used for the automated database scripts to process to update the relational database. For details on creating the theme definition files, see instructions below.

Adjacent fields in each of the files are separated (delimited) by the vertical bar character (|). The format and content of these four files are described in the following sections.

5.2.3.1 Create the hazard_parameters.txt File

General hazard theme parameters – This information is in a file named hazard_parameters.txt and describes the hazard zone theme:

Example of general county parameters:

   |county|County Boundaries|county|County data for the UMCD site|Y|Benton County EOC|

- gis_layer_name – a short name describing the spatial theme. Character limit is 30. For counties, use county.

- gis_legend_name – text description that will appear in the GIS legend. Character limit is 30.
• location_type – type of spatial data, e.g., county (may be the same as gis_layer_name). Limit is 8 characters. For counties, use county.

• gis_layer_description – a longer text description of the theme and its contents. Character limit of 127.

• hazard_zone_layer_flag – a status flag used by the FEMIS application (this will normally be Y). Single character limit, Y or N.

• eoc_name – Official EOC name of the EOC that owns the data for the new theme.

To create the hazard_parameters.txt file, complete the following steps:

1. Open a text editor (e.g., Notepad), and enter the information. All fields are delimited with the pipe (|) character, and there must be a carriage return at the end of the line.

2. Save the file as <drive>FEMIS\GIS\<site code>\hazard_parameters.txt.

5.2.3.2 Create the hazard_subtype.txt File

Hazard zone subtype information – This information is in a file named hazard_subtype.txt and defines the possible polygon (object) subtypes:

Example of county subtype information:

```
|WA|Counties in Washington State|
|OR|Counties in Oregon State|
```

• type_name – the polygon type (e.g., two-digit state code – WA for counties in Washington State). Character limit of 8.

• type_description – longer text description of the type (e.g., “All participating counties in the state of Washington”). Character limit of 127.

• symbol_id – NULL value.

To create the hazard_subtype.txt file, complete the following steps:

1. Open a text editor (e.g., Notepad) and enter the information. All fields are delimited with the pipe (|) character, and there must be a carriage return at the end of the last line.

2. Save the file as <DRIVE>FEMIS\GIS\<SITE CODE>\HAZARD_SUBTYPE.TXT.
5.2.3.3 Create the hazard.txt File

Map feature information – This information is in a file named hazard.txt and contains information on each of the polygons (zones) in the hazard zone theme:

Example of map feature information:

| Franklin| WA | 60000 | Washington State EOC |
| Benton | WA | 60001 | Washington State EOC |
| Umatilla | OR | 40000 | Oregon State EOC |
| Morrow | OR | 40001 | Oregon State EOC |

- zone_name – a short name for the “zone”.

- type_name – the type of the zone (one of the types defined in hazard_subtype.txt file).

- zone_number – a predefined zone_number assigned to this polygon in the ZONE table. Multiplying the eoc_num from the EOC table by 10,000 for the first “zone” and then incrementing this by 1 for the next “zone” produces this number. This number will also be used as the gis_object_id in the GEO_OBJECT table.

- eoc_name – the name of the EOC that has jurisdiction over this “zone”.

To create the hazard.txt file, complete the following steps:

1. Copy FEMISGIS_UTILITIES.APR from the server /home/femis/gis to <DRIVE>\FEMIS\GIS\<SITE CODE>, if not done already.

2. Open the FEMISGIS_UTILITIES.APR in ArcView GIS v3.0a, or double-click on the file using Windows Explorer, if necessary.

3. Click on the title bar of the existing View window if the FEMISGIS_UTILITIES.APR was still open. Otherwise, open a View in ArcView GIS by double-clicking on View 1 in the open window, or by double-clicking on the Views icon on the left-side of the window, if not already open.

4. If the new general hazard theme is not already in View 1, open the new general hazard theme (created previously) in the View by selecting Add Theme from the View menu. Browse to find the file, and click OK.

5. Select Create hazard.txt from the General Hazard menu.

6. Browse to find the general hazard layer file created previously. Click OK.
7. Enter the Oracle database login information for the EOC. The message boxes will prompt you for the Oracle usernames and passwords. Click OK in the Use Default Values message box, or select no and enter the login values manually.

Note: If the database cannot be opened, set up an account with the same username and password and try again.

8. Select the EOC that administers each zone in the message box that appears from the drop-down list once the database is connected. This should correspond to the GIS table for the general hazard zone.

9. Open the hazard.txt file and verify that the file was created successfully. This file was written to the <DRIVE>\FEMIS\GIS\<SITE CODE> directory (or whichever directory the FEMISGIS_UTILS.APR is in).

10. Check the general hazard GIS table and verify that the EOC_NAME, ZONE_ID, and OBJ_ID fields are consistent with the hazard.txt file. If not, populate the general hazard layer table with the values from the hazard.txt file. These values must be the same for each polygon in the hazard.txt file and the general hazard table for general hazard functionality to work. To populate the general hazard layer attribute table, use the ArcView GIS functionality as described in Section 5.2.2.4, Populating the General Hazard Attribute Table.

5.2.3.4 Create the Facility-in-Zone Files

Facility-in-zone information – Identifies the "zone" in which each of the FEMIS facilities is located. This information is in a series of files named <eoc_code>_facilities.txt (e.g., cben_facilities.txt contains all facilities that are under the jurisdiction of the Benton County, WA EOC).

Example of facilities under the jurisdiction of the Benton County EOC:

[Franklin|Able Tank & Toilet|Benton County EOC|private business|20002]
[Franklin|Goodwill Industries, Columbia|Benton County EOC|emergency response|20030]
[Benton|Van Waters & Rogers|Benton County EOC|private business|20062]

- zone_name – the name of the "zone" in which this facility is located.
- facility_name – the name of the facility.
- eoc_name – EOC responsible for the facility.
- facility_type – type of facility (e.g., school).
- gis_object_id – the GIS object-id of the facility.
To create the facility-in-zone files, complete the following steps:

1. Copy FEMISGIS_UTILITIES.APR from the server/home/femis/gis to <DRIVE>\FEMIS\GIS\<SITE CODE>, if not done already.

2. Open the FEMISGIS_UTILITIES.APR in ArcView v3.0a, or double-click on the file using Windows Explorer, if necessary.

3. Click on the title bar of the existing View window if the FEMISGIS_UTILITIES.APR was still open. Otherwise, open a View in ArcView GIS by double-clicking on View 1 in the open window, or by double-clicking on the Views icon on the left-side of the window, if not already open.

   Note: The theme must be in View 1.

4. Open the new general hazard theme (created previously) in the View by, if the new general hazard theme is not already in View 1, by selecting Add Theme from the View menu. Browse to find the file, and click OK.

5. Open the Facility theme by selecting Add Theme from the View menu. Browse to <DRIVE>\FEMIS\GIS\<SITE CODE>\FACILITY\EO.

   Note: If no facility theme exists, run FEMIS on the PC and enter operations or planning mode. Click on the map button to generate the dynamic themes.


7. Select the Polygonal General Hazard theme from the message box drop-down list. Click OK.

8. Select the Point Facility theme from the message box drop-down list.

9. Enter the database login information for the EOC. The message boxes will prompt you for the Oracle username and passwords. Click OK in the Use Default Values message box, or select no and enter the login information.

   The files should be written to the <DRIVE>\FEMIS\GIS\<SITE CODE> directory.

   Note: If the “Could not retrieve EOC names, using EOC codes instead.” message appears, click OK. Try reconnecting to the database and running the facility-in-zone script again. If you are still not successful, replace the EOC codes with the full EOC names in a text editor for each output file.

10. Exit FEMISGIS_UTILITIES.APR by selecting Exit from the File menu.

11. Copy the new general hazard theme files (*.shp, *.dbf, *.shx) to replace the general hazard theme on the server. (For a county general hazard these files should be copied to /home/femis/gis/<site code>/stcounty.
5.3 Database Processing

When the GIS processing is complete, the export files are processed to create two SQL scripts that will update the database. Make sure all of the database modifications have been accomplished to upgrade the database to v1.4.6. Complete the following steps for the database process on one of the UNIX servers at the site. The user must be familiar with text editors and know how to use sqlplus to run SQL database scripts.

Note: Check all of the Oracle passwords to see if they have been changed from default values. If any are changed, use the password utility to reset them to default values. After completing Step 7, reset the passwords to the original values, if they were changed.

1. Create a directory called hazards in the path /home/femis/database on the server where the processing will occur. The automated script named mkehazard.sh in the /home/femis/database/dba directory must be copied into the new directory where work will be done. Then move the export files produced by GIS into this new directory. Use a text editor to look at the files and make sure they are in the correct format as described above. Then use the editor to combine all of the facility information into a new file called merged_departments.txt. If a county facility file is empty meaning that no facilities are present in that county, there is nothing to copy to the merged file. Keep the original <eoc_code>_<facilities>.txt files in case any problems occur since it will be easier to find what is wrong if the facilities are grouped by responsible EOC.

2. Make sure that the server has the correct database configuration files in the /home/femis/etc directory. The eoclist.dat and eocnum.dat files must be correct since the automated script will use these to produce the SQL scripts.

3. Run mkehazard.sh to produce the SQL scripts. If all files are present and in the correct format, two output scripts named hazard_change.sql and hazard_change1.sql will be produced. If any errors occur, do not proceed until the cause is determined and fixed.

4. Login as femis and use sqlplus (sqlplus /nologin) to perform a trial update of the database using the hazard_change.sql script that creates the basic county data. This script will connect to the proper databases and make the changes if all servers, networks, and databases are operating normally. Before running the script, make sure there are no problems. The script is set up to make the changes needed at each database and then rollback these changes in case errors are present. After each EOC is updated for changes, the user will be prompted to enter 0 if this was the initial trial run or if any errors were present. This will allow the user to make sure all the updates will work before getting partially done and then finding problems. So enter 0 to all prompts for the first trial run.

Note: Disregard any multi-line errors that are due to updates of the LOCATION_TYPE table because counties have previously been defined as a valid type at your site.

If you see any other errors, stop the update process by entering a Ctrl+C at the prompt and rollback any changes by entering SQL> rollback; SQL> exit. Then fix the problem and rerun the script.
5. When the hazard_change.sql script runs without errors, run the script again to update the database and save the changes. The user will enter 1 at the prompts this time to commit the changes.

6. Next run the hazard_change1.sql script that processes facilities for a trial run. As in Step 4, enter 0 at the prompt for the trial run. If there are errors enter Ctrl+C at the prompt, rollback any changes, determine the cause, and fix them. These errors are probably due to inconsistencies in spelling.

7. Run hazard_change1.sql again, when Step 6 is error free, to commit the changes by entering a 1 at the prompts. After this step, both the GIS and the relational database changes are complete and the system can be used for non-CSEPP hazards.
6.0 Remote Evacuee Registration and Point to Point Protocol

6.1 Remote Evacuee Registration

The Remote Evacuee Registration (RER) application can be used in shelters where a network connection is not available. Evacuee information can be entered and then uploaded to a site's database using a standard phone connection and PC modem.

The application is also suited to portable PCs where the user must be on the move with respect to the acquisition of evacuee data. Use of the application does not require that the user install the entire FEMIS product line; as such, space can be conserved on the hard drive.

To run RER, your site must have a modem and PPP software installed and properly configured on their server.

See Section 2.6, FEMIS AutoRecovery System Description and Installation, for information on messaging service, logging, sending E-mail, running processes, monitoring swap and disk space, and installing and configuring AutoRecovery.

6.2 Establishing a PPP Dialup Modem Link

PPP (Point to Point Protocol) establishes a dialup modem link from a remote PC to the server. The FEMIS Remote Evacuee Registration application with a PPP link is used so shelter personnel can upload information about evacuees during emergencies.

Note: Make sure nsswitch.conf has files listed for hosts before you remove the bundled PPP packages.

6.2.1 Remove Bundled PPP

A version of PPP comes bundled with Sun's Solaris operating system. To avoid conflicts between bundled PPP and Solstice PPP, you must remove the bundled PPP packages.

# pkg rm SUNWappp
# pkg rm SUNWappu
# pkg rm SUNWappk
Move the bundled PPP startup file to a new name.

```
# cd /etc/rc2.d
# mv S47asppp s47asppp
# cd /etc/rc0.d
# mv K47asppp k47asppp
```

### 6.2.2 Initial Setup

Complete the following steps for the initial setup of PPP.

1. Attach the modem to the Sun server. Use any working serial port. Make sure to use a straight through modem cable because the cable must support pins 1-8 and pin 20, at a minimum.

2. Set the US Robotics Courier V.3Modem dip switches 3 (display result codes) and 8 (act on AT commands) to ON. For other modems, check vendor’s documentation for dip switch settings.

3. Make sure you have an analog phone line for this configuration.

4. Login as root.

5. Remove all port monitoring services on the port that are going to be configured for the modem. You can verify port monitor services are running by typing:

   ```
   # pmadm -p zsmon -l
   
   If your output is similar to the following, then port monitoring services are present.
   
   PMTAG PMTYPE SVCTRG FLGS ID <PMSPECIFIC>
   zsmon Ttymon Ttya u root /dev/term/a - -/usr/bin/login - 9600 idterm,tcompat login: - vt100 y
   
   Remove the services by typing:
   
   ```
   # pmadm -p zsmon -r -s <your serial port (i.e., ttya)>
   
   Note: You can also delete services using the Admintool and selecting Delete or Disable for the port.

### 6.2.3 Modem Setup

Because there are a variety of modems and modem vendors, modem setup is the responsibility of the user. If you have problems with a modem, check your modem documentation, contact the vendor’s technical support, or check the vendor’s web site for additional help.
To set up PPP, you must be able to access the port and the modem. You do this with the tip command. If a tip to the modem does not get results, your PPP connections will fail. You must be able to tip to the modem before installing PPP.

1. tip -38400 /dev/cua/a

2. Verify that the modem is responding to commands. Type:
   
   at

3. You should see OK displayed.

4. Use ~. to exit tip.

   If you do not get an OK, you can try reinitializing your modem. For the initialization string, see your modem documentation.

   If you get an OK, test your modem by connecting to a bulletin board at 9600 baud.

   tip -9600 /dev/cua/a
   at
   atdt 918003922432
   ~.

6.2.4 Installing Solstice PPP 3.0.1

Complete the following steps to install Solstice PPP 3.0.1.

1. Login as root.

2. Enter the following command to start the installation process

   /usr/sbin/pkgadd -d /cdrom/ppp_3_0_1/sparc.

3. Select all to install all packages.

4. Install Sun's Solstice PPP Patch 103563-09 or higher.

5. Call Sun for a license password (1-800-USA-4SUN).

6. Install the PPP license using /etc/opt/licenses/lit.

7. Check that lmgrd is running (ps -ef | grep lmgrd).
8. Check that the license is active using `imstat -a`.

9. Make sure the modem is powered on (If you have a multiple `lmgrd` server configuration, refer to the `lmgrd` man page for the correct `imstat` command.).

10. Run `pppinit` to configure PPP.

    Configure for asynchronous client/server
    Modem - Select your modem type or equivalent from the list.
    Line Speed - 38400
    Device - `ttyc` - depends on which port you are using.
    Type of Call - `answer`
    Add another modem - No
    Local IP address - set to your PPP server’s IP address.
    Remote IP address - set to your remote system’s IP address. The client IP address should be on a different subnet. PNNL used an enterprise IP address for laptops. Example: IP 192.168.xxx.xxx.
    Netmask - Use your netmask. Example: 255.255.255.0
    MTU - 1500
    Login account - You can choose your own account name.
    Inactivity Timeout - 120
    Add another interface - No

11. Make sure the new PPP login account for `femisppp` is added. We used UID=30515, GID=30510 for the PPP account at PNNL. The default shells must be set to `/usr/sbin/pppids`, password. Select any password you want to use.

12. Add your remote PC IP addresses to the `/etc/inet/hosts` file.

13. Do not have `pppsetmod` configure your modem.

14. Add the following lines to `/etc/ttydefs` per Sun’s recommendation.

    
    38400m:38400 hupcl:38400 hupcl crtscts::38400m
    19200m:19200 hupcl:19200 hupcl crtscts::19200m
    9600m:9600 hupcl:9600 hupcl crtscts::9600m

    
15. Start PPP

    `sh /etc/init.d/ppp start`

16. Check the PPP configuration using the `ifconfig -a` command, and look for the network device `ipdptp0`.

    The software has been installed in `/etc/opt/SUNWconn/ppp`. To modify PPP, refer to the `link.conf` and `ppp.conf`.

6-4
The log file is /var/opt/SUNWconn/ppp.log. Make sure the "license is found" message is listed in the log file. It may take several minutes for the message to display.

6.3 Setting up PPP for Windows NT

Setting up PPP for Windows NT consists of verifying the modem has been installed, configuring the dial-up networking, and connecting via the dial-up network.

6.3.1 Verifying Modem Installation

To verify the modem installation, complete the following steps.

1. Log into Windows NT as Administrator.
2. Click Start → Settings → Control Panel, and double-click the modem icon.
3. Verify the modem is installed.
   
   If no modem is installed, the Install New Modem program will execute. Use the vendor’s recommendation for installing the correct drivers for Windows NT v4.0.

6.3.2 Configuring Dial-Up Networking

Complete the following steps to configure the dial-up network.

1. Log into Windows NT as Administrator.
2. Click Start → Programs → Accessories → Dial-Up Networking.
3. Follow the prompts to install the software from the Windows NT v4.0 CD if the Dial-Up Networking has not been previously installed.
   
   If it has been installed but not configured for use, you will be prompted to add a phone book entry. Click OK.
   
   If you do not get either of these prompts, click the New button on the Dial-Up Networking window.
4. Enter a name for the phonebook entry you will use to connect to the PPP server. Click Next.
5. Check The non-Windows NT Server I am calling expects me to type login information after connecting.... Click Next.
6. Check Use Telephony Dialing Properties. Enter values for Country Code, Area Code, and phone number of the modem on the PPP server. Click Next.

7. Check Point-to-Point Protocol (PPP). Click Next.

8. Check Use Terminal Window. Click Next.

9. Enter the IP address created for the remote system on the server (Step 9, in Section 6.2.4, Installing Solstice PPP 3.0.1) in My IP Address. Click Next.

10. Enter the IP addresses for the PPP server's network DNS and/or WINS in Name Server Addresses. If the network does not use either of these, leave them at the default (all zeros). Click Next.

   **Note:** If you do not enter a DNS, be sure the IP for the PPP server and other systems you wish to connect to on its network are in your hosts table located in the `<windir>\system32\drivers\etc\hosts` file.

11. Click Finish to save your phonebook entry.

12. Locate an analog phone line that you can connect to your modem.

13. Click the Location button in the Dial-Up Networking window.

14. Click New if you have previously configured dialing locations.

15. Edit the I am dialing from to reflect the location/phone line you are using.

16. Edit all applicable items in this window, and click OK.

### 6.3.3 Connecting Via Dial-Up

Complete the following steps to connect the dial-up network.

1. Login to Windows NT using the user's account.

2. Click Start → Programs → Accessories → Dial-Up Networking.

3. Select your phonebook entry and dialing from location. Be sure your modem is plugged in, and click Dial.

   You will not need to enter a Password or Domain unless you are connecting to systems on an NT Domain. Click OK.
After the modem has dialed and connected to the PPP server, you will get an After Dial Terminal window. Enter the username and password for the PPP login account created during the installation of Solstice PPP 3.0.1 on the server (Step 10, in Section 6.2.4, Installing Solstice PPP 3.0.1). You will get connecting symbols ({} ) printing on the window after your login. Click Done. If you entered them incorrectly, you will be prompted for the username and password again.

You can test your connection by bringing up a DOS window and entering a ping <ppp server> and verify you get a response.
7.0 Stand-Alone Installation of FEMIS v1.4.6

The following document contains instructions on the installation of a stand-alone Oracle database and the configuration of the FEMIS v1.4.6 application on the stand-alone system. Additional documentation and software that will be required to complete this installation are as follows:

- Oracle7 Workgroup Server or Personal Oracle7 for Oracle v7.3.4. If you have maintenance on your Oracle products, contact Oracle for the latest release.

- Stand-Alone Database Configuration CD. This is a special release CD that contains SQL scripts and command files needed to configure the stand-alone database. This CD is not included in the FEMIS v1.4.6 package.

- FEMIS v1.4.6 COTS CD.

- Section 4.0, FEMIS PC Installation.

7.1 Stand-Alone PC System Requirements

Since the stand-alone PC will be running an Oracle database as well as the FEMIS application and COTS software, the system hardware should be as robust as possible. The following hardware requirements should be used as minimum requirements.

- IBM compatible PC with Windows NT version 4.0 and Service Pack 4
- Pentium 166MHz
- 64MB of RAM
- CD ROM Drive
- Network Adapter or PC Card
- 800X600 pixels and 256 color Display Graphics
- 2GB or greater hard disk.

7.2 Location of Oracle

The Oracle installation process uses scripts to install database files on the PC. These scripts were written to configure the database in its default location of C:\ORANT. The database can take over 1GB so it is important your system can accommodate this. If you do not have room on your C:\ drive, it will be necessary to modify scripts to place the database files on a different drive location.

Note: If you install Oracle to a different location, use that directory instead of C:\ORANT throughout this installation procedure.
7.3 Stand-Alone PC Installation Process

The following sections provide instructions for installing the Oracle database and configuring the FEMIS v1.4.6 application.

7.3.1 Installing PC COTS and FEMIS v1.4.6

Follow the instructions in Section 4.0, FEMIS PC Installation, to install the FEMIS v1.4.6 COTS and the FEMIS application. After you have completed these installations, save copies of your TNSNAMES.ORA and SQLNET.ORA files.

1. Log into Windows NT as Administrator.

2. Save a copy of your TNSNAMES.ORA and SQLNET.ORA files located in the C:\ORANT\NETWORK\ADMIN directory by renaming them TNSNAMES.OLD and SQLNET.OLD.

7.3.2 Installing Oracle7 Workgroup Server or Personal Oracle7

To install Oracle7 Workgroup Server or Personal Oracle7, complete the following steps:

1. Insert the Oracle7 Workgroup Server or Personal Oracle7 CD into the CD drive (usually your D:\ drive).

2. Click Start → Run, and enter D:\SETUP.EXE or click Yes if you are asked if you want to install Oracle software.

3. Click OK for English.

4. Verify your company name and Oracle home directory (usually C:\ORANT), and click OK.

5. Select Custom Installation for the type of installation.

6. Use the Windows Ctrl function to select the following products at the same time.

   If you are using Oracle7 Workgroup Server install (under +{All Products}) the following:

   - Oracle Enterprise Manager
   - SQL*Net Server (under +Oracle Networking Products)
   - SQL*Net Client (under +Oracle Networking Products)
   - Oracle7 Utilities
   - Oracle7 Workgroup Server
   - SQL*Plus
For Personal Oracle7 install the following:

+Personal Oracle
SQL*Net Add-on
SQL*Net Client
SQL*Plus

7. Select Oracle TCP/IP Adapter, if prompted for Oracle Protocol Adapters.

8. Select None and click OK when prompted for the type of starter database on the Starter Database Installation Options window.

9. Click OK on the Create Starter Message window.

10. Exit the installer after the products have been installed, and remove the Oracle CD.

7.3.3 Copying Oracle Database Configuration Files

To copy the stand-alone database configuration files, complete the following steps:

1. Insert the Stand-Alone Database Configuration CD into the D:\ drive.

2. Use Windows NT Explorer and browse to the D:\SITE directory.

3. Right click on the database directory under your site's directory and select Copy.

4. Browse to the C:\ORANT directory on the PC, right click on that directory, and select Paste. If a database directory exists, click Yes to replace it.

The database configuration files have the default location of C:\ORANT\DATABASE and C:\ORANT\DATABASE\F10 for the installation of the database. If the Oracle installation directory is something other than C:\ORANT or you need to use a different database instance name, you will need to edit the following files:

C:\ORANT\DATABASE\CRDBPC.SQL
C:\ORANT\DATABASE\INITF10.ORA
C:\ORANT\DATABASE\EOCDBAICR_DB_LAPTOP.SQL

Change the path locations of the database files and/or instance name accordingly. Make sure the directory you specify exists, otherwise the database scripts will fail.
7.3.4 Adding/Changing the Registry Setting for the ORACLE_SID

To add or change the registry setting for the ORACLE_SID, complete the following steps:

1. Click Start → Run, and enter REGEDT32. Click OK.

2. Double-click on the HKEY_LOCAL_MACHINE directory on the Registry Editor window titled HKEY_LOCAL_MACHINE on Local Machine to display its subdirectories.

3. Select the SOFTWARE → ORACLE.

4. Select Add Value under the Edit menu. In the Value Name enter ORACLE_SID, in the Data Type select REG_EXPAND_SZ from the drop-down list, and click OK. For String enter fiO (database instance name). If the ORACLE_SID value already exists, you should change it so it has the correct database instance name.

5. Exit the Registry Editor.

7.3.5 Configuring SQL*Net

To configure SQL*Net, you will need to run SQL*Net Easy Configuration. Double-click on the SQL*Net Easy Configuration icon that was installed in the Oracle for Windows NT group. The SQL*Net Easy Configuration dialog box appears with a menu of choices.

Note: Do not modify the TNSNAMES.ORA file in the ORANT\NETWORK\ADMIN directory.

You must use SQL*Net Easy Configuration to make modifications to the file.

1. Click Start → Programs → Oracle for Windows NT → SQL Net Easy Configuration.

2. Select Add Database Alias, and click OK.

3. Enter fiO for the Database Alias, and click OK.

4. Select Bequeath for the network protocol, and click OK.

5. Enter LOCALHOST for Bequeath Computer, enter fiO for Database Instance, and click OK.

6. Click Yes when asked if you want to add this database alias.

7. Click Cancel to exit SQL*Net Easy Configuration.
7.3.6 Configuring the Oracle Listener

The LISTENER.ORA file needs to be configured for the new fi0 database instance. A correctly configured file was copied to your PC with the database files. Complete the following steps to replace the existing file:

1. Use Windows NT Explorer to browse to C:\ORANT\DATABASE.
2. Right click on the LISTENER.ORA file, and select Cut.
3. Browse to the C:\ORANT\NETWORK\ADMIN directory on the PC, right click on this directory, and select Paste.
4. Click Yes to replace current file.

7.3.7 Building the Database

To build the database, you will need to run the scripts that were copied to your PC (steps in Section 7.3.3, Copying Oracle Database Configuration Files).

Note: Be sure you have changed these files if your Oracle installation directory is not C:\ORANT or if you are using a database instance name other than fi0.

The CREATFI0.BAT file will create a database instance of fi0 in the database, install the control files in the FIO directory, and create the INITFI0.ORA, STRTFI0.CMD, and PWDFI0.ORA files in the database directory.

The CRDBPC.SQL will create additional files, such as redo logs, rollback segment, sys, temp, tools, and user's Oracle files in the FIO directory. It will also run some default Oracle scripts to correctly configure the database.

The PUBBLD.SQL script sets up the correct public synonym tables.

You should view the CREATFI0.BAT and note the database password indicated after the -INTPWD parameter. You can change the database password by editing the text after this parameter before you run the script.

1. Click Start → Programs → Command Prompt. In the Command Prompt window, enter CD C:\ORANT\DATABASE.
2. Type in CREATFI0, and press Enter at the command prompt.
3. Type in SVRMGR23, and press Enter when the batch file finishes.
4. Type in CONNECT INTERNAL, and press Enter at the Server Manager prompt, SVRMGR>.

5. Enter the database password (view the CREATFI0.BAT -INTPWD password). You should receive the following message: “connected to an idle instance”.

6. Type in @CRDBPC.SQL, and press Enter.

   The CRDBPC.SQL script can take up to an hour to run depending on the speed of the PC. It creates a log file C:\ORAN\DATABASE\FI0\CRDBPC.DOC. You can ignore the following error messages: Public synonym to be dropped does not exist. and Table or view does not exist.

   When the script finishes, it will display SVRMGR>SPOOL OFF.

7. Type in Exit to return to the C:\ORAN\DATABASE> prompt.

8. Type in SQLPLUS SYSTEM\MANAGER, and press Enter.

9. Type in @C:\ORAN\DBSWJPBLD.SQL, and press Enter at the SQL prompt.

10. Type in Exit to leave SQL*Plus.

11. Type in Exit to close command prompt window.

### 7.3.8 Configuring the PC to Start the Database

The PC needs to run the STRTFI0.Cmd to start the database. Complete the following steps to add the command to your startup folder.

1. Click on Start → Settings → Taskbar.

2. Select the Start Menu Programs tab.

3. Click on Advanced.

4. Browse and select C:\WINNT\PROFILES\ALL USERS\START MENU\PROGRAMS\STARTUP.

5. Select New → Shortcut under the File menu.

6. Type in C:\ORAN\DATABASE\STRTFI0.CMD in the Create Shortcut window, and click Next.

7. Click Finished in the Select a Title for the Program window.

8. Close all programs and restart the computer.
9. Log in and verify that the STRTFL0.CMD automatically runs in a DOS window.

10. Click on Start → Settings → Control Panel.

11. Double-click the Services icon and verify the OracleServiceFL0, OracleStartFL0, and Oracle TNSListener have a Started Status and an Automatic Startup.

### 7.3.9 Creating Database Schemas

The MASTER.CR_DB_LAPTOP.SQL script needs to be run to create the FEMIS table spaces and users. If you are using a different location other than C:\ORANT for the database, you will need to edit the CR_DB_TS_LAPTOP.SQL

1. Select Start → Programs → Command Prompt, type CD C:\ORANT\DATABASE\EOCDBA in the Command Prompt window, and press Enter.

2. Type in SQLPLUS SYS/DBA0 at the command prompt, and press Enter.

3. Type in @MASTER.CR_DB_LAPTOP.SQL at the SQL prompt, and press Enter.

The MASTER.CR_DB_LAPTOP.SQL may take up to 15 minutes depending on the speed of your PC. You can view the log file C:\ORANT\DATABASE\EOCDBA\MASTER.CR_DB_LAPTOP.LOG for errors. The script will close the SQL window when it is done.

### 7.3.10 Loading Data into the Database

To load data into the database, complete the following steps:

1. Type in CD C:\ORANT\DATABASE\EXPORTS at the C:\ prompt.

2. Enter DIR to list the database files to be imported into the database. These files should be in the form <EOC>_<EXPORT_DATE>.DMP.

3. Edit the IMPORT.BAT file to view how each EOC’s data will be imported using the IMP73 command. Example:

   IMP73 <EOC>/<EOC> FILE=<EOC>_<EXPORT_DATE>.DMP LOG=<EOC>.LOG

4. Type in IMPORT at the command prompt, and press Enter.

5. Wait for the database import script to load all the tables for each EOC. This command will import the data for each EOC’s .DMP file in the export directory.
7.3.11 Creating Objects that Share Data

To create objects that share data, complete the following steps:

1. Type in `CD C:\ORANT\DATABASE\EOCDBA` at the C:\ prompt.
2. Type in `SQLPLUS /NOLOGIN @MASTER_CR.SQL`, and press Enter.

If your system is not connected to the network and you have Remote Access Service installed, you might receive a Dial-Up Networking prompt if Auto-Dial is enabled (It is enabled by default.). See Section 7.4, Remote Access Service, for instructions on disabling Auto-Dial.

You will need to watch the progress. If everything is running properly, press Enter when prompted.

7.3.12 Configuring FEMIS.INI for Stand-Alone Mode

When FEMIS is installed from the server, configuration files were configured for connecting to the server. The following procedure describes the changes needed for FEMIS to run in a stand-alone mode.

1. Create a new directory C:\FEMIS\USER.
2. Rename C:\WINNT\FEMIS.INI to C:\WINNT\FEMIS.OLD.
3. Open C:\WINNT\FEMIS.OLD using Notepad to edit the file.
4. Use the Replace function under Notepad's Search menu item.
5. Enter M: in the Find what field and C:\FEMIS\USER in the Replace with field.
6. Select Replace All.
7. Enter a new value, RunAsStandAlone=true, under the [Notification Service] section of the file.
8. Save the file as FEMIS.INI in the C:\WINNT directory.

7.3.13 Changing ODBC Data Source Values

The ODBC connections for each EOC need to be modified to connect to the local database you created (fio). Complete the following steps to change the ODBC data source values:

1. Rename C:\FEMIS\ADDODBC.BAT to ADDODBC.OLD.
2. Edit the C:\FEMIS\ADDODBC.OLD.
3. Change the database instance for all EOCs to \f0 under the line that specifies Add calls here.

   Example: call odbcsub.bat <EOC> \f0

4. Save the file as C:\FEMIS\ADDODBC.BAT.

5. Execute the ADDODBC.BAT file.

### 7.3.14 Testing the Setup

You should test the stand-alone system by shutting the PC down and removing the system from your network. After restarting the PC, check to see if you can start FEMIS. Data on this PC is completely separate and different from a PC running FEMIS that connects to the main database at your EOC.

### 7.4 Remote Access Service

If you have Remote Access Service (RAS) installed on the PC (used with Remote Evacuee Registration), you may be prompted to use Dial-Up Networking whenever you attempt to connect to the local database. If you receive this prompt, you can disable this Auto-Dial feature by choosing the following options:

1. Select Yes, Dial when the Dial-Up Networking window appears.

2. Click OK to add an entry and, in the Phonebook entry wizard, click Cancel if you received a prompt that your Phonebook is empty.


Select Yes to disable the Auto-Dial feature when you receive the following message: Auto-Dial attempt failed. Do you want to disable auto-dial from this location?

You can turn this feature off before attempting to install the stand-alone database by doing the following:

1. Select an entry to dial from the Phonebook list in Dial-Up Networking.

2. Click on More and select User Preferences.

3. Clear each location listed in the Enable Auto-Dial by location list on the Dialing tab.

4. Turn on Auto-Dial by reselecting a location in the Enable Auto-Dial by location list.
7.5 Verifying the Stand-Alone Installation

To verify that the stand-alone installation is complete and that FEMIS is fully operational, see Section 4.7, Validating the FEMIS PC Installation. The FEMIS PC Validation Checklist (at the end of Section 4.7) includes items that need to be checked to ensure that FEMIS is operating properly.

Because this is a stand-alone installation, the following items on the checklist do not need to be verified:

<table>
<thead>
<tr>
<th>One Time at Each EOC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 Verify the Evacuation Command Server is operating properly</td>
</tr>
<tr>
<td>4 Only on the server with the depot database, verify FEMIS/EMIS Data Exchange Interface (DEI)</td>
</tr>
<tr>
<td>7 Verify E-mail</td>
</tr>
<tr>
<td>8 Verify SEPR Icon Addressee</td>
</tr>
</tbody>
</table>

Perform on Every PC:

<table>
<thead>
<tr>
<th>14 Verify Evacuation</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 Verify Electronic Planning (Planning Mode)</td>
</tr>
<tr>
<td>18 Verify E-mail</td>
</tr>
<tr>
<td>19 Verify SEPR Icon Addressee</td>
</tr>
<tr>
<td>20 Verify FEMIS Tools on Appropriate PC(s)</td>
</tr>
</tbody>
</table>

If you have a display problem with the D2PC window (cannot see the Edit/View and Close buttons at the bottom of the D2PC window), you will need to change your system display fonts. Click Start → Settings → Control Panel → Display → Settings tab, and change the Font Size field to Small Fonts. Reboot the PC to activate this change.